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Claims

Overview

The down arrow on the Claims tab indicates there is a sub-menu below it. When the Claims tab is
selected, the following options appear:

Emdeon Office Logged in as: Office User | Xform | Thursday, Juns 10, 2010
@ Eligibility || Service Review ¥ | Find Providers | Claims ¥ | Payment ¥ | Clinical Tools | Batch Manager | Setup ¥ rar -1
import [Custamize]

Emdeon Office Home Create

List

Supplement
Customer Support

Message Center Reporting & Analytics

You have 0 unread mail messages. Claim Status 24/7 Online Support

You have 16 claims batches to supplement. More Online Training

Customer Alerts General User Guide 3

You have 4 un-worked claim rejections 4 Real Time User Guide B2
Import

Import allows users to submit primary and secondary claims respectively from a provider’'s workstation
to Emdeon Office for processing.

Create

Create allows users to enter claim information directly into an HCFA 1500 claim form. See the New
Claim section (page 25) for instructions. Before creating a claim for the first time, you must first
complete Provider Setup (page 16).

List

List allows users to view, edit, and submit claims. Before using Claim List, you must have completed
and saved one or more claim forms. You can sort the list of claims by clicking on any of the column
headings.

Supplement

Supplement allows users to submit secondary claims from a provider’s workstation to Emdeon Office
for processing.

Reporting & Analytics

Reporting & Analytics can be used by providers and practices to view summary and detailed
information on submitted claims. It provides users with a tool to view status of claims with the payer.
Additionally, it provides a tool for tracking claims rejections and work completed on rejections.

Un-Worked Claim Rejections

You can access a claim rejections report from the home page. The “un-worked claim rejections” link
shows how many un-worked claim rejections you currently have. Click the link to launch a default claim
rejection report in Reporting & Analytics that includes all un-worked claim rejections from the last seven
days.

Page 6
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Heme = Work Queue Search = Claim Summary

Claim Received Date Tax ID Site ID Search Type

If no dates are entered, dates will default to last 7 days.

) P n ®
Claim Summary
Search Criteria: Claim Date Range: 11/2/2010-11/8/2010 p Payer ID: < Empty = » Provider Tax ID: < Empty >

Claim Status: Rejected » Worked Status: NOT_WORKED » Emdeon File ID: = Empty =

E @ Help

PR_1

006

» Site ID: < Empty =

Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date Amount I
Emdeon-Rejected
Site ID: DKL
File ID: DK1230FFICEODO1
O Julie 123456 CN1234A424 02/23/2010 $2,559.00 AYOL DEO0D00
¥ Jeremiah 123456 0272372010 $2,240.35 AYOL DEKOD0Q0CESaEEaiihe
Payer-Rejected
Site ID: DKL
File ID: DK1230FFICEODO1
O Jonathon 123456 PCN1234AA26 02/23/2010 £446.94 PAYO1 DK00D00
O Patrick 123456 PCN1234AA27 02/23/2010 $1,688.50 PAYO1 DEOO0QOSEsa Ssiie

Claims

To customize which claims will be included in the list of un-worked claim rejections that appear on the
report, click the pencil icon. Type a tax ID, site ID, or different number of days and click Save. For hints

on entering values, click in each box and look at the bottom of the screen.

/€ Customize Claim Rejections - Windows Internet Explorer

[B9]f=][ %]

Claim Rejections Customization

in the list of un-worked claims rejections referenced on the Home page.

L EEmEre e Enter customization data for claim rejections

You have 10 unread mail messages. Tax ID Site ID Days to include
7

Customer Alerts
You have 4 un-worked claim rejections 4
¢

You will receive an error message under the following conditions:

e If the values you enter generate more than 1,000 un-worked claim rejections.

e If you enter a number larger than 450 in the Days to include box.

By adding or modifying the information below you can customize which claims will be included

e If you enter a site ID and enter a number larger than 60 in the Days to include box.

Tax ID Site 1D
Submit Reset

If no dates are entered, dates will default to last 7 days.

From date cannot be older than 15 months.

Home = Work Queue Search B a Help

Modify the search criteria on the claim rejection report page and click Submit to relaunch the report.

For help with Reporting & Analytics, please refer to the Reporting & Analytics section on page 87.

Claim Status

Claim Status allows user to monitor their claims for status information and reimbursements and to

correct and resubmit claims without re-entering patient/provider data.

Page 7
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More contains links to claims resources.

The following table describes in detail each link on the Claims > More page.

Link

Description

Payer Enroliment

Takes you to the Payer Enroliment page of www.emdeon.com, where you can
access Claims Payer Enroliment forms.

Add Providers or Payers

Allows you to add providers or payers for claims submission. This feature is
covered in detail in Add Providers or Payers (page 9).

Change or Remove Providers or
Payers

Allows you to change or remove providers or payers you have already enrolled for
claims submission. These features are covered in detail in Change or Remove
Providers or Payers (page 10).

CMS NPI Enrollment

Takes you to CMS’ National Plan and Provider Enumeration System, from which
you can apply for a National Provider Identifier.

NPI Crosswalk

Takes you to the Enrollment Manager.

NPI Crosswalk Reports

Reports on the success or failure of NPI inclusion in submitted claims.

Crosswalk User Guide

Opens the NPI Crosswalk User Guide.*

Crosswalk Quick Reference

Opens the quick reference guide for using the NPI Crosswalk.*

Complete Emdeon Payer List

A complete list of Emdeon payers.

Claims Resource Center

Takes you to Emdeon’s Claim Resource Center.

Claims User Guide

Opens the Claims User Guide.*

Claims

*These guides are in pdf format and require that you have the Adobe® Reader® installed on your computer. The Reader can
be downloaded free of charge from www.adobe.com.

Page 8


http://www.emdeon.com/�

Emdeon Office Claims User Guide

O emdeon Send Clai
en alms

Send Claims

Add

Benefits of Sending Claims through Emdeon Office

e Submit claims to hundreds of commercial and government payers

e Edit and submit secondary claims. Data from the primary claim is used to create the secondary claim
resulting in improved efficiency and time savings.

e Upload print image and electronic claim files

e Use your own Practice Management system to generate claim files.

A claim file must contain professional (physician) claims only.

Your management system may save claims in a file as you enter them, or you may choose to save or
“print” claims to a file. You'll need to ask your practice management system vendor for details on how to
create the claim file and where you can find it on the PC.

Send Claims Requirements

Unlike real-time transactions, claim transactions sent through Claim Entry and Send Claims require
additional enrollment.

Additionally, before submitting a claim file using the Send Claims service, your claim file format must be
validated, otherwise, your claim file may be successfully transmitted but it will not be processed at the
Claim Processing Center and you will not be notified.

If you have not validated your claim file format with a help desk representative please contact 1-877-
469-3263 for additional information.

Providers or Payers

Use this procedure to add a provider for claim submission or add a payer for a provider who has already
been enrolled for claim submission. The enroliment team will complete the process and will notify you by
email when the enrollment has been processed.

1. Select Claims > More from the main menu. The Claims Additional Resources window appears.
2. Click the “Add Providers or Payers” link. The Add Providers or Payers window appears.

Note: Because this page reflects information currently on file, many boxes will be pre-filled with
information that will likely not need to be changed.
Add Providers or Payers
*Required
Enter Provider Information
* Practice Name * Provider Name * NPI
The Office
* Tax 1D Type * Tax ID Site ID
TaxID v 123456788
* Provider Specialty Code
—Select-- v
Phone Fax * Email
389 939 2990 s @emdeon.com v]
A notification will be sent to this email address when your enrollment has been processed.
We will also store this email address for future communication.
Enter Payer Information
You must enter information for at least one payer. For each payer you add, you must enter a Payer ID and an Individual Provider ID.
Payer ID Lookup Group ID :’I:-gi\xi:ldeurall[: Payer ID Lookup Group ID II’I:':i;;i‘ldeuraIID
123456788 v 123456788 |
123456788 v| 123456785 vl
123456788 v 123456788 |
123456788 v 123456788 |
123456788 v| 123456785 vl
[ Submit ] [ Reset ] [ Return To Previous ]

Page 9
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3. In the Enter Provider Information section, enter the provider’s identifying information. Required
items are marked with a red asterisk (*).

4 Note: If you are adding a payer for a provider who is already enrolled, duplicate the identifying
information for the provider supplied during the initial enrollment process.

Please note the following about this section:

e Tax ID - Select a tax ID from the list or type a new tax ID in the box. This list is made up of all
the tax IDs your account is currently configured to send claims for.

e Email - Select an email address from the list or type a new email address in the box. We will
also store this email address for future communications about your account or enroliment for
additional services.

4. In the Enter Payer Information section, you must enter at least one payer.
Please note the following about this section:

e Payer ID - If you do not know the payer ID, click the “Lookup” link to search for the payer ID.

¢ Individual Provider ID - Select a provider ID from the list or type a new provider ID in the
box. This list is made up of all the provider IDs your account is currently configured to send
claims for.

5. Click Submit.
6. On the page that appears, you will see “Your request has been successfully submitted for
enroliment.” Click Add or Change Another Provider or Return To Home Page.

Change or Remove Providers or Payers

Use this procedure to change or remove provider or payer information for a provider you have already
enrolled, or to remove a provider or payer. The enroliment team will complete the process and will notify
you by email when the enrollment has been processed.

4 Note: You can do any or all of the procedures listed below on the Change or Remove Providers
or Payer page.

Change Information for Providers or Payers

1. Select Claims > More from the main menu. The Claims Additional Resources window appears.
2. Click the “Change or Remove Providers or Payers” link. The Change or Remove Providers window
appears.

4 Note: Because this page reflects information currently on file, many boxes will be pre-filled with
information that will likely not need to be changed.

Page 10
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Change or Remove Providers or Payers

*Required

Enter Provider Information
* Practice Name * Provider Name * Email
The Office # @emdeon_com

) A notification will be sent to this email address
" Tax ID Type “ Tax ID when your enrollment has been processed. We will
TaxlD v 123456788 |V| alse store this email address for future
communication.

Enter Provider or Payer Changes

You must change or remove information for at least one provider or payer.

Provider
Change Remove Field Mew or Removed Information
® [ 5] —Select— i
® o ~Select- v
@® ® —Select— i
® [ ] —Select— i
Payer
Change Remove Payer ID Lookup Field Mew or Removed Information
(O] 5] ~Select- v
® 5] —Select— v
® O —Select— ¥
@ [ 5] —Select— ¥
® 5] —Select— v
[ Submit ] [ Reset ] I Return To Previous ]

3. In the Enter Provider Information section, enter the provider’s identifying information. Required
items are marked with a red asterisk (*).

Please note the following about this section:

e Tax ID - Select a tax ID from the list or type a new tax ID in the box. This list is made up of all
the tax IDs your account is currently configured to send claims for.

e Email - Select an email address from the list or type a new email address in the box. We will
also store this email address for future communications about your account or enroliment for
additional services.

4. In the Enter Provider or Payer Changes section, you must make changes to one provider or
payer. You can make changes to both provider and payer information on this page.
5. If you want to change provider information, do the following:

e In the first row of the Provider section under Enter Provider or Payer Changes, ensure that
Change is selected (it is selected by default).

Select an item from the Field list.

Type the new information in the New or Removed Information box that appears.

Complete additional rows as needed. If you want to change payer information, do the following:
In the first row of the Payer section under Enter Provider or Payer Changes, ensure that
Change is selected (it is selected by default).

¢ In the Payer ID box, type the payer ID of the payer whose information you want to change.

Note: If you do not know the payer ID, click the "Lookup” link to search for the payer ID.

e Select an item from the Field list.
e Type the new information in the New or Removed Information box that appears.
e Complete additional rows as needed.

Click Submit.
On the page that appears, you will see “Your request has been successfully submitted for
enroliment.” Click Add or Change Another Provider or Return to Home Page.

No
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Remove Information for Providers or Payers

The following steps allow you to remove pieces of information for providers or payers. If you want to
remove an entire practice/facility, provider, or payer, refer to Remove Providers or Payers on page

13.

1. Select Claims > More from the main menu. The Claims Additional Resources page opens.
2. Click the “Change or Remove Claims Providers” link. The Change or Remove Providers window
opens.

L

Note: Because this page reflects information currently on file, many boxes will be pre-filled with
information that will likely not need to be changed.

Change or Remove Providers or Payers

*Required

Enter Provider Information

* Practice Name * Provider Name * Email

The Office Wt @emdeon com

. A netification will be sent to this email address
Tax ID Type Tax ID when your enrollment has been processed. We will

TaxID  |v 123456788 V] also store this email address for future

Enter Provider or Payer Changes

You must change or remove informatien for at least one provider or payer.

Provider
Change Remove Field New or Removed Information
O] ® —Select— hl
O] ® —Select— i
® 5] --Select— v]
(O] ® —Select—- v:
Payer
Change Remove Payer ID Lookup Field New or Removed Information
® 4] —Select— -
® —Select— [v]
O] ® —Select— 4
O] ® —Select— 5
® 4] —Select— [v]

communication.

[ Submit ] [ Reset ] [ Retumn To Previous ]

3. In the Enter Provider Information section, enter the provider’s identifying information. Required
items are marked with a red asterisk (*).

Please note the following about this section:

Tax ID - Select a tax ID from the list or type a new tax ID in the box. This list is made up of all
the tax IDs your account is currently configured to send claims for.

Email - Select an email address from the list or type a new email address in the box. We will
also store this email address for future communications about your account or enrollment for
additional services.

4. In the Enter Provider or Payer Changes section, you must make changes to at least one provider
or payer. You can remove information for both providers and payers on this page.
5. If you want to remove provider information, do the following:

In the first row of the Provider section under Enter Provider or Payer Changes, click
Remove.

Select an item from the Field list.

Type the information you want to remove in the New or Removed Information box that
appears.

Complete additional rows as needed.

6. If you want to remove payer information, do the following:

L

In the first row of the Payer section under Enter Provider or Payer Changes, click Remove.
In the Payer ID box, type the payer ID of the payer whose information you want to change.

Note: If you do not know the payer ID, click the "Lookup” link to search for the payer ID.

Page 12
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e Select an item from the Field list.
e Type the information you want to remove in the New or Removed Information box that

appears.
e Complete additional rows as needed.
Click Submit.

On the page that appears, you will see “Your request has been successfully submitted for
enroliment.” Click Add or Change Another Provider or Return to Home Page.

Remove Providers or Payers

Removing a practice/facility, provider, or payer means that you will no longer be able to submit claims
using that entity.

To remove a practice/facility, provider, or payer, follow steps 1-3 of the previous section, and then
continue as follows:

Remove a Practice/Facility

1.

ou A wWN

In the first row of the Provider section under Enter Provider or Payer Changes, click Remove.
Select “Practice/Facility Name” from the Field list.

Type the practice/facility name in the New or Removed Information box that appears.
Complete additional rows as needed.

Click Submit.

On the page that appears, you will see “Your request has been successfully submitted for
enroliment.” Click Add or Change Another Provider or Return to Home Page.

Remove a Provider

1.

ounhbn

In the first row of the Provider section under Enter Provider or Payer Changes, click Remove.
Select “Provider Name” from the Field list.

Type the provider name in the New or Removed Information box that appears.

Complete additional rows as needed.

Click Submit.

On the page that appears, you will see “Your request has been successfully submitted for
enroliment.” Click Add or Change Another Provider or Return to Home Page.

Remove a Payer

1.
2.
3.

Nowuns

In the first row of the Payer section under Enter Provider or Payer Changes, click Remove.
Select “Payer ID"” from the Field list.
In the Payer ID box, type the payer ID.

Note: If you do not know the payer ID, click the "Lookup” link to search for the payer ID.

Type the payer ID in the New or Removed Information box that appears.

Complete additional rows as needed.

Click Submit.

On the page that appears, you will see “Your request has been successfully submitted for
enroliment.” Click Add or Change Another Provider or Return to Home Page.
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Submit a Claim File for Processing

Follow these steps to upload and submit a claim file:

1. Create a claim file using your Practice Management System.

2. Select Claims > Import from the main menu. The Import Claims main window opens. Read the
explanatory text if you are not familiar with claim file formats.

3. Click Proceed to Next Step. The Send Claim File form opens in a separate window.

€ Import Claims - Windows Internet Explorer E]@
P Help
Send Claim File

“You must be registered to perform the Impart Claims service. In addition, before submitting a claim file using the Import Claims service
yiou st verify thatyour claim file format is valic. If you have notwalidated your claim file format with s technician then please contact
1-877-469-3263 for additional information. fyau do notwvalidate your claims file format then your claim file may be successfully
transrmittec BUT it will not e processed atthe Emdeon Claim Processing Center and you will not be notified

Haold submission for entry of additional data.
Locate claim file
Click the "Browse.." button below and you will be prompted to locate the claim file you wish to upload

Browse..

Last file uploaded: C\Documents and Settingsieweeks\Desktoprzi1 2345678902222 sup

Select how you wish the claim file to be processed
& Normal - Upload and submit claim file to the Emdeon Business Services Claim Center for processing

O Testyour internet connection - Claim file will not be processed

Choose an action
“Y'ou are now ready to upload your claim file. The time this takes will vary depending on the size of the claim file and the speed of your
internet connection. This window must remain open until this process is complete. Closing the window will terminate
the process.

Submit Claim for Processing ] [ Cancel ]

" 4 Note: You must be registered to use the Import Claims service. In addition, before submitting a
claim file using the Import Claims service you must verify that your claim file format is valid. If
you have not validated your claim file format with a help desk representative, please contact
customer support for additional information.

4. The “Hold submission for entry of additional data” check box should only be checked if you are
planning to enter prior payment information to generate secondary claims. Otherwise it should be
clear.

L

Note: For information on secondary claims, refer to Supplement Claims on page 33.

5. Click Browse... to locate the claim file. Select the claim file you want to send for processing and
click Open. The file name populates the field.
6. Select the mode in which to send the file.

¢ Normal - Your file is encrypted, transmitted, authenticated, validated, and delivered for
processing.

¢ Test your internet connection - This option allows you to test your internet connection before
actually sending the file for processing. The claim file is neither transmitted, nor presented for
processing at any time.

7. Click Submit Claim for Processing. Once the file is submitted, a message appears indicating
whether the transmission succeeded or failed.

L

Note: Leave the Send Claims window open during file transmission. Closing the window indicates
that you want to terminate the connection and abort the transmission. You can minimize the
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window, but it must not be closed or the process will end immediately.

When the claim is received and processed, a claim status report is sent to your Emdeon Office mail
inbox.
Click Cancel to close the Send Claim File window after your claim file is successfully transmitted.

. Check your Emdeon Office mail inbox for messages about the status of your claims.

Verify Claims Transmission

Once your claims are processed, a claim status report is sent via Emdeon Office mail to your inbox
confirming the status of the claims. Follow these steps to view this report:

1.
2.

Click the mail messages link on the home page.
To view the message, double-click the message or single click the message and then click the Open
icon.

The following is an example of a Level 1 Claim Status Report:

EMDEON CLAIM CONFIRMATION REPORT
REPORT GEMERATION DATE: 09/18/06

FRASIER CRAMNE MD

TSSO ID: alz3

CLAIMS PROCESSED ON 09/18/06 { 8:00 AM CST)
TOTAL CLAIMS PROCESSED: &

INPUT TYPE: HCFA

TRAMSMISSION TYPE: PRODUCTION

BATCH ID: whk17091806075607375

FILE CONTROL #: HCBIKU

09/16/06 AL 60054 DOE, 1 20215 1E0.00 AETMA US HEALTHCARE 19244
09/16/06 valL 60054 SMITH, B 110E82 135,00 AETMNA US HEALTHCARE 19244
09/16/06 vaL 60054 ALLEN, R 28602 135.00 AETMA US HEALTHCARE 19244
09/16/06 Y&l 60054 WALDEMN, C 10657 90.00 AETMA US HEALTHCARE 19244
09/16/06 AL 22099 WILLIAMS, K 13045 110,00 BLUE CROESS 07101
YALID CLAIMS : WaLlD CLAIMS AMOUNT ¢ § 620,00
REJECTED CLAIMS : 0 REJECTED CLAIMS AMOUNT @ & ]

FETOTAL CLAIMS PROCESSED ALL TAKIDS™®®

** TOTaL CLAIMS PROCESSED @ 5 AMOUNTING TO : $620.00 **
¥ TOTAL VALID CLAIMS : s AMOUNTING TO @ § 620.00
** TOTAL REJECTED CLAIMS @ u] AMOUNTING TO @ § uia]

Paper Claim Report

Send Claims Tips

The following information will help you resolve and prevent issues with claim files.

If your claim file cannot reach the Emdeon Office Processing Center, Send Claims generates a
transmission failure message and posts it in the Send Claim File window. Help identify the source of
the problem by making a note of the error message before closing the message window.

Do not close the Send Claim File window during processing. The Send Claim File window must
remain open throughout your session, or your claims will not be processed. You may minimize the
window, but it must not be closed, or your session will terminate and your claim submission process
will end. Since transmission failure messages appear in your Send Claim File window, which is not
visible once your session terminates, you will not notice your transmission has failed until much
later.
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Claim Entry

Overview

The Claim Entry service is designed to meet the needs of small to medium size health care provider
offices, by allowing manual data entry of claims that can be electronically sent to a processing center. In
addition, Claim Entry lets you work with payers that do not accept electronic claims. Once these payers
are set up, all claims sent to these payers are automatically converted to paper claims and sent by mail.

Benefits

e You can manually create HCFA 1500 claims and submit to hundreds of government and commercial
payers

e Data from patient database is integrated into the claim forms

e Claims sent to payers that do not accept electronic claims are converted to paper claims and mailed
to the payer

e Allows editing and resubmitting claims

Features

e Claim List

¢ New Claim

e Provider Setup
e Patient List

Provider Setup

Provider Setup is the starting point for claims entry. This feature allows you to store provider- and
payer-specific information, which is used to generate new claims. Provider Setup information must be
entered before creating claims.

Claim List | MewClairm | Provider Setup | Patient List
ProviderSetup - Introduction

Use Provider Setup to enter, edit and store information about the organization and providers for whom you will be entering claims and the payers to whom you wish to send the
claims.

Use the "Next Step” and "Previous Step” buttons located at the lower right of each page of the form to move through the setup steps. This information must be completed for
each organization (if you are a Billing Service, there will be multiple organizations) and each individual provider associated with those organizations. Each of your payers to
whom you wish to send claims must also be entered before you can begin using the claim entry feature and sending claims.

Click on the "Start Setup” button below to get started.

Once the provider data is stored, it automatically populates fields on a claim form, eliminating the need
to re-enter existing data.

There are six steps involved in setting up a provider organization. These steps must be performed in
sequence the first time you set up an organization:

Step Provider Data Description

1 Provider The onscreen instructions will help you complete all the required fields in this
Organization/Facility section.

2 Tax IDs Enter at least one Tax ID for the organization.
Addresses In the first field, Location Name/Description, enter either the name of the

organization or the practice. If you have multiple office locations, enter the
location names.

Click Save Address and the next screen will allow setup of multiple addresses.
If there are multiple locations, check the appropriate box to indicate where each
address is, where services are performed, and if this is the address where
payments are to be sent.
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Step Provider Data

Description

4 Providers

You must enter either the healthcare provider’s Universal Provider Identification
Number (UPIN) or state license number. You can also enter your NPI number to
be used in New Claims. When entering multiple providers, click Save and Add
New Provider. You must click Save or your information will be lost.

5 Payers

These are the insurance companies, government plans, and Health Maintenance
Organizations to whom claims are submitted. Use the drop-down list to
individually select the payers you want to add.

You can personalize your payer list by selecting the “Edit Payer List” link located
next to the payer drop-down list. If your account is set up with only one payer,
you will not see this link.

If you leave the Payer-Assigned Provider Number field blank and save, the
system will automatically populate the field with “NPI”.

6 Submitter

This is the person or company responsible for submitting claims for a provider.
Most of this information is pre-populated.

L

required fields will prevent you from advancing to the next screen.

National Provider Identifier (NPI) and Tax ID Qualifier

Emdeon Office offers providers the ability to automatically populate fields on a new claims form by
saving provider data through Provider Setup.

Note: All required fields are marked with a red asterisk (*).Failure to complete one of the

When setting up a new provider (or editing an existing one), NPI and Tax ID Qualifier data must be
saved in order for the data to be automatically populated into new claims forms.

L

Note: Saving this data will allow for one-time entry of the information and will save the user

time entering new claims. If the data is not saved using this method, users will be required to
use the NPI crosswalk in order to include NPI, and they must manually enter Tax ID Qualifier
tags in the claim line level comments.

Set Up NPI for Claim Entry

¢ Note: For existing providers already set up for Claim Entry, skip to Step 4.

1. Select Claims > Create, and then click the “Provider Setup” link.
2. Select “Edit Organization” from the Action drop-down menu.

—- Select- s
—-Select -

View TaxIDs

View Addresses

View Providers

View Payer Information
Add TaxID

Add Address

Add Provider

Add Payer Information

Delete Organization

3. Select the “Providers” link.

Oroanizations | TaslDs

Addresses

| P Providers | Payers | Submiter

" 4 Note: Provider NPI is not a required field under the “Providers” link, but if it is not entered
through Provider Setup, users must use the NPI crosswalk to handle NPI, or the claims will be
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rejected.

4. Select “Edit” from the Action drop-down menu.

—Select—M

|- Select-

=First Name |Larry

Middle Initial
*Organization/Last Mame Barber

Provider Degree/Credentials MD

MNPl
UPIN
License # Licanss Type
SSN
-Speciaty |[Emergency Medicine(093) ¥

Save and Add Mew Provider

[ Save Provider ][ ][ Cancel ]

Emdeon Office Claims User Guide
Claim Entry

5. Enter the provider’s ten-digit NPI humber, and select the Save Provider button after NPI

information is entered.

Enter Provider Infarmation

=First Mame |Larry
Middle Initial
*QOrganization/Last Name |Barber
Provider Degree/Credentials |MD
NP1 | 2323232323

UPIN
License # License Type
83N
* Specialty | Emergency Medicine(093) M

Save and Add New Provider ] [ Cancel ]

[ Save Provider % [

Set Up Tax ID Qualifier for Claim Entry

¢ Note: For existing providers already set up for Claim Entry, skip to Step 4 below.

1. Select Claims > Create, and then click the “Provider Setup” link.
2. Select “Edit Organization” from the Action drop-down menu.

- Select - M

|- Select—-

View Tax IDs

View Addresses

View Providers

View Payer Information

Add Tax D

Add Address

Add Provider

Add Payer Information

Delete Organization

3. Select the “Payers” link.
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Addrezzes | Providers | P Payers | Submitber

Orgarizations |  TaxlDs |

4 Note: Performing Provider Tax ID Type is not a required field under the “Payers” link, but if
it is not entered, users must manually enter the Tax ID Qualifier tags in new claims forms’ claim

line level comments, or the claims will be rejected.

4. Select “Edit” from the Action drop-down menu.

-~ Sele

Delete

The Payer Information screen will appear.

Information

= Provider | Barber,Larry

M Edit Payer List

= Payer |Aetna

= Service Address | MedClinic South

P, - A d Provid
syerAssigne r:iﬂbz; 55555555 (Optional if NPI is valued in Provider)

Provider Specialty
+ Tax 1D | 656565656(Federal Tax ID Number) [¥| or [ Use the provider's ssn

Performing Provider Taxio Type | Employer Identification Number [¥| (change anly if Biling and Performing Provider Tax 1D TYPES are not the same.)

Performing Provider Number |55555555 (Optional for entity)

Sub-Identification Number [2555
Submitter Code
HMO/PPO Code

Group NPI

[ Save Payer Information ] [ Save and Add ] [ Cancel ]

5. Select "Employer Identification Number” or “Social Security Number” as the Performing Provider Tax
ID Type from the drop-down menu.

Employer Identification Number  |v
- Select -

Employer ldentification Number
Social Security Number, Individual

Information

+ Provider | Barber Larry

= Payer ‘Aetna M Edit Payer List

= Service Address | MedClinic South '

Payer-Assigned Provider
Y g Number 22999958 (Optional if NPI is valued in Provider)

Provider Specialty
* Tax 10 | 656565656(Federal Tax ID Number) [¥| or [ use the provider's ssn

performing Provider Tax1o Type | Employer Identification Number [+| (change only if Biling and Performing Provider Tax Ib TYPES are not the same.)

Performing Provider Number 55555555 (Optional for entity)
Sub-Identification Number |3333—
Submitter Code
HMO/PPO Code

Group NPT

[ Save Payer Information ] [ Save and Add ] [ Cancel ]

6. Select Save Payer Information to save and exit or Save and Add to add the Tax ID Qualifier for
other payers.
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Claim Line Level Comments

Claim line level comments can be used to pass claim data by using concatenated tags.

NPI and Tax ID Qualifier

After setting up provider NPI and Tax ID Qualifier information in the “Provider Setup” tool, all new claims

forms will be automatically populated with the Provider NPI and Tax ID Qualifier data.

NPI and Tax ID Qualifier data must be present at the claim line level (Step 4 in the new claim form) for

each procedure submitted in a claim for the claim to be processed.

The NPI and Tax ID Qualifier data tags will be displayed for the user in the "Comment...” window for line

level comments.

Step 4 - Claim Line Information
=Performing “Place Type *ICD-9 Anes

Delete "Start Date ~End Date Provider Spec Code Code “Proc Mods Ptrs Units Mnts “Charges EPSDT
X (04142010  [04/14/2010 | 56556555 Barber, Lamy v|[093  [[11 2 P loos2s £ a 0.0 15000 | ~Select—|v|[_Comment
X 55556555 Barber, Larry |v] (093 n e rel Il 0.0 50.0 —Select—|v
1 |+ More Line(s)... Total |$150.00

Amount Paid by Patient |50.00

Comment{Maximurm allowed characters is 160}
LRNNPI*2323232323,LRTIQ*E

Save

The NPI and Tax ID Qualifier tags will be visible in the Comment field.

Enter Attachment Information

There are many times when a provider needs to convey to a payer that a claim has attachment
information associated with it. To convey that attachment information exists for a claim, the user
should:

e Proceed to the end of the Remarks field.

After selecting the Comment... button, the Additional Claim Line Information window will appear.

4 Note: The Remarks field is not the Comment field. The Remarks field is at the bottom of the

form under Other Information (see below).

Step 9 - Other Information

Date first consulted Hospital Service Dates Date last seen
To
Referring Provider NPI Referring Provider # Referring Provider TaxID Type
— Select —- hd
Referring Physician Last Name First Name M.1.
Referring Provider State Referral Number Workers Condition Code
—Select— |w — Select - b

Remarks
CRNNPI*2323232323,CRTQE BLGNP*2323232323

[ Save as New Claim ] [ Cancel ]

e Add acomma
e Enter the PWK* tag

The PWK* tag should then be followed by:

e a1 position Documentation Indicator
e a 1 position Documentation Type Code
e a 3 to 30 position Attachment Control Number
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1 position Documentation Indicator

The first character after the PWK* tag should be the Documentation Indicator. It should be one of the
following codes:

Code | Meaning

1 By Mail

2 FAX

3 Available on Request at Provider Site

1 position Documentation Type Code

The second character after the PWK* tag should be the Documentation Type. It should be one of the
following codes:

0
o
=}
o

Meaning

DME prescription

Explanation of benefits (Coordination of Benefits

Diagnostic report

Operative note

PEN certification

Ambulance certification

Physical therapy certification

Chiropractic justification
Prosthetics or Orthotic Certification

Oxygen prescription

Multiple documentation items
Other

N[ <[“("|ZT|o|mM|mMmO|O|®|>

3 to 30 position Attachment Control Number

Positions 3 through 30 after the PWK* tag should contain the attachment control number. This number,
usually assigned by the provider, will be recorded on the attachment and will provide a cross-reference
between the attachment and the claim.

Remarks
CRNNPI*2323232323, CRTQE . BLCNPI*2323232323 PWK*UB 123456789

[ Save as New Claim ] [ Cancel ]

[

Note: In order to avoid claim rejections, it is important that the information following the PWK*
tag is entered in the order as described above and using the values described above.
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Additional Claim Line Information Fields

While NPI and Tax ID Qualifier tags are required to process the claim, other claim information can be
contained in claim line level comment tags as well.

When users enter values for any of the fields on the screen, tags will be automatically populated for
them in the Comment section. (NPI and Tax ID Qualifier tags will already be present.)

Additional Claim Line Information
Provider Information

Ordering Provider NPI Ordering Provider UPIN

Ordering Provider Last Name Ordering Provider First Name Ordering Provider Middle Initial

Supervising Provider 1D Supervising Provider Last Name Supervising Provider First Name Supenising Provider Middle Initial
Purchase Senice Provider NPI Purchased Service Provider # Purchased Serice Name

Service Information

Purchased Service Purchased Serice Charge
N[v] 50.00
Accute Manifestation Date Date Last Seen Initial Treatment Date X-Ray Date

Nature of Condition
—Select- [V]

CLIAID # Mammaography Cert Number National Drug Code

Resubmission Information
Resubmission Code Resubmission Reference Number

Narrative Information

Comment(Maximum allowed characters is 160}

LRNNPI*2323232323,LRIQ*E

Save

User Comments

If users want to insert their own comments, they can by entering their comments after the auto-
populated tags, separated by a comma and using the prefix “NAR*"” followed by the comments. See the
example below.

Comment{Maximum allowed characters is 160)

LRNNPI*2323232323, LRTQ*E,
NAR*ENTER COMMENT HERE...

Save
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Patient List

Patient List is used to store, manage, and retrieve patient demographic information. When creating a

claim for a patient whose data is already stored in the database, the stored data automatically populates
fields on the claim form.

Before using Patient List for the first time, you must first complete the Provider Setup section on page
16. This is because for each patient record, you will be asked to select a payer, and this information is
stored in Provider Setup.

Click “Customize” to specify what information you want to appear on the Patient List. Click the Clear
button to clear the Search field.

Add a Patient
Follow these steps to add a patient record:

1. Select Claims > Create on the main menu, and then select Patient List. The Patient List screen
appears. If there are any saved patient records, they will appear listed on the screen as shown on
the illustration.

Clairn List | MNewClairm | Provider Setup | Patient List

payer: |All ." Edit Payer List
Add Patient (1 - 3) out of 3 Patients

Name

] Hrd Insured 09/04/1978 562734523745 Absolute Total Care 788787878787 M ;ifaat:‘g:e;:‘fs%% Edit |
%{h Insured 07/04/1974 123456789 aiﬁg‘;ferfd‘ca' 678678678  F iii:;r;?yclfzes’ﬁm Edit | Delete
% Insured 01/07/1976 345345345345 Aetna 2314523433 M &7: g;é‘;;"ad Goldville, £t | pajete

* To 539 = dependent to an existing insured patient, chedk the comesponding chedtbax prior to [Add Patient]

(1 - 3) out of 3 Patients

2. Select a payer from the Payer drop-down list and click Add Patient. The Add Patient screen
appears.

3. Required fields are preceded by a red asterisk. Notice there are two tabs: Patient Details and
Insurance Details. If the patient and the insured are not the same, then both sections must be
completed before saving the patient record.

Add Patient
sPatient Account #
Insured
Deta Details
er patient data dicates rzquired field
S5t Mame *First Name Middle Initial
“Date of Birth “Gender
* Address Address2
*City “State =Zip Phone
*Member ID “Relationship To Insured
’Eelect-- M
Employment Status Student Status
~Select- lll ~-Select-
[ Next Tab ] [ Besst] [ Cancel ]

4. Enter the patient data and when you are finished, click Save to save the record. A Patient Entry
Status message appears confirming the record has been saved.

5. To enter more patient records, return to the previous window by clicking To Patient List and repeat
the previous steps.
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6. To return to the patient record and make changes to it or to print the record, click Previous

Screen. Once you enter a patient record, you can print a hard copy of it by pressing CTRL + P on
your keyboard.

Search for a Patient Record
Follow these steps to search for a patient record:

1. Use the field next to the Search button to enter your search criteria. You can search for a patient by

using any character string found on the record, such as First and Last nhame, Address, City, and
State.

ClaimList | MewClaim | Provider Setup | PatientList

Fatient Search Criteria

Oz
Payer: |All ." Edit Payer List m m
Add Patient (1 - 3) out of 2 Patients
Patient
Relation|DOB [Payer [Member ID (Address |Actions 7
Name
Bernard, 456 Dunder Avenue,
[ And Insured 09/04/1978 562734523745 Absolute Total Care 788787878787 M Seranton, PA 56789 Edit
Bucket, Advanced Medical 450 Penny Lane,
O Eenih Insured 07/04/1974 123456789 Management 678678678 F Liverpool, GA 45678 Edit | Delete
Goldman, 678 Gold Road, Goldville,
O Frankie Insured 01/07/1976 345345345345 Aetna 2314523433 M WA 98089 Edit | Delete

* To add a dependent to an existing insured patient, check the comespending chedbox prior to [Add Patient

Add Patient (1 - 3) out of 2 Patients

2. Press Enter on your keyboard or click Search to start the search.

3. If no patients are found or if the record you are trying to locate is not on the list, try expanding your
search criteria by entering less specific data.

Edit a Patient Record
Follow these steps to edit a patient record:

1. If necessary, use the search procedure described above to find the patient record you wish to edit.
2. When you find the patient record, click on the hyperlinked Patient Name or the “Edit” link in the
Action column. The Edit Patient window appears, showing the patient record.

3. Edit the data as needed and when you are finished, click Save to save your changes or click Cancel
to leave the record unchanged.

Delete a Patient Record
Follow these steps to delete a patient record:

1. From the Patient List window, find the patient record you wish to delete and click the “Delete” link in
the Action column. A confirmation dialog box appears asking if you want to delete the record.
2. Click OK to delete the record or click Cancel to keep the record.
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New Claim

New Claim allows you to enter claim information directly into a HCFA 1500 claim form.

L

Note: Before using New Claim for the first time, you must complete the Provider Setup section
on page 16.

Follow these steps to enter a new claim:

1. Select Claims > Create, and click the "New Claim” link.

Clairm List | Mew Claim | Provider Setup | Patient List

Step 1 - Select organization

—Please selectthe organization name— |+

Step 2 - Select pay to address and provider
—Flease select pay to address — | v |

—Flease selecl a provider— | ¥ |

Step 3 - Select payer name

—Please select payer— |v

In Step 1, select the organization for which you wish to submit the claim.

In Step 2, select the pay to address and the provider name for the claim.

In Step 3, select the payer name from the drop-down menu. Step 4 appears.

Select a service address by clicking the option button next to it.

Click Continue to Claim Data. The claim data entry form appears.

Clicking the Select Patient button at the top of the screen opens a list of patients associated with
the selected payer. If you select one of the patients from the list, the patient’s demographic and
payer data will populate the claim entry form. This step is optional.

8. Enter the ICD-9 Diagnosis Code(s) and Procedure information. Additional required fields are
highlighted in pink and preceded by a red asterisk (*).

NowunhswnN

L

Note: To progress through the required fields, use these shortcuts:
Forward: CTRL + >
Backward: CTRL + <

9. Complete the rest of the claim form.

10. To use the Supplement Claims feature, enter SUP* in the Comment field.

11. To print a paper copy of the claim form, press CTRL + P on your keyboard.

12. When you finish the form, select Save at the end of the page to save your work. A Save
Confirmation screen appears with instructions for creating a new claim, adding the claim to a batch
for submission, and submitting claims.

e To submit another claim using the same provider and payer, click New Claim located in the
upper right corner of the screen.

e To submit a claim for a different provider or payer, click Close to return to the New Claim
screen.

e To create a claim batch, click Close and select “"Claim List.”
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Claim List allows you to view, edit, submit, and manage claims. Before using Claim List for the first
time, you must have completed and saved one or more claim forms. Any claim can be edited and saved
as a new claim, which helps to avoid re-keying the same information for multiple claims per patient or

multiple patients with similar services.

This service provides search criteria to assist in selecting groups of claims for submission. Click the

Clear button to reset all fields to their original settings.

Click “Customize Page” to specify what information you want to appear on the Claim List. You can sort

the list of claims by clicking on any of the column headings.

Use Claim List

Follow these steps to work with claims:

1. Select Claims > Create, and click the “Claim List” link. If any claims have been created and saved

they will appear listed on the screen as shown below:

Claim List | MNew Claim | Provider Setup | Patient List

Search Criteria

Status Claim Type Service Date Search Text
|Saved}Unsubmmedtl |---Se|ect--- M From To w m
[ Select &l [ Delete Selected Submit Selected (1 - 2) out of 2 Claims

Patient Name ro\nder 1D Clalm Payer Status Total Service Batch
Name Date Charges Date 1D

[J1. Braverman,Larry 55555555 Saved 04/14/2010 £50.00 04/14/2010

|I'I'I

Commercial Aetna

L’_

m
=
-

T
z
o
=

[Jz. Goldman,Frankie 55555555 Commercial Aetna Saved 04/14/2010 3$150.00 04/14/2010

To search for a claim, use the Claims Search Criteria fields located at the top of the screen.

¢ Click Search to perform a search.

e Click Clear to reset all search fields to their original settings.

e The Search Text box can be used to search on data contained in a claim,
and “Provider ID.”

e Click Clear and then click Search to show the full claim list.

like “Patient Name”

2. Check the box to the left of the claim you wish to submit or delete, or click “Edit” next to the claim
you wish to edit. When you select the action you wish to take, the claim will appear in a separate
window.

3. To the right of the claim, click "HCFA” to view the HCFA format of this claim.
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Check Claims

Overview

The Claim Status service allows you to check the status of a previously submitted claim, regardless of
whether the claim was submitted manually or electronically. This tool allows you to manage claim
rejections, reimbursements, and online claim adjustments, which eliminates having to re-key
information and generate duplicate forms.

Key Features

Fast access to real-time claim status information for multiple payers

Individual and batch functionality for improve productivity

Time-saving batch management features: sort, move, copy, delete

Ability to track claims throughout the reimbursement cycle

Verify that claims have been received by payers

Quickly determine the status of claims

Expedite follow up on rejected claims

Obtain enroliment forms by selecting Setup > More and clicking the “Payer Enrollment” link

Check a Claim’s Status

1.
2.

uvew

Select Claims > Claim Status on the main menu.
Select a payer.

Note: The claim status request screen varies depending on the payer.

Select a search type (if applicable).

Enter search criteria to locate the claim.

Enter requesting provider and service provider information (if applicable). To find a provider ID, click
the Edit button.

If the Requesting Provider is the same as the Service Provider, click the "Same as Requesting
Provider” check box. This populates the Service Provider fields with Requesting Provider information.
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7. Click Send to Payer to process your query.

Step 1 - Select payer
Aetna Tools

Edit * Aetna DocFind
‘Aetna ["] Payer List... Page + Senices Requiring Precertification

* Aetna Benefit Products Booklet

Step 2 - Select how you wish to search

|Subsciber [v]

Step 3 - Enter search criteria  * indicates required fields
* Subscriber ID

123456769

# Subscriber Last Name * First Name M.L.
WATKINS GERALD

* Subscriber DOB * Gender

02/04/1976 Male

* Service Start Date Service End Date

02/16/2011

Total Submitted Charges Claim Number
Requesting Provider
+ Provider ID Type = Provider ID + Individual/Organization
# Last/Organization Name First Name { Required for Individual ) M.I.
ALAN WV JOMES ALAN

Service Provider

Same as Fequesting Provider
= Provider 1D Type * Provider ID = Individual/Organization

v

* Last/Organization Name First Name { Required for Individual ) M.I.

Step 4 - Begin search

Send to Payer ResetPage I
Disclaimer: The Provider understands that receipt or use of this information does not guarantee payment of any health care claim by Aetna
and such information is subject to change, even retroactively, at any time.

The following illustration shows results of this inquiry.

Aetna

Claim Status Notification  [SaveResponseioBaioh]

Request: Insured=GERALD WATKINS MemberlD=123456789 DOB=02/04/1976 ProviderD=1382640710

Emdeon Trace # 160044503

Patient: Ik & Tws Service Provider: WRADREAN § AN Y9
Member |D: 222222222 Federal Tax 1D : 111111111
DOB - 03/30/1966 Requesting Provider: SRATRRAN § AL v s
Gender : Female Federal Tax 1D - 111111111
Claim #: ESFTFDZOV01 Financial Inquiry

Status : Finalized/Payment-The claim/line has been paid.
Payment reflects usual and customary charges.
Finalized/Payment-The claim/line has been paid.
Processed according to contract/plan provisions. This change to be effective 1/1/2009: Processed according to contract provisions.
(Contract refers to provisions that exist between the Health Plan and a Provider of Health Care Services).
Status Information Date : 09/30/2004
Total Claim Charge Amount :$99,999.99
Claim Payment Amount - $800.00
Adjudication Date - 11/19/2003
Payment Method : Check
Check or EFT Date : 11/21/2003
Check or EFT #:00000006
Claim Senvice Date - 10/12/2003-10/12/2003

Line Procedure Svc Date As Of  Charge Paid Status
Units

64400 1 10/12/2003-10/12/2003 09/30/2004 $99,999.99 $969.60 Finalized/Payment-The claim/line has been paid.
Payment reflects usual and customary charges.
Finalized/Payment-The claim/line has been paid.
Processed according to contract/plan provisions. This change to be effective
1/1/2009: Processed according to contract provisions. (Contract refers to
provisions that exist between the Health Plan and a Provider of Health Care
Senices).

Check Claims
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8. Click “Save Response to Batch” to save the response to a new or existing batch.

4 Note: The "Save Response to Batch” link appears only if batching is off.

The following window appears:

Default .OH Bl
Refresh List

—0OR —
Save Transaction to a MNew batch:

Close

Do one of the following:

e To save the response to an existing batch, choose the batch from the list. Click “Refresh List” if
your batch does not appear in the list.
e To save the response to a new batch, enter the batch name.

Click Save.

9. Click Return to Previous to return to the Claim Status request screen. Do not click the Back
button on your browser since this may cause unpredictable results.

Claim Status Information

Emdeon Office provides the following claim status information:

Claim status

Claim number
Trace number
Patient/insured data
Provider data

Claim amount
Payment amount

Claim Adjustment
You can request a claim adjustment for some payers using Claim Status or Batch Manager.

L

Note: Claim Adjustment is only available for the payers who support the function.

Request a Claim Adjustment from Check Claims

Select Claims > Claim Status from the main menu.

Select a payer.

Enter search criteria in the remaining fields on the form.

Click Send to Payer. After a few seconds, a Claim Status Notification appears with one or more
claims matching your search criteria.

pPLhE
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5. Locate the claim you want to modify and click the “Adjustment Request” link.

Blue Cross Blue Shield of Massachusetts

Claim Status Notification  [SaveResponseloBaich]

BCBSMA Services
. Claim Coding

Assistance

Request: Insured=ASDFASDF ASDFASDF MemberlD=34234234234 DOB=12/12/2003 ProviderlD=4545454545
Emdeon Business Services Trace # 112166650

Patient: BEN A SOTIRAKOPOULO Service Provider: AGAPE HOME MEDICAL

Member ID: 45896197600 Federal Tax D : 641244476
DOB - 12/26/1952 Requesting Provider
Gender :Male Federal Tax D : 742767006
Claim# : 06061506010000 Adjustment Reguest

Status - Acknowledgement/Receipt-The claim/encounter has been received. This does not mean that the ¢
for adjudication.
Claim/encounter not found.
This is claim level status
Status Information Date - 03/28/2002
Total Claim Charge Amount : $22,252 11
Claim Payment Amount - $52.11
Adjudication Date : 03/28/2002
Payment Method : Check
Check or EFT # : 003166702
Medical Record # - 18003526
Claim Senice Date : 04/22/2002-

has been accepted

04/22/2002
Line Procedure Mod Date As Of Charge Paid Status
1 E1140 B2.D4 04/22/2002-04/22/2002 03/28/2002 $10.052.10 $312.43 Finalized/Payment-The claim/line has been paid.

For more detailed information. see remittance advice.

Blue Cross Blue Shield of Massachusetts

Claim Adjustment Request
Status Information

Billing _
Provider ID: ©+ )

Payer Claim —_—
2 D60&S T

Acknowledgement/Receipt-The claim/encounter has been

received. This does not mean that the claim has been accepted

for adjudication.

Status
Category:
Status: Claim/encounter not found.

Validate claim infoermation

Correct? Enter corrected information
Subscriber 1D: 45898 £ 4w o
Insured Name: SOFRAaONOLLO SEM & e
Member Name: SOFRAOMOLLO SEN & CIne
Member DOB: 19521226 Cno
Member Gender: M Mo

Date of Service: 04/22/2002-04/22/2002 Mo
Enter additional claim information

If any of the following information is incorrect on the original claim, please select from choices listed or enter the correct
information in the fields below

Relationship: ]

Primary Diagnosis:

Other Insurance Information
Other Insurer Name:
Street:
City:
State: Zip:
Insured Name:
Policy # or Insured ID:

Comments

Describe any other information that is in error and enter the correct information below.

Contact Information *indicates required fields

= Name: * Phone: Email:
Actions
[ Submit ] [ Return to Claims Detail I [ Return to Check Claim

Emdeon Office Claims User Guide

Check Claims

A Claim Adjustment Request data entry form appears showing the patient and claim information.
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6.

7.

8.

9.

In the Validate Claim Information section, review the data elements carried over from the claim.
If you want to modify the information, click No in the Correct? column and type the correct
information in the box.

The next step varies depending on the payer:

e Blue Cross Blue Shield of Massachusetts: Update information in the Enter Additional Claim
Information and Other Insurance Information sections if necessary.

e Coventry plans: Indicate the Reason for Adjustment by selecting a value from the list. Indicate
all the claim lines that need to be modified, if applicable, and include any pertinent comments for
each modified item.

Use the Comments field to type any additional information that may be relevant to the claim, up to
250 characters. Be as specific as possible in making your request. If none of the data elements
referenced above pertain to your inquiry, you can complete the Comments section only.

In the Contact Information section, type the name and phone number of a contact person.

10. When you finish entering the correct claim data, click Submit. A Claim Adjustment Confirmation

appears. Use the browser’s Print button to print the confirmation notice for future reference.

11. Next, do one of the following:

e To return to the previous Claim Status Notification screen, click Return to Claims Detail. This is
the claim detail screen you created the adjustment request from.

e To return to the Claim Status screen, click Return to Check Claim. This will take you to a new
input screen where you can inquire on another claim.

Request a Claim Adjustment from Batch Manager

1.
2.
3.

4,
5

Claim

Select Batch Manager from the main menu.

Select or search for the batch that contains the transaction(s) you want to modify.

On the Batch Inquiry screen, click the link in the Responses column. The Claim Status Notification
appears.

Click the “Adjustment Request” link. The Claim Adjustment Request data entry form appears.
Follow steps 6-10 above in the Request a Claim Adjustment from Check Claims section.

Financial Inquiry

The Claim Financial Inquiry (CFI) transaction allows you to receive a more detailed response when
checking the status of a claim. The CFI transaction occurs after a Claim Status Notification has been
returned by a claim status transaction.

4 Note: The CFI transaction is only available for the payers who support the transaction.

Request a Claim Financial Inquiry

pPLE

Select Claims > Claim Status from the main menu.

Select a payer.

Enter search criteria in the remaining fields on the form.

Click Send to Payer. After a few seconds, a Claim Status Notification appears with one or more
claims matching your search criteria.

Select the claim you want to receive a CFI response for.
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6. If the payer supports the CFI transaction, there will be a “Financial Inquiry” link near the Claim #
section. Click the “Financial Inquiry” link.

Aetna

Claim Status Notification  [SsveResponsetoBatch]

Request: Insured=GERALD WATKINS MemberD=123456789 DOB=02/04/1976 ProviderlD=1982640710

Emdeon Trace #: 160044503

Patient: NS Fa SN Service Provider: WRGORGAN § aAnL veirs
Member ID- 222222222 Federal Tax ID - 111111111
DOB - 03/30/1966 Req ing Provider: Lamny vy
Gender -Female Federal Tax ID - 111111111
Claim #: ESFTFDZOVD1 Einancial Inqui

Status - Finalized/Payment-The claim/line has been paid.
Payment reflects usual and customary charges.
Finalized/Payment-The claim/line has been paid.
Processed according to contract/plan provisions. This cha
(Contract refers to provisions that exist between the Health
Status Information Date - 09/30/2004
Total Claim Charge Amount - $99,999.99
Claim Payment Amount : $800.00
Adjudication Date - 11/19/2003
Payment Method - Check
Check or EFT Date : 11/21/2003
Check or EFT # - 00000006
Claim Service Date - 10/12/2003-10/12/2003
Line Procedure Svc Date AsOf  Charge Paid Status
Units
64400 1 10/12/2003-10/12/2003 09/30/2004 $99,999.99 5969 60 Finalized/Payment-The claim/line has been paid.
Payment reflects usual and customary charges.
Finalized/Payment-The claim/line has been paid.
Processed according to contract/plan provisions. This change to be effective
1/1/2009: Processed according to contract provisions. (Contract refers to
provisions that exist between the Health Plan and a Provider of Health Care
Senices).

jto be effective 1/1/2009: Processed according to contract provisions.
and a Provider of Health Care Senvices).

The Claim Financial Response will be returned.

Aetna

Claim Financial Response
Request: Insured=IMA PATIENT MemberlD=222222222 DOB=19660330 Claim#=E8F7FDZ0V01 ProviderlD=111111111

Emdeon Business Senices Trace # 987654321

Payee - Cardio Clinic Payer - Aetna
Federal Tax ID - 123445660 Tax D - 234556770
Payment Information Address - Farmington Ave.
Payment Amount $120.00 Hart, CT 0006
Check # - 00000006 Payment Information

Check Issuance Date : 06/05/2010 Production Date - 06/02/2010

Receiver # - 0474210003

Claim Financial Inf ion - Remi Infi ion Only
Claim # - EBFTFDZ0V01
Patient Control # - 0000-SR00-T000
Claim Status - Processed as Primary

Total Amount Charged $245.00
Claim Payment $120.00
Patient Responsibility §20.00

Filing Indicator - Indemnity Insurance
Received Date - 06/01/2010
Claim Office Contact - Aetna
Telephone : (732) 222-5555
Madified Facility Type - Inpatient Hospital

Patient Service Provider
MName : Austin, Jane Name - Cardio Clinic,
Member ID - 12345678901 Federal Tax ID - 4566778990
Subscriber

Member ID : 12345678901

Claim Adjustments
Adjustment Group : Payor Initiated Reductions
Quantity Amount Reason
$105.00  Previously paid. Payment for this claim/service may have been provided in a
previous payment.

Service Details
Line Procedure Date Paid Charge Paid Service
Units D
#1 33472 05/1%/2010 - 0 $245.00$120.00 Provider Control # - 0001
05/15/2010
Adjustment Group : Patient Responsibility
Quantity Amount Reason
0 $20.00 Coinsurance Amount

Return to Previous

7. Click the Return to Previous button to return to the Claim Status Notification response.

Page 32



Emdeon Office Claims User Guide

N
( J emdeOI’T Supplement Claims

Supplement Claims

Overview

This section describes how to supplement primary and secondary claims and how to generate and
submit secondary claims through Emdeon Office. It is assumed that you are already familiar with the
Send Claims feature in Emdeon Office (page 9).

Secondary Claims

A secondary claim is a request for payment to a secondary payer after the primary payer has met its
portion of responsibility for the claim.

A secondary claim is created by merging data from:

1. Existing data on the primary claim and

2. Supplemental data entered by Emdeon Office users through the Supplement Claims feature. This
supplemental data is obtained from printed EOBs and electronic remittance files sent by primary
payers.

Secondary Claims in Office

Currently, there are two ways to create secondary claims in Office: through Supplement Claims and
through Reporting & Analytics (see Secondary Claims on page 169 in the Reporting & Analytics
section). This section describes how to create secondary claims through Supplement Claims, but there
are some fundamental differences between the two methods.

Feature Secondary Claims: Supplement Claims Secondary Claims: Reporting & Analytics

Create secondary claim Upload a primary claim for the purpose of Create a secondary claim only from a primary
converting it to a secondary claim to submit to claim that has already been submitted through
another payer. Make changes needed to create the Emdeon clearinghouse to the payer. Using
the secondary claim immediately after you this method, you will upload the claim once, not
upload the claim. The changes you make are twice.

independent of the submission of the primary
claim to the primary payer.

Change field values Make changes only to certain fields Make changes to any field
Submission format Submit claims in multiple formats Submit claims only in ANSI X12 4010 or NSF+
format

Secondary Claims Workflow

The following steps describe the typical workflow for a batch file containing claims needing to be
supplemented and sent to secondary payers:

1. Select Claims > Import. Click the Proceed to Next Step button.
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2. On the Send Claim File screen, select the “Hold submission for entry of additional data” check box,

3.
4,

5.

as shown on the next illustration.

‘€ Import Claims - Windows Internet Explorer g@
2 = Help
Send Claim File

You must be registered to perform the Impart Claims service. In addition, before submitting a claim file using the Irmport Claims service
you rust verify that your claim file format is valid. f yvou hawve notwvalidated yaur claim file format with a technician then please contact
1-877-469-3263 for additional information. [fyou do notvalidate your claims file format then yaur claim file may be successfully
transmitted BUT itwill not be processed atthe Emdeon Claim Processing Center and you will not be notified.

Hald submission for entry of additional data.
Locate claim file
Click the "Browse..." button below and you will be prompted to locate the claim file you wish to upload

Browse...

Last file uploaded: C\Documents and Settingsieweeks\DeskiopiOfficeltest files\CI_OK bt

Select how you wish the claim file to be processed
& Mormal - Upload and submit claim file to the Emdeon Business Services Claim Center for processing

 Test your internet connection - Claim file will nat be processed

Choose an action
You are now ready to upload your claim file. The time this takes will vary depending on the size ofthe claim file and the speed of your
intermet connection. This window must remain open until this process is complete. Closing the window will terminate
the process.

Submit Claim for Processing ] [ Cancel ]

Copyright © 1396-2010 Emdeon Business Services LLC. Al rights reserved.
Help|Glossary|Contact Customer Support|License and Business Associate Agreement
Emdeon Business Services subscribes to the HONcode principles of the Health On the Net Foundation

Using the Browse... button, locate the file to be uploaded and click Submit Claim for Processing.
Return to the home page and select Claims > Supplement to open the Supplement Claims
application. A list of batches appears.

[ Batch List [| |

wrzi02192010141212. 1 1 Supplemented Supplement | Send | Delete
wrzi02262010093717. 1 1 Supplemented Supplement | Send | Delete
wrzil2262010093719. 1 0 Supplemented Supplement | Send | Delete
wrzil2262010130115. 1 0 Supplemented Supplement | Send | Delete
wrzil2262010141559. 1 0 Supplemented Supplement | Send | Delete
wrzil2262010141577 1 1 Supplemented Supplement | Send | Delete
wrzi040710134359394 1 0 Supplemented Supplement | Send | Delete
wrzi040710134413440 1 0 Supplemented Supplement | Send | Delete

Select the batch containing the claims you would like to supplement by clicking the appropriate
“Supplement” link.

Enter supplemental data using the various data entry screens.

When you are finished working with the claims, return to the Batch List and click "Send” to submit
the batch for processing.

Alternate Workflow using Claim Entry

When claims are entered through the Claim Entry feature:

1.

2.

Enter claims through Claims > Create, making sure to indicate "Sup*” in the Remarks field. This
tells the system to hold submission of the claim to allow entry of data for secondary claims.

Execute batching/claims submission from Claim Entry as usual. Files tagged with “"Sup*” in the
Remarks field are not sent for processing.

Proceed to Claims > Supplement to supplement and submit claims using steps 4-7 listed above.
When claims are sent through Supplement, the system removes the “Sup*” tag from the claim and
releases it to NEIC for processing.

Email Notifications

After you upload a supplemental batch, you will receive an email notification indicating the batch is
pending and that you need to supplement, send, or delete the batch. If the batch remains in a pending
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state for over four days, you will receive additional email notifications reminding you that action is
needed.

Troubleshooting Guide

For a list of common issues and error messages you may encounter when working with Supplement
Claims, refer to the Troubleshooting Guide on page 56.

Output Format

At the bottom left of every screen, there is a note indicating the type of output format used: NSF 2.5,
NSF+, or 4010. The Claim Level and Line Level Entries screens will vary depending on which output
format is used.

Batch List

When you select Claims > Supplement, a list of batches that have been flagged as needing to be held
for the entry of supplemental data appears. The Status column indicates the number of claims that
have already been supplemented in each batch.

EEE |

wrzi02192010141212 1 1 Supplemented Supplement | Send | Delete
wrzil2262010093717 1 1 Supplemented Supplement | Send | Delete
wrzi02262010093719. 1 0 Supplemented Supplement | Send | Delete
wrzi02262010130115. 1 0 Supplemented Supplement | Send | Delete
wrzi02262010141559. 1 0 Supplemented Supplement | Send | Delete
wrzi02262010141577. 1 1 Supplemented Supplement | Send | Delete
wrzi040710134359394 1 0 Supplemented Supplement | Send | Delete
wrzi040710134413440 1 0 Supplemented Supplement | Send | Delete

Action Column
In the Action column, you can select “"Supplement,” “Send,” and “Delete.”

e The “Supplement” link opens the Claim List screen, which lists the claims in a batch that can be
supplemented. When you select a batch to supplement, a file locking mechanism prevents other
users from accessing the same batch. This way, only one user is allowed to work on one batch at a
time. If other users select the same batch to work on, they will see an alert message as shown
below.

Message from webpage

! E Batch wrzi02192010141212, is in use by user Ihalpert,
L

e The “Send” link sends a batch of claims that was previously held for the entry of supplemental data.
If there are no errors within the supplemented data, the file is sent to Emdeon Office for processing
and the batch is removed from the list. If the system detects any errors in the additional data
entered, an error message will appear on the screen and the batch will not be removed from the list.
Once all errors are corrected and a batch is re-sent, the batch will be removed from the list. To view
some sample error messages you may encounter when sending a batch, see Ambulance Data

e The 4010 Ambulance Data screen functions similarly to that of NSF+: you can add ambulance data
to both primary and secondary claims, and available data pre-populates the appropriate fields (see
Ambulance Data on page 48). However, with 4010, you have the ability to add claim level
ambulance data as well as line level ambulance data. Entering ambulance information at the claim
level negates the need for you to include it for each service line when there are no differences to
report at the line level.
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BatchList | ClaimList | Claim Summary | | |

| Provider Data |

| Ambulance Data

Medically Necessary:

Purpose of Stretcher: Patient Discharged: Patient Admitted:

Batch Name Claim # Destination Payer Patient Name Date of Birth Claim Date

wrzi02262010093717. 1 i WILLIAMS 07/15/1990

Ambulance Data Claim Level

Patient Weight: Hospital Admit: *Type of Transport:

Bed Confined Before: Bed Confined After: Moved by Stretcher:

|7Seleclf M ‘7Selectf Ill |7Se\eclf M

Ui ous/Shock: Emergency Situation: Physical Restraints:

|—Se|ect— l:l ‘—Select— M |—Se\ect— ’1]

Visible Hemarrhaging: “Transported TO/FOR:

|—Se|ect— u ‘—Select— tl
=Miles: Purpose of Round Trip:

|7Se\ectf

¥

‘*Sslectf M
Senvices Available:

|7Seleclf u

[ Save Claim Level Reset Claim Level Page

Procedure Procedure Ambulance
Code Modifiers Amount Data Applied

- Service Dates

Line From - Through
1 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
2 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
3 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
4 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
5 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
6 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0

Line Level Entries If different from Claim Level

Apply Adjustments ta Line Mumber:

Ambulance Data

Patient Weight: Hospital Admit: *Type of Transport:

Bed Confined Before: Bed Confined After: Moved by Stretcher:

|—Se|ect— M ‘—Select— ’il |—Se\ect— M

Unconscious/Shock: Emergency Situation: Physical Restraints:

|—Se|ect— tl ‘—Select— M |—Se\ect— hl

Wisible Hemorrhaging: *Transported TO/FOR:

|—Se|ecl— M ‘—Select— u

Medically Necessary: *Miles: Purpose of Round Trip:

Purpose of Stretcher: Patient Discharged: Patient Admitted:

‘—Select— M |—Se\ect— u

Services Available:

| —Select- M
Save Lins Reset Page

Selected Claim List: Claim 1

Output Format 4010

Claim Total
$600.00

¢ Sample Error Messages on page 53.

e The “"Delete” link deletes the batch. You may need to delete a batch if you realize you have already
uploaded that batch and want to avoid sending duplicate claims or if you wish to print out the batch
from your Practice Management System instead of sending it electronically.
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This screen opens when you click the “Supplement” link on the Batch List screen.

Batch List || Clairn List | |

Claim q Date of N A Claim
T e e oo

PALMETTO
[QSecondary |  WEBBSUZE  F 07/15/1970 GOVERNMENT PENEFITS 09/05/2003 £200.00
ADM.
O 2 ng?v%\fr M 07/15(1970 ALASK A MEDICARE 09/05/2003  $126.00
O 3 m,LKER M 11231938 ALASKA MEDICARE 09/05/2003  $388.00
[ Secondary 4 Er M 09/10/1948 AETNA US HEALTHCARE $95.00

Supplement

Output Format MSF2.5

Until you select one or more claims to supplement, only the tabs shown on the above illustration will
appear. Some of the claims will show the label Secondary in the Select column indicating they have
been previously supplemented and flagged as Secondary claims. Clicking the Supplement button opens
the Claim Summary screen. This is true for all claim types: NSF 2.5, NSF+, and 4010.

If the selected claim has not been designated as Primary or Secondary, the Claim Summary screen

appears, as shown on the following illustration:

Batch List | Claim List || Claim Summary

Batch Name ;Elaim gestmatlon Enor iz [z Gender Date of Birth Claim Date
tes4110707111730587 C;%ES[X ayer DOODY, HOWDY 11/23/1938  09/05/2003

00472003 - 0304/2003 99213 £50.00
2 00472003 - 02/04/2003 92020 $45.00
[ Designate as Secondary Claim ] [ Designate as Primary Claim ]

Secondary

Selected Claim List: Claim 2

Output Format MSF+

Claim
otal
$95.00

Service Service Dates Procedure Procedure
Line From - Through Code Modifiers Units

Secondary Claim data and Primary Claim data cannot both be entered. Please designate whether this claum should be treated as Primary or

Once a batch and an associated claim have been selected, the Claim Summary screen (shown above)
allows you the option of designating the claim as either Primary, for the purpose of adding other
insurance information, or as Secondary, for the purpose of adding primary payer payment information.

e If you select Designate as Primary Claim, the Insurance Information tab displays.
e If you select Designate as Secondary Claim, three more tabs display: Claim Level Entries, Line

Level Entries, and Insurance Information, as the next section explains.
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This section applies to NSF 2.5 claims only. If you work with another type of claim, please skip to NSF+
Claims on page 44 or 4010 Claims on page 51.

Claim Summary - Secondary Claim

When you select a secondary claim to supplement, all tabs become available. The Claim Summary

screen for a secondary claim appears as shown on the next illustration:

Batch List | Claim List || Claun Summary | Claim Level Entries | Line Level Entries | Insurance Information | | Provider Data
Batch Name Claim # Destination Payer Prior Payer Patient Name Gender Date of Birth Claim Date Claim Total
nsfd110707115006985 5 HORIZON WJ PLUS DOODY HOWDY M 122311947 $155.00
Service Service Dates Procedure Procedure
Line From - Through Code Modifiers
040172005 - 040172005 99214 £95.00
2 04012005 - 040172005 92015 £30.00 10
3 040172005 - 040172005 32015 £30.00 10

Buoth Adjudication Date and Payer Amount Paid must be specified first to begin supplementing this clairm. Then press Save to continue.

*Adjudication Date  *Payer Amount Paid  Obligated to Accept in Full - Allowed Amount
[

[ Designate as Primary Instead ] [ Back Out All Changes ]

Selected Claim List: Claim4a
Output Farmat NSF2.5

If the Payer Amount Paid is 0.00, you are directed to the Claim Level Entries screen to enter denial
reasons. (See Claim Level Entries — NSF 2.5 on page 38).

If the Payer Amount Paid is a dollar amount greater than zero, you are directed to the Line Level
Entries screen to enter applied amounts. (See Line Level Entries — NSF 2.5 on page 39).

Two new fields on this screen are described below:

Field Description
Obligated to Accept in Optional field. This is the amount the provider agreed to accept as payment in full, under
Full contract provisions.

This field should only be used if the entire claim was applied to the Obligated to Accept in
Full Amount and the information will not be reported at the service line.

Total Obligated to Accept Amounts may be entered at both the line and claim level but not
both.

Allowed Amount

Optional field. Maximum amount a provider is allowed to charge for services under contract
provisions. Allowed Amounts may be entered at the line level and if entered, will result in
their claim level total being incremented.

If you select Back Out All Changes, the claim will revert to its original state and the previous Claim
Summary screen will appear.

Claim Level Entries — NSF 2.5

The Claim Level Entries screen is used to enter denial reasons and denied amounts.

When the Payer Amount Paid on a claim equals 0.00, you must go to this screen to enter the denial
reasons. This information is obtained from the EOB (Explanation of Benefits) or remittance sent by the

primary payer.
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Batch Last | Clain List | Clawn Summary || Claim Lewel Entrigs | | | Insurance Information | Prowider Data

Gender Date of Birth Claim Date Claim Total

Batch Name Claim # Destination Payer Prior Payer Patient Name

nsfd 1107071 15006935 4 AETNA US HEALTHCARE WALKER, JAY M 05/10/1945 $25.00
*Denial Reason 1 *Amaunt 1

‘Nan—covered henefits (02) v| |$95.EID |

Denial Reason 2 Amount 2

\ 4 | |

Denial Reason 3 Amount 3

\ 4 | |

Selected Claim List: Claim 4

Output Format M5F2.5

Line Level Entries — NSF 2.5

This screen allows you to enter payments and adjustment amounts for each service line on a claim.
Obtain these amounts from the EOB (Explanation of Benefits) or remittance sent by the primary payer.

Batch List | Claim List | Claim Summary | Clam Level Entries || Line Lewel Entries | Insurance Information | Prowider Data

Claim Total
$95.00

Gender Date of Birth  Claim Date

09/10/1948

Patient Name
WALKER JAY M

Claim # Destination Payer Prior Payer

AETHA US HEALTHCARE

Batch Name
nsfd110707 115005385 4

Total Distributed

Disallowed Disallowed -
CERERE

§0.00 $0.00 $0.00 $35.00

Service Service Dates Procedure Procedure Applied
Line From - Through Code Modifiers Amount

Payer

$60.00 <>

04/01/2005 - 04/01/2005 99214 £95.00 £85.00
Dizallawed Cost Containment Dizallowed Other Deductible Corlnsurance Payment
none none $0.00 $35.00 $60.00
Obligated to Accept Amount Allowed Amourt
$E0.00 none
Total $95.00

Line Level Entries

2Apply Papments Adiustments ta Line Mumber:

Dizallmwed Cnst Cantainment  Disallmwed Other - Nedurtible

Cr-Inairancq Pavment Ohlinated tn Arcent Arnant Allnwed Amnnnt

~

)

Supplement Claims

At the top of the screen under Total Distributed there is a row of summary dollar amounts (these
amounts are described in detail on the following table). Next to each service line there is also an

Applied Amount column.

These amount fields are used to aid you in determining that you have fully accounted for the difference
in the amount the payer paid on the claim versus the adjustments that occurred to the claim.

The following table contains definitions for the amounts shown on the Line Level Entries screen under

Total Distributed.

Adjustment Data Description

Disallowed Cost Containment

The portion of line charges disallowed by the payer due to the failure of
either the provider or insured to meet the cost containment provisions of
the insurance plan.

Disallowed Other

The portion of line charges disallowed by the payer for reasons OTHER than
the failure of the provider or insured to meet the cost containment
provisions of the insurance plan.

Deductible

Any applicable deductible amount. If the patient has already met their
deductible for the year, this field will contain zeroes, or be empty meaning
that no deductible amount was applied to the claim.
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Adjustment Data Description
Co-Insurance An agreement between the insured and the insurer where the insured

agrees to cover a set percentage of the covered costs after the deductible
has been paid.

The coinsurance is typically 20% of the allowed amount.

On this screen, coinsurance is the amount applied toward the coinsurance
by the primary payer.

Payment The amount paid by the insured on the claim.

Payer Amount Paid The amount paid the payer on the claim. The Payer Paid Amount is taken
from the Claim Level Entry screen where the payer amount paid was initially
entered and is simply a visual aid for you to be able to compare the
amounts entered at the line level against the claim level payment.

Applied Amount This column is a total of the payments and adjustments entered for each
service line.

Line Level Entries

Apply Payments Adjustments to Line Number. | Service Line 1 v|

Digallowed Cost Containment  Disallowed Other Deductible ~ Co-Insurance  Payment  Obligated to Accept Amount Nluwed__AmUum_
: | : ooo | [s00 | (000 | [850.00 5 |

Reason Code  Reason Description

Selected Claim List: Claim 4

Output Format MSF2.5

The bottom portion of the screen (above) allows entering data for each service line. Two new optional
fields are described below:

Adjustment Data Description

Obligated to Accept Amount Optional field. This is the amount the provider agreed to accept as payment
in full, under contract provisions.

This field should only be used if the entire claim was applied to the
Obligated to Accept in Full Amount and the information will not be reported
at the service line.

Total Obligated to Accept Amounts may be entered at both the line and
claim level but not both.

Note: Obligated to Accept Amount can be valued for the service line or for
the entire claim but not both.

Allowed Amount Optional field. Maximum amount a provider is allowed to charge for services
under contract provisions. Allowed Amounts may be entered at the line level
and if entered, will result in their claim level total being incremented.

You can browse and search for claim adjustment reason codes and explanations by clicking the Browse
Reason button. This feature is particularly helpful for users who rely upon remittances that lack code
descriptions to determine which adjustment field (Disallowed Cost Containment, Disallowed Other,
Deductible, etc.) an amount should be attributed to.

The Disallowed Cost Containment, Disallowed Other, Deductible, Co-insurance, and Payment amounts
(displayed at the top of the screen) will increase appropriately as these Line Level amounts are entered
for each service line. All changes must be saved in between service lines and before leaving the screen.

Insurance Information — NSF 2.5

The Insurance Information screen varies based on whether the claim is primary or secondary. All fields
are editable except for the Payer Name which populates based on the selected Payer ID. Any data
present in the claim will pre-populate the screen.
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When a primary claim is selected, the Insurance Information tab allows you to add information
identifying the secondary payer. This is particularly necessary for the successful submission of Medicare

Crossover claims.

Batch Name
nsfd120806143318182 2

*Payer ID
-
Group Murnber

*Ingured Last Name

*Ingured 1D

Claim # Destination Payer
ALASKA MEDICARE

Batch List | Claum List | Clan Summary | | Insurance Information

Prior Payer Patient Name
WEBE, SUZIE

Payer Narme

*Patient Relationship to Insured

Gender Date of Birth Claim Date Claim Total
F 074151970  09/05/2003 $126.00

|

*Ingured First Mame

*Insured Gender

|

*Insured Date of Birth
Payer Claim Office Number

Selected Claim List: Claim 2

Output Format MSF2.5

Insurance Type Code

Group Mame

Insured Middle Initial

Secondary Claims

Emdeon Office Claims User Guide
Supplement Claims

For secondary claims, the Insurance Information tab displays insurance information for both payers.
You may view, edit, and add insurance information for both prior/primary payers and
secondary/destination payers.

-~
Batch List | Clamm List | Clam Summary | Claim Level Entries | | [ Insurance Informafion| | Provider Data =
Batch Name Claim # Destination Payer Prior Payer Patient Name  Gender Date of Birth Claim Date Claim Total
nsfd120806143318182 4 AETNA US HEALTHCARE Blue Crow  WWALKER, JAY M 09/10/1248 $95.00
Prior Payer Information
“Payer 1D Payer Mame
91114 Blue Crow
Group Mumber *Patient Relationship to Insured
‘ Father or Mother (18) V|
*Ingured Last Name *Ingured First Name Ingured Middle Initial
*Insured 1D *Insured Gender E:|
[InsiDooo01 Male  ~|
“Insured Date of Birth Insurance Type Code
11/04/1965 b
Payer Clairn Office Mumber Group Marne
Prior Authorization Mumber Insured Address 1
Insured Address 2 Insured City
Insured State Insured Zip
Destination Payer Information ]

The bottom portion of the screen, shown on the next illustration, allows you to enter necessary
information for the receiving payer in the event that more data is needed to successfully adjudicate the

claim.
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Destination Payer Information

“Payer ID Payer Mame

91114 AETNA US HEALTHCARE

Group Number *Patient Relationship to Insured

72522001000242 | v

*Insured Last Mame *Insured First Name Insured Middle Initial
WALKER

*Insured D #nsured Gender

[0g974470101 | [Male ]

*Insured Date of Birth Ingurance Type Code

09/10/1948 | Individual Policy (IF) b

Payer Claim Office Nurnber Group Mame

Prior Authorization Mumber Ingured Address 1

Insured Address 2 Insured City

Ingured State Ingured Zip
[ Feset Scieen ] [ Swap Payers ]
Selected Clairn List: Claim 4
Output Format MSF2.5

Payer Search

The Payer Find button opens a search screen. You may search by payer name or ID. Both search fields
accept partial data entries followed by a wild card character or asterisk (%, *). Neither field is case-
sensitive. You may enter upper- or lowercase.

For example:

e A search on "SM*” on the Payer ID will return all payers whose Payer IDs begin with SM.
e A search on “blue*” on the Payer Name will return all BlueCross BlueShield payers.

Swap Payers

The Swap Payers button allows you to swap the primary and secondary payers if you notice they are
reversed in the supplemental claim screens. This feature is also helpful if you wish to form a secondary
claim using data from the original, primary claim.

You can determine if the payers are reversed on the supplemental claims screens by examining the
Explanation of Benefits or ERA. The primary payer would be the one who created the ERA as they paid
first. If the payer who created the ERA appears in the destination payer field, then it needs to be
reversed since that payer has already made payments on the claim.

In this case, swapping the prior and destination payers ensures the claim is directed to the correct payer
and the payment information is associated with the correct payer.
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Provider Data — NSF 2.5

The Provider Data screen allows you to edit provider identifiers and other information at the claim level

and line level. Any data present in the claim will pre-populate the screen.

Emdeon Office Claims User Guide
Supplement Claims

Showing lines 1106 1 2
Rendering Prov ID

1 [rnbads

Renderng Prov UPIN

Supenising Prav UPIN

1

Rendering Prov ID
58558

Renderng Prov UFPIN

[N}
i
I
i

1

Supervising Prov UPIN

1

Rendering Prov ID
rnh345

Renderng Prov UPIN

w

BatchList | ClaimList | Claim Summary |

123456789

Rendering Prov Tax 1D

Referring Prov 1D

123456759

Ordering Prov MPI

1234567893

Rendering Prov Tax 1D
31129356

Referring Prov 1D

123486789

Ordering Prov NPI

Rendering Prov Tax 1D

23456789

Referring Prov D

| Line Level Enfries | Insurance Information | [yl CIRETES

=]
g%
]
<

Rendering Prov Network 1D
6776699

23456789

°=PE
§EE
R
el o
ERIRE
[= =
I ]
2 ]

Rendering Prov Network 1D
B778899

Refering Prov NP
23456789

Ordering Prov UPIN

H

Rendering Prov Network D
6778899

Refarring Prov NPI

i

1

Rendering Prov Specialty

Referring Prov UPIN
Purchasing Prov NP1
Rendering Prov Specialty
Referring Prov UPIM
Purchaging Proy NP1
Rendering Prov Specialty

Referring Prov UPIN

Batch Name Claim # Destination Payer Patient Name Date of Birth Claim Date Claim Total
mybatch_730 1 MEDICAL MUTUAL OF OHIO PATIENT JANE 07/15A1970 09/05/2003 $500.00
Claim Level Data
Billing Provider: *Tax ID “Tax D Type: Medicare # UPINAUSIN #
123455789 536364 [
Medicaid # Charnpus # BCBS # Comrerical #
3636364 3636364 3636364 3636364
MPI State License # Specialty
—
Rendering Provider: Render Prov # Tax 1D Network 1D NP1
44555 h23456789 mnt345 1
Specialty
Supervising Provider: Superviging Id NPI
Facility/Lah: Facility/Lab Id NPI
Referring Provider: Referring Prov # NPl Metwork 1D

Line Level Data

Rendering Prov NP1

Supervising Prov NP

Rendering Prov NPI
Supervising Prov MPI
Rendering Prov NP1

Supervising Prov NP

Up to six line items appear in the Line Level Data area of the Provider Data screen. Scroll down to view

all six line items.

The total number of pages of line items appears directly under the Line Level Data heading and also at
the bottom of the page. To view another page of line items, click the number of the page you wish to

view.

[

viewing another page.

Claim level data can be edited and saved from any Provider Data page.

Copy to Remaining Lines

Note: In order to preserve your changes on a page, you must click the Save button before

The Copy to Remaining Lines button allows you to copy the provider data in all fields of the line item
in which the button is located to all remaining line items, including those on subsequent pages. Fields in
preceding line items are not affected.
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Specialty Find
The Specialty Find button opens a search screen. You can search by specialty code or description. Both
search fields accept partial data entries followed by a wild card character or asterisk (%, *). Neither field
is case-sensitive. You can enter upper- or lowercase.

For example:
e A search on “3*” on the Specialty Code will return all specialty codes that begin with 3, such as “30
and “33.”

e A search on “*de*” on the Specialty Description will return all specialty codes with the letters “de” in
any portion of the description, such as “Dental Hygienist” and “Independently Billing Radiology

Group.”

Save and Reset Page
Each Save button on the page saves all data on the current page, including both claim level and line
level data.

The Reset Page button clears any changes you have made on the current page since your last save,
including both claim level and line level data.

NSF+ Claims

This section applies to NSF+ claims only. If you work with another type of claim, please skip to NSF 2.5
Claims on page 38 or 4010 Claims on page 51.

Batch List | Claitn List | | Cladm Summary
Batch Name glaim g:;gr:atlon E:;:[ Pt (eme Gender Date of Birth Claim Date _I(;La‘iarln
tes4 110707 111730597 CROSY DOODY, HOWDY 11/231938  09/05/2003 $95.00
I N = =30 P
Line From - Through Code Modifiers
0%9/04/20032 - 09/04/2003 99213 F30.00
2 0%/04/20032 - 09/04/2003 92020 F43.00 1

[ Designate az S econdary Claim ] [ Dezsignate as Primary Claim ]

Secondary Claim data and Primary Claim data cannot both be entered. Please designate whether this claim should be treated as Primary or
Secondary.

Selected Claim List: Claim 2

Output Format NSF+

On this screen you have the option of designating the claim as Secondary or Primary by clicking the
appropriate button.

e If you select Designate as Primary Claim the Insurance Information tab displays.
e If you select Designate as Secondary Claim, three more tabs display: Claim Level Entries, Line
Level Entries and Insurance Information, as shown on the next illustration.
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Claim Summary

This screen shows detailed information on selected claims.

Both Adjudication Date and Payer Amount Paid must be specified first to begin supplementing this claim. Then press Save to continue.

*Adjudication Date *Payer Amount Paid

[ Designhate as Primary Instead ] [ Back Out &l Changes ]

Selected Claim List: Claim 2

Output Format NSF+

Batch List | Claim List || Claim Summary | | | | Ambulance Data
Batch Name :‘Zlaim g::;it:atinn E:;;r HEHETRRN Gender gartl: of Claim Date (T:AI::iaT
tesd 110707 121024962 CROSY DOODY, HOWDY 11/231538 08/05/2003 $95.00
e e e
Line From - Through Code Maodifiers
09/04/2003 - 05/04/2003 99213 $50.00
2 0%/04/2003 - 05/04/2003 52020 F45.00 1

Emdeon Office Claims User Guide
Supplement Claims

primary payer.

Message Action

Both Adjudication Date and Payer | This message appears if the Adjudication Date and Payer Amount Paid
Amount Paid must be specified fields are empty.

first to begin supplementing this Enter the missing data from the EOB and click Save. The payer paid
claim. amount comes from the EOB (Explanation of Benefits) report sent by the

If you select Back Out All Changes, the claim will revert to its original state and the previous Claim

Summary screen will appear.

Batch List | Clain List || Claim Summary | Claim Level Entries | Lne Level Entries | Insurance Information | Ambulance Data

Batch Name Clalm # Destination Payer Prior Payer Patient Name Gender Date of Birth Claim Date Claim Total
tes4110707 111730597 MEDICAID WEBB, SUZIE 07A151970  09/M05/2003 $255.00
N S = e
Line From - Through Code Modifiers Units
09/04/2003 - 09/04/2003 22004 F110.00
2 09/04/2003 - 02/04/2003 52015 $15.00 1
3 09/04/2003 - 09/04/2003 92016 F25.00 1
4 02/04/2003 - 09/04/2003 92017 £35.00 1
5 0970442003 - 09/04/2003 22018 £45.00 1
& 09/04/2003 - 09/04/20032 9201% £55.00 1

*Adjudication Date = Payer Amount Paid
[ftmeo07] | [s12000

[ Designate as Primary Instead ] [ Back Out Al Changes

Selected Claim List: Claim 1

Output Format MSF+
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The Claim Level Entries screen is used to enter claim level adjustment reasons and amounts.
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The information needed to complete the Optional Payment Information and Claim Adjustments
fields is obtained from the Remittance Advice Notice sent by the primary payer.

Batch List | ClaimList | Claim Summary | REETgREER= TR | Line Level Entries | Insurance Information | Ambulance Data

Batch Name Claim # Destination Payer Patient Name
mybatch790 1 PALMETTO GOWERNMENT BENEFITS ADM PATIENT, JAKNE

Optional Payment Information

Patient Responsible Amount Discount Amount Per Day Limit Amount Approved Amount
Patient Paid Amount Tax Amount Pre-tax Claim Total Amount Obligated to Accept Amount

Medicare Outpatient Adjudication Medicare Outpatient Adjudication Medicare Outpatient Adjudication MOA Non-payable Professional
Reimbursement Rate HCPS Payable Amount ESRD Amount Component Billed Amount

Medi o ient Adiudication R

Rermark Code 1 Rernark Code 2 Rernark Code 3 Rernark Code 4 Rermark Code 5
| |[3earch | | |[3earch | | |[ Search | | |[ Search | | |[ Search |

Claim Adjustments

PR - Patient Responsibilityl

Selected Claim List: Claim 1

Output Foamat MSF+

Date of Birth
07451870

Claim Date
09/05/2003

Adjustments

The Claim Adjustments portion of the Claim Level Entries screen, shown on the next illustration,

allows you to enter up to 5 group codes per line (highlighted in blue) and up to 6 reason codes per

group code.

Claim Adjustments

Amount Reason Code Cluantity

[$1.00 [[1 | [CSeachReason ] |1

‘!52 oo ||2 | [__Search Reason | |2 ‘
$3.00 3 [(Seachfeason ] 3|
‘$4 oo ||4 | [ Search Reason | |4 ‘

Il | [SeachReasan | |

\ Il | [CSeachResson | | |

Selected Claim List: Claim 2
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If a Group Code is entered, at least one valid reason code and an amount greater than 0.00 must be
entered. Otherwise, you will not be able to save entries.

d Note: You have the option of entering adjustments at the claim level or at the line level. This is
why the Adjustments section is identical on both the Claim Level and Line Level Entries
screens.

The following table describes the Adjustments section of the screen:

Button/Field Description

Show Reasons These buttons expand the view to reveal 6 reason codes for each group code.

Hide Reasons These buttons collapse the view and delete the reasons for the selected group code.
Search Reasons Each of these buttons opens a search screen. You may enter an alpha-numeric code in the

Reason Code field or you may enter a wild card (* or %) to display all the possible reason
codes and their respective descriptions.

The Reason Description field does not accept partial text entries so you must enter the
full description in this field (for example: “Major Medical Adjustment”).

Amount The unpaid or denied dollar amount associated with a reason code.

Reason Code The code associated with the reason for an adjustment, such as a denial or reduction in
payment from the amount billed on a claim.

Quantity The adjusted units of service if applicable.

Line Level Entries — NSF+

This screen allows you to enter payments and adjustment amounts for each service line on a claim.
Obtain these amounts from the EOB (Explanation of Benefits) or remittance sent by the primary payer.

Batch List | ClaimList | Claim Summary | Claim Level Entries | EEREIESTER=0GET | Insurance Information | Ambulance Data

Batch Name Clalm # Destination Payer Patient Name Date of Birth Claim Date
mybat:hEM PALMETTO GOWVERNMENT BEMEFITS ADK PATIENT, JANE 07151970 03/05/2003
I - I S I ey
Line From - Through Code Modifiers Units
09/04/2003 - 05/04/2003 92004 $110.00
2 09/04/2003 - 09/04/2003 92015 $15.00 1.0
3 09/04/2003 - 05/04/2003 92016 $25.00 1.0
4 090472003 - 09/04/2003 207 $35.00 1.0
) 090472003 - 09/04/2003 9208 $45.00 1.0
B 090472003 - 09/04/2003 92019 $55.00 1.0

Line Level Entries

Apply Payments/Adiustments to Line Number:

*Sewice Line Paid Amount *Procedure Code  Procedure Modifiers  Procedure Description PD Service Unit Count  Obligated to Accept Amount Allowed Arnount
| | fooe || | | 1o

Line Adjustments

CO - Contractual Obligations{
CR - Correction and Reversals]

A - Other Adjustments

Page 47



-

(

/

emdeon

Emdeon Office Claims User Guide
Supplement Claims

The following table describes some of the fields on the Line Level Entries screen:

Field

Description

Procedure Code

A numeric code that describes the service.

Procedure Modifiers

Abbreviation on Remittance = MODS

Procedure Modifiers are two position alpha or numeric codes appended to
procedure codes that provide additional information about the billed
procedure. In some cases, addition of a modifier may directly affect payment.

Amount

The dollar amount charged for the service.

Units

The quantity of service delivered. (This number can be milligrams, cc's,
minutes etc.)

PD Service Unit Count

Paid Service Unit Count. This is the number of service units the primary payer
paid for. The default value for this field is Units.

Obligated to Accept Amount

The dollar amount the provider has agreed to accept as payment in full, under
contract provisions.

Obligated to Accept Amounts may be entered at both the line and claim level
but not both.

Allowed Amount

The maximum dollar amount a provider is allowed to charge for services under

contract provisions.

4 Note: The Adjustments portion of the Line Level Entries screen is identical to the one described
in Adjustments on page 46.

Insurance Information — NSF+

The Insurance Information screen varies based on whether the claim is primary or secondary. All fields
are editable except for the Payer Name, which populates based on the selected Payer ID.

Primary Claims

When a primary claim is selected, the Insurance Information tab allows you to add information

identifying the secondary payer. This is particularly necessary for the successful submission of Medicare

Crossover claims.

Batch Name
tesd110707121134191 1

“Insured Last Name

*Insured D

Batch List | Claitn List | Clatn Summary || Insurance Information | Ambulance Data

Claim # Destination Payer Prior Payer Patient Name

Gender Date of Birth Claim Date Claim Total

MEDICAID

Payer Name

WEBE, SUZIE F

0771541970 09/05/2003 $285.00

*Patient Relationship to Insured

v

“Insured First Name

*Insured Gender

el

"_!nsured Date of Birth

FPayer Claim Office Mumber

Selected Claimn List: Claim 1

Output Farmat M5F+

Insurance Type Code

Insured Middle Initial

Group Name
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Secondary Claims

For secondary claims, the Insurance Information tab displays insurance information for both payers.
You may view, edit and add insurance information for both prior/primary payers and
secondary/destination payers, as shown on the next illustration.

Batch List | ClairnList | Clain Sumnmary | Claim Lewvel Entries | Line Level Entries || Insurance Information | Ambulance Data
Batch Name Claim # g:.;t::atmn ::::;r faticntiame Gender Date of Birth Claim Date .(IZ‘LE:;T
tesd110707121134181 2 CROSK DOODY, HOWDY ] 11/23/1838  09/05/2003 $95.00
Prior Payer Information
“Payer ID Payer Name
Group Mumber *Patient Relationship to Insured
| | | "
*Insured Last Mame *Insured First Name Insured Middle Initial
*Insured 1D *lnsured Gender
| |
*Ingurad Date of Birth Insurance Type Code
s
Payer Claim Office Mumber Group Mame
Prior Authorization Nurnber Insured Address 1
Insured Address 2 Insured City
Insured State Insured Zip

The bottom portion of the screen, shown on the next illustration, allows you to enter necessary
information for the receiving payer in the event that more data is needed to successfully adjudicate the

claim.
Destination Payer Information
*Payer ID Payer Name
91114 CROSH
Group Mumber *Patient Relationship to Insured
|BLUE CROW | | Selt-Patientls Insured (01) |
*Insured Last Name *Insured First Mame Insured Middle Initial
|InsLast | InsFirst
*Insured 1D *Insured Gender
o0 |
*Insured Date of Birth Insurance Type Code
11231938 | v
Payer Claim Office Murmber Group Mame
Prior Authorization Mumber Insured Address 1
Insured Address 2 Insured City
Insured State Insured Zip
[ Beset Screen ] [ Swap Payers ]
Selected Claim List: Claim 2
Output Farmat M5F+
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Payer Search

The Payer Find button opens a search screen. You may search by payer name or ID. Both search fields
accept partial data entries followed by a wild card character or asterisk (%, *). Neither field is case-
sensitive. You may enter upper- or lowercase.

For example:

e A search on "SM*” on the Payer ID will return all payers whose Payer IDs begin with SM.
e A search on “blue*” on the Payer Name will return all Blue Cross and Blue Shield payers.

Swap Payers

The Swap Payers button allows you to swap the primary and secondary payers if you notice they are
reversed in the supplemental claim screens. This feature is also helpful if you wish to form a secondary
claim using data from the original, primary claim.

You can determine if the payers are reversed on the supplemental claims screens by examining the
Explanation of Benefits or ERA. The primary payer would be the one who created the ERA as they paid
first. If the payer who created the ERA appears in the destination payer field, then it needs to be
reversed since that payer has already made payments on the claim.

In this case, swapping the prior and destination payers ensures the claim is directed to the correct payer
and the payment information is associated with the correct payer.

Ambulance Data

If you are an HCFA/CMS 1500 upload customer who currently submits ambulance claims using your
1500 form, the Ambulance Data screen allows you to supplement primary and secondary claims with
ambulance information.

After selecting a claim and identifying the claim service lines that pertain to ambulance data, detailed
information may be added using the Ambulance Data entry screen.

Batch List | Claim List | Claitn Sutnmary | Claim Level Entries | Line Level Entries | Insurance Information | | Ambulance Diata

Batch Name Clalm # Destination Payer Prior Payer Patient Name Gender Date of Birth Claim Date Claim Total
tesd 110707121134191 CROSK WALKER, JAY 11/23/1938 09/05/2003  §95.00
Service Service Dates Procedure Procedure Ambulance
Line From - Through Code Modifiers Units Data Applied
09/04/2003 - 09/04/2003 99213 $30.00
2 09/04/2003 - 09/04/2003 92020 F45.00 1

Line Level Entries

Apply Adjustrents to Line Mumber.

Ambulance Data

Patignt " eight: Hospital Admil * Type of Transport:

EBied Confined Biefore: Bed Confined After: tfoved by Stretcher.

| Patient was bed confined V| | Patientwas bed confined V‘ | Patient was mowved by stretcher V‘
Unconscious/Shock. Emergency Situation: Physical Aestraints;

|Yes, the patient was unconscious or in shock V| Emergency situation V| | Physical restraints needed V|

“isible Hemorhaging: * Tranzported TO/FOR:

Mo wisible hemarrhaging noted ¥ Patient was transported to nearest facility for care of symptoms, complaints, ar both V|
tedically Mecessany: * Miles: Purpoze of Round Trip:

Medically necessary B | |
Purpose of Stretcher: Patient Dizcharged: Patignt &dmitted:
|F'URF'OSE OF STRETCHER - WHATEYER | ‘ves, patientwas discharged |+ “Yes, patientwas admitted v

Services Available:
|Yes, the services were avallable at the first facility V‘

Selected Claim List: Claim 1

Output Format NSF+

The data on this screen can be updated independently or in conjunction with primary payer data or
secondary claim data. Any available data from the input file pre-populates the Ambulance Data fields.
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4010 Claims

This section applies to 4010 claims only. If you work with another type of claim, refer to NSF 2.5
Claims on page 38 or NSF+ Claims on page 44.

The 4010 claims output format is similar to NSF+, but it has several enhancements. Refer to the NSF+
Claims section beginning on page 44 for explanations of Claim Summary, Claim Level Entries, and
Insurance Information. Below are details concerning the screens and features that have been enhanced

or added.

Provider Data

The functionality of the Provider Data screen is similar to that of NSF 2.5, but with 4010, there are
additional controls that prevent you from entering conflicting information or information for which
sufficient supporting data does not exist in the original claim.

Batch List | ClaimList | Claim Summary | | | | Provider Data | | Ambulance Data
Batch Name Claim # Destination Payer Patient Name Date of Birth Claim Date Claim Total
wrzi02262010093717. 1 a— Raalas g L $600.00
Claim Level Data
Billing Provider: “Tax ID “Tax D Type: Medicare # UPIN/USIN #

e

Medicaid # Champus # BCBS # Commerical #

GP-0001
NPI State License # Specialty

000 Speciaty Find

Rendering Provider:
e Billing is the same as Rendering Provider

Supervising Provider: Supervising Id NP
Facility/Lah: Facility/Lab Id NP
SF00001
Referring Provider: Referring Prov # ID Type: ) NPI Network ID:
e

Line Level Data

Showing lines 1 to 6:
:
2
3
4
:
‘

Showing lines 1 to 6:

Selected Claim List: Claim 1

Output Format 4010

You can edit all fields except for the Tax ID for the Billing Provider. When the billing provider is the
same as the rendering provider, the Billing Provider fields will appear, but the Rendering Provider fields
will not. Instead, the following phrase will appear in the Rendering Provider section: “Billing is the same
as Rendering Provider” (see above).

The Provider Data screen will only display fields for the providers or provider types that were present on
the claim that was entered originally. For example, if the original claim did not contain a service facility
provider/provider identifier, the fields corresponding to service facility provider will be absent from the
Provider Data screen.
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Patient Data is a new screen for 4010. Enter identifying information about the patient here.

Batch List | ClaimList | ClaimSummary | Claim Level Entries | Line Level Entries | Insurance Information | Provider Data | JEEIEIAREIZN | Ambulance Data

Batch Name Claim #
wrzi02192010141212. 1

“Patient Last Name
WILLIAMS

Patient ID
ID12345

*Patient Address 1
123 MAIN ST

Patient Address 2

Cigna

= Patient City
ANYTOWN

Selected Claim List: Claim 1

Output Fornat 4010

Destination Payer

Patient Name
WILLIAMS

*Patient First Name
STACY

Patient Gender
Femal

Date of Birth
1991
Patient Middle Initial

H

= Patient Date of Birth
01/01/1991

“Patient State
Tennessee (TN)

Claim Date Claim Total

d Note: The Patient Data screen is only active when the Patient Relationship to Insured field is
a value other than Self-Patient Is Insured (01) for the Destination Payer on the Insurance

Information screen.

“Payer ID

Group Number

“Insured Last Name
Williams

*Insured ID

*Insured Date of Birth
Payer Claim Office Number
Prior Authorization Number

Insured Address 2

Insured State

Tennessee (TN)

Selected Claim List: Claim 1

Dutput Format 4010

Payer Name

= Patient Relationship to Insured

Destination Payer Information

Employee (08)

—Select—

Self-Patientls Insured (01)

Spouse (02)

Natural child/insured has financial responsibility (03)
Natural childfinsured has no financial responsibility (04)
Stepson or Stepdaughter (05)

Foster Child (06)

Ward of Court (07)

Insured Middle Initial

Unknown (09) &1
Handicapped Dependent (10)

Organ Donor (11)

Cadaver Donor (12)

Grandson or Granddaughter {13}
Nephew or Niece (14)

Injured Plaintiff (15)

Sponsored Dependent (16)
Dependent of a Minar Dependent (17)
Father or Mother (18)
Grandfather or Grandmother (19)

Life Partner (20)

Emancipated Minar (21}

Significant Other (22)

Adopted Child (24)

Other Adult (25)

Other Relationship (39)

Page 52



Emdeon Office Claims User Guide

> o
( / emdeOﬂ Supplement Claims

Ambulance Data

The 4010 Ambulance Data screen functions similarly to that of NSF+: you can add ambulance data to
both primary and secondary claims, and available data pre-populates the appropriate fields (see
Ambulance Data on page 50). However, with 4010, you have the ability to add claim level ambulance
data as well as line level ambulance data. Entering ambulance information at the claim level negates the
need for you to include it for each service line when there are no differences to report at the line level.

BatchList | ClaimList | Claim Summary | | | | Provider Data | | Ambulance Data
Batch Name Claim # Destination Payer Patient Name Date of Birth Claim Date Claim Total
wrzi02262010093717. 1 - WILLIAMS 07/15/1990 $600.00

Ambulance Data Claim Level

Patient Weight: Hospital Admit: “Type of Transport:

Bed Confined Before: Bed Confined After: Moved by Stretcher:

|'—Selecl—— M ‘——Select—' Ill |~Se\ecl~ M

Ui ous/Shock: Emergency Situation: Physical Restraints:

|--Se|ect-- l:l ‘--Select-- M |--Se\ect-- ’1]

Visible Hemarrhaging: “Transported TO/FOR:

|--Se|ect-- u ‘--Select-- tl

Medically Necessary: *Miles: Purpose of Round Trip:

Purpose of Stretcher: Patient Discharged: Patient Admitted:

‘——Select—r M |~Se\ect~ M

Senvices Available:

| -Select- V

[ Save Claim Level Reset Claim Level Page

== == == = e =

Line From - Through Code Modifiers Amount Data Applied
01/01/2010 - 11/01/2010 9923 01020304 $100.00

2 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
3 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
4 01/01/2010 - 11/01/2010 9923 010203 04 $100.00 1.0
5 01/01/2010 - 11/01/2010 9923 01020304 $100.00 1.0
6 01/01/2010 - 11/01/2010 9923 01020304 $100.00 1.0

Line Level Entries If different from Claim Level

Apply Adjustments ta Line Mumber:

Ambulance Data

Patient Weight: Hospital Admit: *Type of Transport:

Bed Confined Before: Bed Confined After: Moved by Stretcher:
|--Se|ect-- M ‘--Select-- M |--Se\ect-- M
Unconscious/Shock: Emergency Situation: Physical Restraints:
|--Se|ect-- tl ‘--Select-- M |--Se\ect-- hl
Wisible Hemorrhaging: *Transported TO/FOR:
|'—Selecl—— M ‘——Select—' u
Medically Necessary: *Miles: Purpose of Round Trip:
Purpose of Stretcher: Patient Discharged: Patient Admitted:
‘--Select-- M |--Se\ect-- H

Services Available:

| ~Select- M
Save Line Reset Page

Selected Claim List: Claim 1

Output Format 4010
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Sample Error Messages

The following are sample error messages that may appear when sending a batch of claims that have

errors in any supplemental data entered.

Sample NSF2.5 Error Message:

Adjudication Date
Payer Amount Paid
Insured Last Name
Insured First Mame
Insured ID

Insured Gender
Insured Date of Birth
Disallowed Cost
Disallowed Other
Deductible
Comsurance

Payment

Batch nsf10412651230tst_7 has missing information.
Please correct supplemented information before attempting send again

Clai Patient Name Claim Date Claim Total
1 JANE DOE 09/05/2003 500.00

08/28/2006

200.00

Wissing Insured Last Name
Miszing Insured First Hame
Wiszing Insured 1D

Wissing Insured Gender
Missing Insured Date of Birth
0.00

0.00

0.00

0.00

0.00

Total payments 0.00) does not match payer amaunt paid (200.00)

Senice line 0: The charge amount (110.00) does not match the sum of supplied supplem ental amounts @.00).
Senvice line 1: The charge amaunt (15.00) does not match the sum of supplied suppleme ntal amaunts (0,00
Service line 2: The chargs amount(110.00) does not mateh the um of supplisd supplem ental amounts (.00,
Senice line 3 The chame amount (15.00) does not mateh the sum of supplied supplemental amounts (.00}
Senvice line 4 The charge amaunt (11000 does not match the sum of supplied supplemental amounts (0.00).

Sewice line 5: The charge amount(15.00) does not match the sum of supplied supplemental amounts (0.00).

Sample NSF+ Error Message:

Adjudication Date
Payer Amount Paid
Insured Last Mame
Insured First MName
Insured ID

Insured Gender
Insured Date of Birth
Disallowed Cost
Disallowed Other
Deductible
Coinsurance

Payment

Batch nsf10412651230tst_7 has tissing information,
Flease correct supplemented mformation before attemphing send agam,

Claim # Patient Name Claim Date Clai
1 JANE DOE 09/05/2003 500.00

Total

0B8/28/2006

200.00

Missing Insured Last Name
Missing Insured First Name
Missing Insured 10

Miseing Insured Gender
Miseing Insured Date of Birth
0.00

0.00

0.00

0.00

0.00

Emdeon Office Claims User Guide
Supplement Claims
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Sample 4010 Error Message:

Batch wrzil 2262010141577, haz mizzing infarmation,
Fleaze carect supplemented infarmation befare attempting send again
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Prior Payer ID

Prior Insured 1D
Prior Insured Gender

Cams B
$100.00
Adjudication Date 04/07/2010
Payer Amount Paid $50.00
Total Adjustments $0.00

Payer amount paid plus adustments not equal o claim total

Prior Patient Relationship to Insured Missing Patient Relatiorship To lrsured

Prior Insured Date of Birth

Mizsing Payer [0

Mizsing Insured 1D
Mizzing Insured Gender

Mizzing Insured D ate of Birth

Abbreviations Used in Remittance Advice Notices

To save space, a number of abbreviations are used in a remittance advice. The following table is

included as a reference.

Abbreviation Description

PT RESP Patient Responsibility. Includes total coinsurance, deductible, non-covered services, and
psychiatric limitation.

PERF PROV Performing Provider Number

SERV DATE Date of Service

POS Place of Service

NOS Number of Services

PROC Procedure Code

MODS Modifiers. Modifiers are two-digit codes appended to procedure codes and/or HCPCS codes,
to provide additional information about the billed procedure. In some cases, addition of a
modifier may directly affect payment.

BILLED Billed Amount

ALLOWED Allowed Amount (prior to deductions or offsets)

DEDUCT Deductible Due (amounts applied to patient’s deductible will appear here)

COINS Coinsurance Due (patient’s 20%)

PROV PD Amount Paid to Provider (prior to adjustments)

RC AMOUNT Reason Code other than deductible and coinsurance. If more than one, additional
adjustment codes will appear on the next line.

HIC Medicare Health Insurance Claim number (patient’s “Medicare Number”)

ACNT Patient account number assigned by the provider

ICN Internal Control Number (also known as DCN)

ASG Whether assignment accepted (Y = yes or N = no)

MOA Medicare Outpatient Adjudication Remark Code. For a complete list of MOA codes click
Search, and on the search screen enter a wild card in the Remark Code field (* or %) and
click Search.

REM Remark Codes

NET The amount paid for the claim after adjustments

ADJS Adjustments

Page 55



-

(

/

emdeon

The following abbreviations appear as adjustments:
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Abbreviation Description

PREV PD Amounts previously paid on this claim will appear here

PD TO BENE Amounts collected over the co-pay will appear here (This amount will be paid to the patient
for this claim)

INT Interest

MSP Medicare Secondary Payer (Amount paid by insurer primary to Medicare)

OTHER Other claim level adjustments that apply

FCN Financial control number of prior claim(s) that contributed to the overpayment or that
explains the reason for the offset

BF Balance Forward (This applies to suppressed checks for less than $1.00.)

Troubleshooting Guide

The following table lists common issues and error messages you may encounter when working with

Supplement Claims.

Problem/Scenario

Possible Causes

Action Required by User

that claims needed to be held for the
entry of prior payment information.

A batch has been indicated as N/A The user should proceed to the

needing to be held for entry of prior Supplement Claims function and select

payment data accidentally (i.e. the Send from the batch list.

user wants to send the batch without Note: If the user entered the claim

entering any supplemental data). using the Claim Entry feature in
Emdeon Office, they will need to
remove the “Sup*” indicator in the
remarks field before attempting to
send.

The user has forgotten to indicate N/A The user needs to re-upload the batch

indicating that the batch contains
claims requiring supplemental
information.

Note: Any unaffected claims may
result in rejections at the Emdeon
Clearinghouse for duplicate claim.

The user would like to use the
Supplement Claims feature but
receives email notification upon
upload that a supplemental batch was
received and if their submission was
unintentional they should resubmit or
if their submission was intentional
they should contact Customer
Support.

The user has not been set up within
Emdeon to take advantage of the
Secondary Claims feature.

The user is not eligible to be set up as
a Secondary Claims user (due to the
input format of their data).

The user should contact customer
service to determine if they have an
eligible set up to take advantage of
the Secondary Claims feature. If they
have an eligible set up to take
advantage of the Secondary Claims
feature, Customer Support can
perform the necessary activation of
the feature.

Customer receives email notification
that a batch is over 4 days old.

Customer has uploaded the batch
indicating it as needing to be
supplemented but has yet to complete
the necessary steps to complete
submission.

Customer needs to proceed to the
Supplement Claims function at which
point they may supplement, send, or
delete the batch.

Customer has selected a batch under
the Supplement Claims feature but is
unable to select and supplement a
particular claim.

The secondary payer may not be able
to receive secondary claims
electronically.

There are multiple errors associated
with the original claim data.

If the description under the Payer
Name reads Non EDI Payer, the payer
is unable to receive secondary claims
and the user will be unable to
supplement. If the description reads
otherwise, the user should contact
Customer Support for assistance with
the claim errors.

The user has selected a claim to
supplement and the destination and
prior payer are presented in reverse
order.

There is a variance in their software
and the order in which it provides
payer information.

The user should use the “Swap
Payers” function to properly set the
destination and prior payers.
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Problem/Scenario Possible Causes Action Required by User
A batch of claims no longer appears The user has either sent or deleted If the batch was deleted and needs to
under the Batch List in the the batch. be sent, the user will need to re-enter
Supplement Claims function. the batch. If the batch was sent, the

user should confirm with other users
at their site that the desired entries
were made prior to sending the batch.

After sending the batch under the N/A The user needs to correct the errors,
Supplement Claim function the user re-load the batch, and re-enter any
receives subsequent reject applicable supplemental information.
notifications.

The user receives a message that a Only one user can access a given The user needs to wait for the other
batch is in use by another user. batch at a time under the Supplement | user at their site to release the batch.

Claims feature.
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Overview

This section contains information on the text-readable reports generated from Emdeon’s processing
system and returned to the submitter’s Emdeon email. Understanding these reports will provide a
submitter the necessary knowledge to effectively manage their electronic claims. While each report
displays unique and specific claims information, the following information and features are common to
all reports referenced in this section:

e All reports must be requested through an Emdeon representative.

e All reports are 80 characters wide and 60 lines long.

e All reports are formatted as ASCII-text and should be printed using a text-capable program.
Wrapping of text may occur; therefore, it is important to establish the correct text size through your
computer.

Emdeon’s Provider Reports

The following table is a brief overview of the reports available from Emdeon for providers. An example of
each report is included along with field description information. We recommend that you use the
Reporting & Analytics (page 87) solution for claim status information in place of these reports. Turn
on or turn off the delivery of some or all of these reports by clicking Setup > My Account; detailed
information about changing your report delivery options can be found in the General User Guide.

Report # Emdeon Timing* Purpose of the Report
Report Title
RPT-00 Customer Daily - Alerts Provides a complete listing of all batch system Customer Service Alerts,
Service Alert for the business | CSAs, for the business day. The report does not contain real-time
day Customer Service Alerts. Depending upon the vendor's preferences, the

RPT-00 can be for vendors only or for vendors and providers. There is
no preference to add or remove RPT-00, only a vendor option to
indicate if the provider is to receive the CSA in addition to the Vendor.

RPT-02 File Status Within 4 hours Provides an initial analysis of the file, by displaying file status of
Report of time file accepted or rejected and a description of the status. It also indicates
submitted to the total number of claims and $ value if the file contains valid claims.
Emdeon The RPT-02 report is generated within a few hours after the file has

been received from the clearinghouse. In order for the RPT-02 to be
generated, a submitter’s transmitted file must be received and opened
by the clearinghouse with the file’s Summary record residing in the
Repository database. There is no sorting of information within the

report.
RPT-03 File Summary Within 48 hours Provides summarized information on the quantity of accepted and
Report of time file rejected claims, as well as the total number of claims received by
submitted to Emdeon for each submitted file. In order for the RPT-03 to generate, all
Emdeon claims contained within the submitter’s file need to be processed and

contain status record information. There is no sorting of information
within the report.

RPT-04 File Detail Within 48 hours | Contains a detail summary of the file submitted for processing. It
Summary Report | of time file provides a file roll-up listing all accepted and rejected claims contained
submitted to in each file submitted to Emdeon. It also contains payer name/id and
Emdeon status of claim. In order for the RPT-04 to generate, all claims

contained within the submitter’s file need to be processed and contain
status record information. Information is sorted by Customer and then
by Patient (Last Name, First Initial, Middle Initial).

RPT-04A Amended File Daily - includes Contains a detailed listing of all claims for which the status was
Detail Summary claims with an amended during the previous processing day. Claim statuses are
Report amended status | amended when a pending claim is processed and/or when a claim is
within the last reprocessed at Emdeon. It also contains payer name/id and amended
24 hours status of the claim. Information is sorted by Customer and then by

Patient (Last Name, First Initial, Middle Initial).
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Report # Emdeon Timing* Purpose of the Report
Report Title
RPT-05 Batch and Claim Within 48 hours | Contains rejected batches and claims listed with detailed error
Level Rejection of time file explanations. In order to prevent “lost” claims, the RPT-05 report must
Report submitted to be reviewed and worked after each file transmission. Claims that are
Emdeon listed as rejected are not forwarded to the payer(s) for processing.
These rejected claims must be corrected and re-submitted (either
electronically or on paper) for processing. In order for the RPT-05 to
generate, all claims contained within the submitter’s file need to be
processed and contain status record information. Information is sorted
by Customer and then by Patient (Last Name, First Initial, Middle
Initial).
RPT-05A Amended Batch Daily - includes Contains rejected batches and claims listed with detailed error
and Claim Level claims with an explanations. In order to prevent “lost” claims, the RPT-05A report
Rejection Report | amended status | must be reviewed and worked after each file transmission. Claims that
within the last are listed as rejected are not forwarded to the payer(s) for processing.
24 hours These rejected claims must be corrected and re-submitted (either
electronically or on paper) for processing. In order for the RPT-05 to
generate, all claims contained within the submitter’s file need to be
processed and contain status record information. Information is sorted
by Customer and then by Patient (Last Name, First Initial, Middle
Initial).
RPT-08 Provider Monthly | Monthly - by Displays the number and $ value of claims accepted and forwarded by
Summary the 5™ calendar Emdeon for the month. Monthly and Y-T-D Totals for both accepted and
day rejected claims are included as well as the provider’s top 25 errors for
the month. Information is sorted by Customer ID, Payer, and Error
Frequency. Y-T-D totals include data for claims processed by Emdeon
beginning September 1%, 2001.
RPT-10 Provider Claim Daily - includes | Contains information provided by payers who receive claims from
Status Report payer status Emdeon for adjudication. Not all payers who receive claims from
updates Emdeon provide information for this Claim Status Report, and the
received in the amount/frequency of information produced will vary from payer to
last 24 hours payer. The RPT-10 does not return Unprocessed, Request for Additional
Information, or Rejected statuses. This report is generated daily for
each submitter for payer status updates received within the previous 24
hours. Information is sorted by Customer ID, Status, and then by
Payer.
RPT-11 Special Daily - includes | Contains information provided by payers who receive claims from
Handling/ payer status Emdeon for adjudication. Not all payers who receive claims from
Unprocessed updates Emdeon provide information for this report, and the amount/frequency
Claims Report received in the of information produced will vary from payer to payer. The RPT-11
last 24 hours returns Unprocessed, Request for Additional Information, and Rejected
Statuses only. This report is generated daily for each submitter for
payer status updates received within the previous 24 hours.
Information is sorted by Customer ID, Status, and then by Payer.

*Daily reports are generated on a daily basis assuming that the submitter is part of a Submitter Report Group that receives
the report and if the submitter has had claims volume with the report’s specific parameters at Emdeon in a given day. Next
Business Day reports are generated on a next business day basis assuming that the submitter is part of a Submitter
Report Group that receives the report and if the submitter has had claims volume with the report’s specific parameters at
Emdeon in a given timeframe. Monthly reports are generated on a monthly basis assuming that the submitter is part of a
Submitter Report Group that receives the report and if the submitter has had claims volume with the report’s specific
parameters at Emdeon in a given month.

Report Sequence, Frequency, and Usage Information

The following sequence, frequency, and usage information is provided for each report referenced in this

guide.

RPT-00 Customer Service Alert

Sequence By customer ID

Frequency Daily - includes all Customer Service Alerts within past 24 hours
Usage To provide a listing of all batch system related Customer Service Alerts
RPT-02 File Status Report

Sequence By file submitted
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RPT-02 File Status Report

Frequency Daily if claim data is submitted by 8:00 p.m. Eastern time

Usage To monitor whether the file transmitted to Emdeon was accepted for processing or was rejected by
the clearinghouse

RPT-03 File Summary Report

Sequence By file submitted

Frequency Next business day if claim data is submitted by 8:00 p.m. Eastern time

Usage To monitor daily number of accepted and rejected claims and charges per file submitted

RPT-04 File Detail Summary Report

Sequence By file submitted, by customer and by patient

Frequency Next business day if claim data is submitted by 8:00 p.m. Eastern time

Usage To monitor daily claims submitted to Emdeon for future reference

RPT-05 Batch and Claim Level Rejection Report

Sequence By file submitted, by customer, and by patient

Frequency Next business day if claim data is submitted by 8:00 p.m. Eastern time

Usage To monitor daily batch and claim level rejections. Contains detailed error explanations necessary to
correct any rejected claims. This report is very important and should be worked/reviewed daily.

RPT-08 Provider Monthly Summary

Sequence By customer, by payer, and by error

Frequency Monthly, by the 5% business day if claim data is submitted by 8:00 p.m. Eastern time

Usage Monitors overall monthly customer statistics, claims forwarded to the listed insurance payers and the
most frequent claim level rejections. Management could use this report.

RPT-10 Provider Claim Status Report

Sequence By customer, by status, and by payer

Frequency Daily for each submitter for payer status updates received within the previous 24 hours if claim data is
submitted by 8:00 p.m. Eastern time

Usage To monitor status of claims submitted electronically to payers. Note: Not all payers provide a claim
status electronically, and the amount/frequency of returned information varies. The RPT-10 does not
return Unprocessed, Request for Additional Information, or Rejected statuses.

RPT-11 Special Handling/Unprocessed Claims Report

Sequence By customer ID, by status, and by payer

Frequency Daily for each submitter for payer status updates received within the previous 24 hours if claim data is
submitted by 8:00 p.m. Eastern time

Usage To monitor and inform of the status of unprocessed, request for additional information, and rejected
statuses only on claims submitted electronically to payers. Note: Not all payers provide a claim status
electronically, and the amount/frequency of returned information varies.

Report
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RPT-00 (Customer

The RPT-00 report is intended for Vendors only or for Vendors and Providers depending upon the
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Service Alerts)

Report

Vendors preference. The RPT-00 is a listing of all pertinent Customer Service Alerts for the processing

day.

RPT-00 Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-00

report.

Header Section displays
the type of claims
distribution system
(Medical, Hospital,
Dental) and the report’s
title and date.

Information Section
displays submitter and
provider information.

Subject Section displays
subject of the CSA

Payer and Topic
Section displays
content of the
announcement

Resolution Status
Section displays the
current status of the
CSA.

Action Required by
Customer and
Emdeon Section
displays the specific
actions required by the
Customer and Emdeon.

P

CSA ID and
Production Issue
Number Section
displays the internal

Emdeon tracking

numbers

End / Next CSA
separator

Page Footer Section
displays report # and
page number(s) of the

report. \

— Subject:

\\\\*‘Resolution Status:

Emdeon Business Services Division
XXXXXXX Claims Distribution System

—

CUSTOMER SERVICE ALERT
Report #: RPT-00 Report Date: MM/DD/YY

Submitter ID: 123456789
Submitter Name: Vendor Systems

—t

Customer ID/Sub: 987654321 abcd NPI:
Customer Name: Prov/Group Name

1234567890

R R R

CLAIM DELIVERY - Update

—

Date: 05/05/2009
LOB: Professional
Payer(s): 12034 - PAYER NUMBER 0 NAME
Topic: Please be advised of this UPDATE to a CSA originally released on

5/01/2009. Emdeon determined that due to an internal Emdeon issue some claims
for the above Payer(s) sent from your location and processed at Emdeon on
4/28/2009 through present may have rejected at Emdeon for invalid reasons with
the following error: Enrollment: Required; Provider enrollment is required to
submit EDI claims to this Payer.

Efforts to resolve this issue continue. It is currently
open and unresolved.

Action Required by Customer: ©No action is required. Please do not resubmit
claims. Enrollment is no longer required for this Payer.

Ly

Action Taken by Emdeon: Emdeon is actively addressing this issue and expects
to resubmit all impacted claims to the above Payer(s). Updates concerning
client impact will be provided at least every 2 days.

Emdeon is proud to be your EDI partner and remains committed to your success.
Thank You for your attention and cooperation,
Emdeon

P CSA ID: 1-567DEF

Production Issue(s): 1-123ABC

R KK KKKk Kk Kk KA KKk Kk Xk KK KA KA A KK XK KK KKK KKK XK KKK Ak Ak Xk KAk hh kX hk Xk Kk khhhk kX kxkkk K%

Subject: CLAIM DELIVERY - Update
Date: 05/05/2009
LOB: Institutional/Professional
Payer(s): 12430 - PAYER NUMBER 1 NAME
12345 - PAYER NUMBER 2 NAME
98765 - PAYER NUMBER 3 NAME
45678 - PAYER NUMBER 4 NAME
99999 - PAYER NUMBER 5 NAME
88888 - PAYER NUMBER 6 NAME
77777 - PAYER NUMBER 7 NAME

KKK KKK KKK KK R R R R R R AR A R A A A A A A A A A A A A A A A A A A A A A A KRR A AR A KA A KA KA KA KA A KRR KA KA KA KA KA KR AKX KA AKX KKK KKK
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Report

Closing Comments —
Section

v

Emdeon Business Services Division
XXXXXXX Claims Distribution System

CUSTOMER SERVICE ALERT
Report #: RPT-00 Report Date: MM/DD/YY

Submitter ID: 123456789
Submitter Name: Vendor Systems

Customer ID/Sub: 987654321 abcd NPI: 1234567890
Customer Name: Prov/Group Name

KKK KKK KK R KRR R AR AR AR A A R A A A A A A A A A A A A A A AR A A AR A AR KRR KA A AR KR KA KA KA KA KA KA KA KA KA KA KA KRR AKX KA KA KA KA KRR KKK KK
66666 - PAYER NUMBER 8 NAME
55555 - PAYER NUMBER 9 NAME
Additional Payers not listed.

Topic: Please be advised of this UPDATE to a CSA originally released on
4/27/2009 (Dates Revised). Emdeon determined that some claims sent from your
location and processed at Emdeon on 4/17/2009 through present are not being
processed by the above Payer(s). This may cause you to experience delays with
claims and reports.

Resolution Status: Efforts to resolve this issue continue. It is currently
open and unresolved.

Action Required by Customer: No action is required.

Action Taken by Emdeon: Emdeon is continuing efforts to resolve this issue
and updates concerning client impact will be provided at least every 2 days.

Emdeon is proud to be your EDI partner and remains committed to your success.
Thank You for your attention and cooperation,
Emdeon

CSA ID: 1-568DEF
Production Issue(s): 1-568BRQ, 1-555XXX, 1-666XXX, 1-777XXX

KA KA AR AR A A AR A A A A A A A A A A Ak Ak Ak Ak Ak khkhkhkhkhkhkkkkkkkkkkkkkkhkkkkhkkkkkkkkkkkkkkkkkkkkxx%x

RPT-00 Page 2
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RPT-00 Detailed Information

Report

Sorting Sequence

By customer ID

Frequency of Report

Daily - includes all batch system Customer Service Alerts within the past 24 hours

Purpose of Report

To inform the customer of all pertinent Customer Service Alerts

Report Field Name

Description

Report Date

The date the report was generated by Emdeon.

Report #

The Emdeon report number

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity

submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

Customer ID

The identifier used by Emdeon to identify the customer

Customer Name

The name of the customer

SUBJECT:
Subject

Date

Line of Business

The subject of the Customer Service Alert
The date the announcement is for
The line of business affected

PAYER and TOPIC:
Payers
Topic

The payers affected by the announcement
A brief text describing the announcement

RESOLUTION STATUS

The current status of the issue

ACTION REQUIRED by
CUSTOMER and EMDEON:
Required by customer
Required by Emdeon

The specific actions requested of the customer
The steps Emdeon will be taking to resolve the issue

CSA ID and PRODUCTION
ISSUE NUMBER:

CSA ID

Production Issue Number

The ID number associated with this Customer Service Alert
The associated Emdeon production issue ticket for this Customer Service Alert
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RPT-02 (Customer Service Alerts)

The RPT-02 report gives an initial analysis of the file received. It shows a file status of accepted or
rejected and a description of the status. It also indicates the total number of claims and $ value if the
file contains valid claims.

RPT-02 Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-02
report.

Header Section
displays the type of Emdeon Business Services Division
claims distribution ———p XXXXXXXX Claims Distribution System
system (Medical,
Hospital, Dental) and
the report’s title.

File Status Report
Date/Time: MM/DD/YY-HH:MM:SS

Emdeon Ref: EP1234567890123 Report Date: MM/DD/YY
. Report #: RPT-02
Information Acct ID: 123 File Control #: P23456
Section displays data
on your transmitted _—T submitter Filename: 040500clms Emdeon Ref: 5634
file. This information
can be used for Submitter ID: 123456789
locating your file in Submitter Name: Vendor Systems
Emdeon’s processing
system. File Status: ACCEPTED
File Status
Section displays
_> * ok ok ok ok ok kK STATUS * ok ok ok ok ok kK

message on the
status of your

. . Your file has been accepted and is bein rocessed by Emdeon Business
transmitted file. o s i

Services Division.

File Totals Section
displays quantity and File Totals: CLAIMS RCVD $ VALUE
dollar value of claims __—» 60 8213.25
in your submitted file.

khkkkkkkkkkkkkkkkhkkkkkhkhkhkkkhkhkkhkhkhkkhkhkhkhkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhhkhkhkhkhkhkhkhkhkhkhkhkkhkrrk

Disclaimer
Section displays DSCLATMER
text message

explaining the \$
intent of the report.
This displays only
once on the report.

THIS IS A FILE LEVEL ACKNOWLEDGEMENT BY EMDEON ONLY AND IT DOES NOT
GUARANTEE ACCEPTANCE OF YOUR CLAIMS. ADDITIONAL REPORTS WILL FOLLOW.

khkkkkkkkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkkkkkkxk

Page Footer Section
displays report # and
page number(s) of the
report.

RPT-02 Page 1
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RPT-02 Report Detailed Information

Report

Sorting Sequence

By file submitted

Frequency of Report

Daily if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor whether the file transmitted was accepted for processing or rejected

Report Field Name

Description

Date/Time The date/time the claims file was processed by Emdeon. Format is MM/DD/YY-HH:MM:SS
Report # The Emdeon report number

Acct ID The submitter’s login/account ID assigned by Emdeon

File Control # Control number assigned to the file by the originator of the submitted transaction

Submitter Filename

The file name assigned by the submitter

Emdeon Ref

The tracking number assigned by the Emdeon clearinghouse to identify the file. This value
can be used for referencing purposes.

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

File Status Indicates if the claims batch was ACCEPTED or REJECTED

STATUS A description of the submitter’s batch file status being processed by the Emdeon system.
For example, a status could be a duplicate file, unknown submitter, incomplete file,
accepted file but stopped during processing, etc.

File Totals:

CLAIMS RCVD The number of claims received in the file.

$ VALUE The dollar value of the claims contained in the received file.

DISCLAIMER Text message explaining that the report is a file level acknowledgement and that it does

not guarantee acceptance of the submitter’s claims.
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RPT-03 (File Summary Report)

The RPT-03 report gives a summary of the file submitted for processing. This report informs the
submitter of how many claims were accepted and/or rejected, as well as the total number of claims
received by Emdeon for each file submitted.

RPT-03 Report Sample

Emdeon Office Claims User Guide
Report

The following sample is provided to illustrate the various sections and fields contained in the RPT-03

report.

Header Section
displays the type of
claims distribution
system (Medical,
Hospital, Dental) and
the report’s title and
run date.

Information

Section displays data — |
on your transmitted
file. This information
can be used for
locating your file in
Emdeon’s processing
system.

File Totals Section — |
displays quantity and
dollar value of claims
in your submitted file.
The total number of
accepted and rejected
claims is displayed.

Page Footer Section
displays report # and
page number(s) of

the report. \‘

/»

EMDEON REF: EP12
Report #: RPT-03
Acct ID: 123

—p
File Control #:

Submitter ID:
Submitter Name:

**x** TRANS TYPE
Electronic

Paper
Totals

A RPT-03

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

File Summary Report

FILE SUBMISSION DATE/TIME:

34567890123 Run Date:
P23456 Emdeon Ref:
123456789
Vendor Systems
——————————————— FILE TOTALS —————————————-
**x%  CLAIMS INPUT **x**
NUMBER $ VALUE
23120 125000.35

A **%% CLAIMS ACCEPTED ****

NUMBER $ VALUE NUMBER $ VALUE
19250 95000.35 100 12000.00
3700 13950.50 70 4050.00
22950 108950.35 170 16050.00
Page 1

*%*% CLAIMS REJECTED ****

MM/DD/YY-HH:MM: SS
MM/DD/YY

5634
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RPT-03 Detailed Information

Report

Sorting Sequence

By file submitted

Frequency of Report

Next business day if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor daily number of accepted and rejected claims and charges per file submitted.

Report Field Name

Description

Run Date The date the report was generated by Emdeon

Report # The Emdeon report number

Acct ID The submitter’s login/account ID assigned by Emdeon

File Control # Control number assigned to the file by the originator of the submitted transaction

Emdeon Ref The tracking number assigned by the Emdeon clearinghouse to identify the file. This value

can be used for referencing purposes.

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

FILE TOTALS:
CLAIMS INPUT

NUMBER The total number of claims contained in the submitted claims file

$ VALUE The total monetary value of the claims contained in the submitted claims file
TRANS TYPE:

Electronic Indicates that the claim was transmitted electronically

Paper Indicates that the claim was transmitted on paper

Totals Indicates the total number of claims submitted

CLAIMS ACCEPTED

The number (NUMBER) and $ value ($ VALUE) of the claims accepted in the file submitted

CLAIMS REJECTED

The number (NUMBER) and $ value ($ VALUE) of the claims rejected in the file submitted
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Summary Report)

Report

The RPT-04 report gives a detail summary of the file submitted for processing. This report is a file roll-
up listing all accepted and rejected claims contained in each file submitted to Emdeon. The RPT-04 also
contains payer name/ID and status of claim.

RPT-04 Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-04

report.

Header Section displays
the type of claims

distribution system
(Medical, Hospital,
Dental) and the report’s
title and run date.

—

Information Section
displays data on your
transmitted file. This
information can be
used for locating your
file in Emdeon’s
processing system.

Disclaimer Section ——
displays text message
explaining the intent
of the report. This
displays only once on
the report.

File Roll-Up
Section displays

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

File Detail Summary Report
FILE SUBMISSION DATE/TIME:
Run Date:

MM/DD/YY-HH:MM: SS
Emdeon Ref: 5634 MM/DD/YY
Report #: RPT-04

Acct ID: 123

—v

File Control #: P23456

Submitter ID: 123456789

Submitter Name: Vendor Systems

KKK KKK KK KK R AR R A A AR A A A A A A A A A A A A A A A A A A A A A A A KRR AR AR KA A KRR A KA A KA A KA KA KA A KA KA KA KA KR AKX KA KA KRR KA KRR KKK K

—p DISCLAIMER

ACCEPTED CLAIMS HAVE BEEN FORWARDED TO THE PAYER BY EMDEON BUSINESS SERVICES
DIVISION. ADDITIONAL CLAIM STATUS REPORTS MAY FOLLOW IF AVAILABLE FROM THE
PAYER. THIS IS NOT A GUARANTEE OF PAYMENT.

KKK KKK KKK R A R A A AR R A A A A A A A A A A A A A A A A A A A A A A A A KA A AR A KA AR A A A AR KA A A KA A KA KA KA KA KA KA A KA KA KA AKX KA KA KKK KK

header and detail ____————»

areas of a claim
record. Patient and
Payer information is
displayed.

Page Footer Section
displays report # and

page number(s) of the \
report.

Customer ID/Sub: 987654321 abcd NPI: 1234567890
Customer Name: Prov/Group Name
FILE ROLL-UP
Patient Name Patient Date of Total Payer Name/ID Status
Control # Service Charges
Childs M J 39145278912547856364 012700 176.95 Payer One 12345 AE
Gagnon J 39143268973247658365 012800 1176.00 Payer Two 60054 RE
Osborn J 39145278955467289367 012500 276.00 Payer Three SMTX0 TE
Osborn J 39145278963098426368 012700 176.00 Payer One 12345 AP
Customer ID/Sub: 987654321 efgh NPI: 1234567890
Customer Name: Prov/Group Name
FILE ROLL-UP
Patient Name Patient Date of Total Payer Name/ID Status
Control # Service Charges
Bolders M J 39145278961234531363 012700 176.00 Payer One 12345 AE
Garrett J 39143268971234504366 012800 1176.00 Payer Two 60054 RE
Osborn J 39145278951234507369 012500 276.00 Payer Three SMTX0 TE
Sims J 39145278961234508362 012700 176.95 Payer One 12345 AP
RPT-04 Page 1
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Report

Header Section
displays the type of
claims distribution
system (Medical,
Hospital, Dental) and
the report’s title and
run date.

>

Status Key Legend
Section displays

status acronyms and -
values.

Page Footer Section
displays report # and —% RPT-04
page number(s) of the
report.

AE
AP
RE
RP
TE

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

File Detail Summary Report

Run Date:

*%*%  Status Key Legend ***

Accepted Claim sent out electronically
Accepted Claim sent out on paper
Electronic Claim rejected by Emdeon
Paper Claim rejected by Emdeon
Electronic Test claim

MM/DD/YY

Page 2
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RPT-04 Detailed Information

Report

Sorting Sequence

By file submitted, by customer, and by patient

Frequency of Report

Next business day if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor daily claims submitted to Emdeon for future reference

Report Field Name

Description

Run Date The date the report was generated by Emdeon

Report # The Emdeon report number

Acct ID The submitter’s login/account ID assigned by Emdeon

File Control # Control number assigned to the file by the originator of the submitted transaction

Emdeon Ref The tracking number assigned by the Emdeon clearinghouse to identify the file. This value

can be used for referencing purposes.

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

DISCLAIMER

Text message explaining that the report is for status information only

Customer ID/Sub

The ID and Sub ID used by Emdeon to identify the customer

Customer Name

The name of the customer

FILE ROLL-UP:
Patient Name

Patient Control #
Date of Service
Total Charges
Payer Name/ID
Status

The name of the patient on the claim. This includes last name, first initial, and middle
initial.

The unique identifier assigned by the provider identifying the patient

The date the services were rendered. This is the “From” date.

The total $ amount of the claim

The name and ID of the payer

Shows the status of the claim. For example, AE, AP, RE, RP, TE. See the Status Key
Legend field description below.

Status Key Legend

Describes each status acronym

AE - Accepted claim sent out electronically
AP - Accepted claim sent out on paper

RE - Electronic claim rejected by Emdeon
RP - Paper claim rejected by Emdeon

TE - Electronic test claim
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RPT-04A (Amended File Detail Summary Report)

Report

The RPT-04 report gives a detail summary of the file submitted for processing. This report is a file roll-
up listing all accepted and rejected claims contained in each file submitted to Emdeon. The RPT-04 also
contains payer name/ID and status of claim.

RPT-04A Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-04

report.

Header Section displays
the type of claims

distribution system
(Medical, Hospital,
Dental) and the report’s
title and run date.

Information Section
displays data on your
transmitted file. This
information can be
used for locating your
file in Emdeon’s
processing system.

Disclaimer Section
displays text message
explaining the intent
of the report. This
displays only once on
the report.

File Roll-Up
Section displays
header and detail
areas of a claim
record. Patient and
Payer information is
displayed.

Page Footer Section
displays report # and

page number(s) of the
report.

\§§§§§§§§§§“ihRPT—04A

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

File Detail Summary Report
FILE SUBMISSION DATE/TIME:
Run Date:

MM/DD/YY-HH:MM: SS
Emdeon Ref: 5634 MM/DD/YY
Report #: RPT-04A
Acct ID: 123
—»
File Control #: P23456
Submitter ID: 123456789
Submitter Name: Vendor Systems

KKK KKK KK KKK R R AR R R AR A A A A A A A A A A A A A A A A A AR A A A AR A AR KA KA AR A A KA KA KA KA AR KA KA KA KA KA KA KA KA KA KR AKX KKK KKK

’,,)V

ACCEPTED CLAIMS HAVE BEEN FORWARDED TO THE PAYER BY EMDEON BUSINESS SERVICES
DIVISION. ADDITIONAL CLAIM STATUS REPORTS MAY FOLLOW IF AVAILABLE FROM THE
PAYER. THIS IS NOT A GUARANTEE OF PAYMENT.

DISCLAIMER

KKK KKK KKK AR AR R AR A A R A A A A A A A A A A A A A A A A A A A A A AR A AR KA A AR A A A KA A KA A A KA KA KA KA KA KA KA KA AKX KA AKX KA KA KKK KK

Customer ID/Sub: 987654321 abcd NPI: 1234567890
Customer Name: Prov/Group Name
— FILE ROLL-UP
Patient Name Patient Date of Total Payer Name/ID Status
Control # Service Charges
Childs M J 39145278912547856364 012700 176.95 Payer One 12345 AE
Gagnon J 39143268973247658365 012800 1176.00 Payer Two 60054 RE
Osborn J 39145278955467289367 012500 276.00 Payer Three SMTX0 TE
Osborn J 39145278963098426368 012700 176.00 Payer One 12345 AP
Customer ID/Sub: 987654321 efgh NPI: 1234567890
Customer Name: Prov/Group Name
FILE ROLL-UP
Patient Name Patient Date of Total Payer Name/ID Status
Control # Service Charges
Bolders M J 39145278961234531363 012700 176.00 Payer One 12345 AE
Garrett J 39143268971234504366 012800 1176.00 Payer Two 60054 RE
Osborn J 39145278951234507369 012500 276.00 Payer Three SMTX0 TE
Sims J 39145278961234508362 012700 176.95 Payer One 12345 AP
Page 1
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( J emdeon’ Report

RPT-04A (continued)

Header Section
displays the type of Emdeon Business Services Division
claims distribution XXXXXXXX Claims Distribution System

system (Medical,
Hospital, Dental) and
the report’s title and
run date.

File Detail Summary Report
Run Date: MM/DD/YY

*** Status Key Legend ***
Status Key Legend

Section displays | ___—> AE - Accepted Claim sent out electronically
status acronyms and — | AP - Accepted Claim sent out on paper
values. RE - Electronic Claim rejected by Emdeon

RP - Paper Claim rejected by Emdeon

TE - Electronic Test claim

Page Footer Section
displays report # and
page number(s) of the

report. T |
P RPT-04A Page 2
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RPT-04A Detailed Information

Report

Sorting Sequence

By file submitted, by customer, and by patient

Frequency of Report

Next business day if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor daily claims submitted to Emdeon for future reference

Report Field Name

Description

Run Date The date the report was generated by Emdeon

Report # The Emdeon report number

Acct ID The submitter’s login/account ID assigned by Emdeon

File Control # Control number assigned to the file by the originator of the submitted transaction

Emdeon Ref The tracking number assigned by the Emdeon clearinghouse to identify the file. This value

can be used for referencing purposes.

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

DISCLAIMER

Text message explaining that the report is for status information only

Customer ID/Sub

The ID and Sub ID used by Emdeon to identify the customer

Customer Name

The name of the customer

FILE ROLL-UP:
Patient Name

Patient Control #
Date of Service
Total Charges
Payer Name/ID
Status

The name of the patient on the claim. This includes last name, first initial, and middle
initial.

The unique identifier assigned by the provider identifying the patient

The date the services were rendered. This is the “From” date.

The total $ amount of the claim

The name and ID of the payer

Shows the status of the claim. For example, AE, AP, RE, RP, TE. See the Status Key
Legend field description.

Status Key Legend

Describes each status acronym.

AE - Accepted claim sent out electronically
AP - Accepted claim sent out on paper

RE - Electronic claim rejected by Emdeon
RP - Paper claim rejected by Emdeon

TE - Electronic test claim

Page 73



O emdeon’

Emdeon Office Claims User Guide
Report

RPT-05 (Batch & Claim Level Rejection Report)

The RPT-05 report contains rejected batches and claims listed with detailed error explanations. In order
to prevent “lost” claims, the RPT-05 report must be reviewed and worked after each file transmission.
Claims that are listed as rejected are not forwarded to the payer(s) for processing. Rather, these
rejected claims must be corrected and then resubmitted (either electronically or on paper) for

processing.

RPT-05 Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-05

report.

Header Section displays

the type of claims
distribution system ————
(Medical, Hospital,
Dental) and the report’s
title and run date.

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

Batch & Claim Level Rejection Report

FILE SUBMISSION DATE/TIME:

MM/DD/YY-HH:MM:SS

Information Section
displays data on your
transmitted file. This
information can be
used for locating your
file in Emdeon’s
processing system.

Disclaimer
Section displays

text message /
explaining the
intent of the
report. This

displays only once
on the report.

Error Header and
Detail Section
displays claims that
are in error in the
submitted claims file
by provider. The field
in error and actual
data value are
displayed.

]

Page Footer Section
displays report # and
page number(s) of the
report.

v

Emdeon Ref: 5634
Report #: RPT-05
Acct ID: 123

Ly

File Control #: P23456

Submitter ID: 123456789
Submitter Name: Vendor Systems

KKK KK KKK A KRR AR A A A A A A A A A A A A A A A A A A A A A A AR AR A AR A A AR KA A KRR A KA A KA KA KRR KA KA A KA KA A KRR KA KA AKX KR KA KRR KKK K

| ¥

CLAIMS LISTED ON THIS REPORT HAVE NOT BEEN SENT ON TO THE PAYERS FOR
PROCESSING AND MUST BE CORRECTED AND RESUBMITTED ELECTRONICALLY OR ON PAPER.

khkhkhkhkhkhkhkhkhkhkhkhkhkkhkhkhkhkhkkkkkkkkkkkkkkkkkkk ok kkkkkkkkkkkkkkkhkkkkhkhkkkhkkkhkkhkhkkkhkkhkkk k% %

Customer ID/Sub: 987654321 abcd
Customer Name: Prov/Group Name

LR R R RS SR EEEE S

Patient Name Patient Ctrl #

Childs M F 39145278961247890361
Payer Name/ID: Payer Two 65004
ERROR MESSAGE: Invalid HCPCS number

FLD: FA0-09 SEQ:01 Field Name: HCPCS

39145278964563892368
65004

Goagnon J
Payer Name/ID: Payer Two

ERROR MESSAGE: Invalid HCPCS number
FLD: FA0-09 SEQ:01 Field Name: HCPCS

Lengyel-Gomez B M 39145278969876453360
Payer Name/ID: Payer One 56432
ERROR MESSAGE: Provider Number Mismatch

FLD: B0-08 SEQ:01 Field Name: PROV #

39145278961265374370
65004

Mazloompour J M
Payer Name/ID: Payer Two

ERROR MESSAGE: Invalid HCPCS number
FLD: FA0-09 SEQ:01 Field Name: HCPCS

p RPT-05

DISCLAIMER

: 1234567890

ERROR LISTING

Run Date: MM/DD/YY

R R R R R SRS SRS

Claim ID DOS Charges

okkeal2345-00002 012800 1176.00

Data in Error: 2503y

okkeal2345-00004 012800 1176.00

Data in Error: 2503y

okkeal2345-00012 012700 1500.00

Data in Error: E26995

okkeal2345-00010 012800 1176.00

Data in Error: 2503y

Page 1
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RPT-05 (continued)

Emdeon Office Claims User Guide
Report

Header Section
displays the type of
claims distribution
system (Medical,
Hospital, Dental) and
the report’s title and
run date.

Error Header

and Detail

Section displays /
claims that are in

error in the

submitted claims

file. The field in

error and actual

data value are

displayed.

Page Footer Section
displays report # and
page number(s) of
the report.

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

Batch & Claim Level Rejection Report

Payer Name/ID: Payer Two 65004

ERROR MESSAGE: Invalid HCPCS number

Patient Name Patient Ctrl # Claim ID DOS Charges
Osborn J 39145278963456789371 okkeal2345-00001 012700 176.00
Payer Name/ID: Payer One 56432
ERROR MESSAGE: Invalid CPT code
FLD: E0-05 SEQ:01 Field Name: CPT Data in Error: 99999
e 4
Customer ID/Sub: 987654321 abcd NPI: 1234567890
Customer Name: Prov/Group Name
kkkkkkkkkkkkkk ERROR LISTING kkkkkkkkkkkkkk*
Patient Name Patient Ctrl # Claim ID DOS Charges
Hayes J M 39145278970958765375 okkeal2345-00011 012800 1176.00

FLD: FA0-09 SEQ:01 Field Name: HCPCS Data in Error: 2503y
Indira-Manzur J 39145278996543635378 okkeal2345-00009 012700 176.95
Payer Name/ID: Payer One 56432
ERROR MESSAGE: Provider Number Mismatch
FLD: B0-08 SEQ:01 Field Name: Provider # Data in Error: E26995
Osborn J 39145278934654394373 okkeal2345-00001 012700 176.00
Payer Name/ID: Payer One 56432
ERROR MESSAGE: Invalid CPT code
FLD: FA0-09 SEQ:01 Field Name: CPT Data in Error: 99999

A RPT-05 Page 2

Run Date: MM/DD/YY
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RPT-05 Detailed Information

Report

Sorting Sequence

By file submitted, by customer, and by patient

Frequency of Report

Next business day if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor daily batch and claim level rejections. Contains detailed error explanations
necessary to correct any rejected claims. This report is very important and must be
worked and reviewed daily.

Report Field Name

Description

Run Date The date the report was generated by Emdeon

Report # The Emdeon report number

Acct ID The submitter’s login/account ID assigned by Emdeon

File Control # Control number assigned to the file by the originator of the submitted transaction

Emdeon Ref The tracking number assigned by the Emdeon clearinghouse to identify the file. This value

can be used for referencing purposes.

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

Customer ID/Sub

The ID and Sub ID used by Emdeon to identify the customer

Customer Name

The name of the customer

ERROR LISTING:
Patient Name

Patient Ctrl #
Claim ID
DOS

Charges

Payer Name/ID
ERROR MESSAGE
FLD

SEQ

Field Name

Data in Error

The name of the patient on the claim. This includes last nhame, first initial, and middle
initial.

The unique identifier assigned by the provider identifying the patient

The unique claim identifier assigned by Emdeon

The date from which the services were started (rendered) for the patient. This is also
known as the “From” date.

The total amount of the claim

The name of the payer and the identifier assigned by Emdeon

The description of the error

The field containing the data in error

The sequence number of the field containing the data in error

The name of the field containing the data that is in error

The data causing the error in the claim. The actual data that is in error will display on the

report.
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RPT-05A (Amended

Emdeon Office Claims User Guide

Batch & Claim Level Rejection Report)

Report

The RPT-05 report contains rejected batches and claims listed with detailed error explanations. In order
to prevent “lost” claims, the RPT-05 report must be reviewed and worked after each file transmission.
Claims that are listed as rejected are not forwarded to the payer(s) for processing. Rather, these
rejected claims must be corrected and then resubmitted (either electronically or on paper) for

processing.

RPT-05A Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-05

report.

Header Section displays
the type of claims

distribution system
(Medical, Hospital,
Dental) and the report’s
title and run date.

|

Information Section
displays data on your
transmitted file. This
information can be
used for locating your
file in Emdeon’s
processing system.

P

Disclaimer
Section displays
text message
explaining the
intent of the
report. This
displays only once
on the report.

Error Header and
Detail Section
displays claims that
are in error in the
submitted claims file
by provider. The field
in error and actual
data value are
displayed.

—

Page Footer Section
displays report # and
page number(s) of the

report. D

b

Emdeon Business Services Division

—> XXXXXXXX Claims Distribution System
Batch & Claim Level Rejection Report
FILE SUBMISSION DATE/TIME: MM/DD/YY-HH:MM:SS
Emdeon Ref: 5634 Run Date: MM/DD/YY
Report #: RPT-05A
Acct ID: 123
—»
File Control #: P23456
Submitter ID: 123456789

Submitter Name: Vendor Systems

KKK KK KKK A KRR AR A A A A A A A A A A A A A A A A A A A A A A AR AR A AR A A AR KA A KRR A KA A KA KA KRR KA KA A KA KA A KRR KA KA AKX KR KA KRR KKK K

DISCLAIMER
CLAIMS LISTED ON THIS REPORT HAVE NOT BEEN SENT ON TO THE PAYERS FOR
PROCESSING AND MUST BE CORRECTED AND RESUBMITTED ELECTRONICALLY OR ON PAPER.

KKK KKK KKK KR AR R R R R AR AR A A A A A A A A A A A A A AR AR A A A AR A KA AR KA A KA A A KRR KA KA KA A KA KA KA A KA KA KRR KA AR KA KA A KR KA KKK KK

Customer ID/Sub: 987654321 abcd
Customer Name: Prov/Group Name

NPI: 1234567890

KAKKKKKKKK KKK KK ERROR LISTING KAKKKKKKKK KKK KK

Patient Ctrl # Claim ID Charges
Childs M F 39145278961247890361 okkeal2345-00002 012800 1176.00
Payer Name/ID: Payer Two 65004

ERROR MESSAGE: Invalid HCPCS number

Patient Name

v

FLD: FA0-09 SEQ:01 Field Name: HCPCS Data in Error: 2503y
Goagnon J 39145278964563892368 okkeal2345-00004 012800 1176.00
Payer Name/ID: Payer Two 65004

ERROR MESSAGE: Invalid HCPCS number

FLD: FA0-09 SEQ:01 Field Name: HCPCS Data in Error: 2503y
Lengyel-Gomez B M 39145278969876453360 okkeal2345-00012 012700 1500.00
Payer Name/ID: Payer One 56432

ERROR MESSAGE: Provider Number Mismatch

FLD: B0-08 SEQ:01 Field Name: PROV # Data in Error: E26995
Mazloompour J M 39145278961265374370 okkeal2345-00010 012800 1176.00
Payer Name/ID: Payer Two 65004

ERROR MESSAGE: Invalid HCPCS number

FLD: FA0-09 SEQ:01 Field Name: HCPCS Data in Error: 2503y

RPT-05A Page 1
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RPT-05A (continued)

Emdeon Office Claims User Guide
Report

Header Section

displays the type of

claims distribution ———
system (Medical,

Hospital, Dental) and

the report’s title and

run date.

—

Run Date: MM/DD

Patient Name

Osborn J
Payer Name/ID:

ERROR MESSAGE:
Error Header FLD: E0-05 SE
and Detail P4

Section displays
claims that are in
error in the
submitted claims
file. The field in
error and actual
data value are
displayed.

’//,,f”

Customer ID/Sub
Customer Name:

Patient Name
Hayes J M

Payer Name/ID:
ERROR MESSAGE:
FLD: FA0-09 SE

Indira-Manzur J
Payer Name/ID:
ERROR MESSAGE:
FLD: B0-08 SE

Osborn J

Payer Name/ID:
ERROR MESSAGE:
FLD: FA0-09 SE

Page Footer Section
displays report # and

page number(s) of
\RPT—OBA

the report.

Emdeon Business Services Division
XXXXXXXX Claims Distribution System
Batch & Claim Level Rejection Report
/YY
Patient Ctrl # Claim ID DOS Charges
39145278963456789371 okkeal2345-00001 012700 176.00
Payer One 56432
Invalid CPT code
Q0:01 Field Name: CPT Data in Error: 99999
: 987654321 abcd NPI: 1234567890
Prov/Group Name
kkkkkkkkkkkkk* ERROR LISTING kkkkkkkkkkkkkk*
Patient Ctrl # Claim ID DOS Charges
39145278970958765375 okkeal2345-00011 012800 1176.00
Payer Two 65004
Invalid HCPCS number
0:01 Field Name: HCPCS Data in Error: 2503y
39145278996543635378 okkeal2345-00009 012700 176.95
Payer One 56432
Provider Number Mismatch
Q:01 Field Name: Provider # Data in Error: E26995
39145278934654394373 okkeal2345-00001 012700 176.00
Payer One 56432
Invalid CPT code
Q:01 Field Name: CPT Data in Error: 99999
Page 2
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RPT-05A Detailed Information

Report

Sorting Sequence

By file submitted, by customer, and by patient

Frequency of Report

Next business day if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor daily batch and claim level rejections. Contains detailed error explanations
necessary to correct any rejected claims. This report is very important and must be
worked and reviewed daily.

Report Field Name

Description

Run Date The date the report was generated by Emdeon

Report # The Emdeon report number

Acct ID The submitter’s login/account ID assigned by Emdeon

File Control # Control number assigned to the file by the originator of the submitted transaction

Emdeon Ref The tracking number assigned by the Emdeon clearinghouse to identify the file. This value

can be used for referencing purposes.

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

Customer ID/Sub

The ID and Sub ID used by Emdeon to identify the customer

Customer Name

The name of the customer

ERROR LISTING:
Patient Name

Patient Ctrl #
Claim ID
DOS

Charges

Payer Name/ID
ERROR MESSAGE
FLD

SEQ

Field Name

Data in Error

The name of the patient on the claim. This includes last name, first initial, and middle
initial.

The unique identifier assigned by the provider identifying the patient

The unique claim identifier assigned by Emdeon

The date from which the services were started (rendered) for the patient. This is also
known as the “From” date.

The total amount of the claim

The name of the payer and the identifier assigned by Emdeon

The description of the error

The field containing the data in error

The sequence number of the field containing the data in error

The name of the field containing the data that is in error

The data causing the error in the claim. The actual data that is in error will display on the

report.
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RPT-08 (Provider Monthly Summary)

The RPT-08 is a monthly report showing the number of accepted and $ value of claims a provider has
sent to the carrier(s) for the month. Monthly and Y-T-D totals for both accepted and rejected claims are
included as well as the provider’s top 25 errors for the month.

RPT-08 Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-08
report.

Header Section
displays the type of Emdeon Business Services Division

claims distribution — | XXXXXXXX Claims Distribution System
system (Medical,

Hospital, Dental) and
the report’s title and

Provider Monthly Summary
Report Date: MM/DD/YY

date.
B Report #: RPT-08

Information Ly

- . /
Section displays Acct ID: 123 Month Ending: MM/20YY
provider and
month-end Customer ID/Sub: 123456789 abcd NPI: 1234567890
information. Customer Name : Prov/Group Name

Carrier Statistics

Section d|sp|ays CARRIER OUTPUT CLAIMS
number of claims X .
submitted for that CARRIER CLAIMS % $ Value %
I’naOI’ét:Est)O the listed Payer Name One 362 50 44675.50 50
payer(s). Payer Name Two 84 11 9392.54 11

Payer Name Three 17 3 2335.00 3

Payer Name Four 56 8 5620.32 7

Payer Name Five 141 19 18347.05 20

Payer Name Six 24 3 2795.00 4

Paper 45 6 5909.00 7
Provider Totals PROVIDER TOTAL INPUT CLAIMS
Statistics Section ——_|

; >
displays monthly e s s
* % % * % % * k k%

and Y-T-D* totals Totals CLMS INPUT CLMSOACCEPTED CLMSOREJECTED
of the number and # $ Value # % $ Value # % $ Value
$ ‘l’)a"’.tetog claims Mthly 727 89174.41 726 100 89074.41 1 0 100.00
submitted. Y-T-D 6167 752273 .50 5973 97 728472.16 194 3 23801.34
Top 25 Errors
Section displays the ——| TOP 25 ERRORS
top 25 errors >
existing in all Field Field Name Error Total
submitted claims
files for the month. E6 Sequence # INV: Sequence # must be numeric 4417
The field, field name, D2 Payer Zip INV: Payer Zip not within state range 1140
error message, and DO Pat Rel. INV: Patient Relation 1186
total are dspﬂayed. E6 Network ID REQ: Render Network ID for Payer 1133
Page Footer
Section displays b RET-08 page 1

report # and page
number(s) of the
report.
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RPT-08 Detailed Information

Report

Sorting Sequence

By customer, by payer, and by error

Frequency of Report

Monthly, by the 5™ business day if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

Monitors overall monthly customer statistics, claims forwarded to the listed insurance
payers and the most frequent claim level rejections. Management could use this report.

Report Field Name

Description

Report Date The date the report was generated by Emdeon
Report # The Emdeon report number
Acct ID The submitter’s login/account ID assigned by Emdeon

Month Ending

The month for which this summary was generated

Customer ID/Sub

The ID/Sub ID used by Emdeon to identify the customer

Customer Name

The name of the customer

CARRIER OUTPUT CLAIMS:

CARRIER

CLAIMS
%

$ VALUE

The name of the payer where the claims were forwarded by Emdeon to the payer for the
month

The number of claims forwarded by Emdeon to the payer for the month

The percentage of total claims forwarded by Emdeon to the payer for the month

The $ amount forwarded by Emdeon to the payer for claims submitted by the provider for
the month

PROVIDER TOTAL INPUT
CLAIMS:
Totals

Mthly

Y-T-D*

The monthly provider totals of the number of claims, percentage, and values categorized
by CLMS INPUT, CLMS ACCEPTED, and CLMS REJECTED

The year-to-date provider totals of the number of claims, percentage, and values
categorized by CLMS INPUT, CLMS ACCEPTED, and CLMS REJECTED

TOP 25 ERRORS:
Field

Field Name
Error

Total

The field containing the data in error

The name of the field containing the data in error

The description of the error

The total humber of claims that contained that error for the month

*Y-T-D totals include data for claims processed by Emdeon beginning September 1st, 2001.
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RPT-10 (Provider Claim Status)

The RPT-10 report contains information provided from payers who are receiving claims for adjudication
from Emdeon. Not all payers who process claims through the Emdeon system provide information for
this Provider Claim Status Report, and the amount/frequency of information produced will vary from

payer to payer.

RPT-10 Report Sample

Emdeon Office Claims User Guide
Report

The following sample is provided to illustrate the various sections and fields contained in the RPT-10

report.

Header Section
displays the type of
claims distribution
system (Medical,
Hospital, Dental) and
the report’s title and
date.

—_—

Information Section
displays data provider
information. When
applicable, vendor
information also displays.

Disclaimer Section
displays text
message explaining
the intent of the
report. This displays
only once on the
report.

Claim Status
Header and Detail
Section displays (on
a daily basis) the
status of claims if a
status on Ty
a submitted claim has

been received from

the payer. Claims are

grouped according to

status, then payer.

Page Footer
Section displays
report # and page
number(s) of the
report.

T

Submitter ID:

—

Status: 20
Provider ID:
Payer Grp #:
Insured ID:
Patient:

Pat Ctrl #:
Patient DOB:
p.Total Charge:
Amount Paid:
Emdeon Ref:
Subm Clmid:
Data in Error:

Provider ID:
Payer Grp #:
Insured ID:
Patient:

Pat Ctrl #:
Patient DOB:
Total Charge:
Amount Paid:
Emdeon Ref:
Subm Clmid:
Data in Error:

Report #: RPT-
Acct ID: 123
Ly

XXXXXXXX Claims Distribution System

10

123456789

Submitter Name: Vendor Systems

Emdeon Business Services Division

Provider Claim Status Report

NPI:

Customer ID/Sub:
Customer Name:

khkkkkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkkkxkx

DISCLAIMER

THIS REPORT IS GENERATED BY THE PAYERS AND NOT BY EMDEON BUSINESS SERVICES
DIVISION. NOT ALL THE EMDEON PAYERS PARTICIPATE IN THIS CLAIM STATUS REPORT
PROGRAM AND THE AMOUNT OF INFORMATION RECEIVED VARIES FROM PAYER TO PAYER.

hhkkhkkkhkhhkhkhhhkhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhhkhhhkhhhhhhhhkhhkhhkhkhkhhkhhhhkhrk

CLAIM STATUS

Payer acknowledges receipt of claim

341376894 Payer Name:
583747423456777 Partial Claim?:
214563200 Payer ID:
L Duck Payer Phone:
123456678 Payer Ref:
121256 Payer Report Type:

85.00 Payer Status Date/Time:

62.35 Emdeon Process Date:
EP1234520031211 Emdeon Claim ID:

123456789012345678901234567890

DOS:

341376894 Payer Name:
583747423456777 Partial Claim?:
214563200 Payer ID:
L Duck Payer Phone:
123456678 Payer Ref:
121256 Payer Report Type:

85.00 Payer Status Date/Time:

62.35 Emdeon Process Date:
EP1234520031211 Emdeon Claim ID:

123456789012345678901234567890

DOS:

Report Date: MM/DD/YY

1234567890

123456789 1234
Prov/Group Name

Payer Two

Yes - 8

60050
5555555555
X158374

BCBS batch ack
031800/23:02:44
031800
keal2345-0007
031300-031300

Payer Two

No

60050
5555555555
X158374

BCBS batch ack
031800/23:02:44
031800
keal2345-0007
031300-031300
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RPT-10 (continued)

Header Section
displays the type of

claims distribution —™——_|

system (Medical,
Hospital, Dental)
and the report’s
title and date.

Claim Status Header
and Detail Sections
displays (on a daily
basis) the status of
claims if a status on a
submitted claim has
been received from the
payer. Claims are
grouped according to
status, then payer.

Page Footer Section
displays report # and

page number(s) of \‘

the report.

Emdeon Office Claims User Guide

Report

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

Provider Claim Status Report
Report Date: MM/DD/YY

Status: 20 Payer acknowledges receipt of claim

Provider ID: 341376894 Payer Name: Payer Two

Payer Grp #: 583747423456777 Partial Claim?: Yes - 8

Insured ID: 214563200 Payer ID: 60050

Patient: L Duck Payer Phone: 5555555555

Pat Ctrl #: 123456678 Payer Ref: X158374

Patient DOB: 121256 Payer Report Type: BCBS batch ack
Total Charge: 85.00 Payer Status Date/Time: 031800/23:02:44
Amount Paid: 62.35 Emdeon Process Date: 031800

Emdeon Ref: EP1234520031211 Emdeon Claim ID: keal2345-0007
Subm Clmid: 123456789012345678901234567890 DOS: 031300-031300

Data in Error:

Provider ID: 341376894 Payer Name: Payer Two

Payer Grp #: 583747423456777 Partial Claim?: Yes - 8

Insured ID: 214563200 Payer ID: 60050

Patient: L Duck Payer Phone: 5555555555

Pat Ctrl #: 123456678 Payer Ref: X158374

Patient DOB: 121256 Payer Report Type: BCBS batch ack
Total Charge: 85.00 Payer Status Date/Time: 031800/23:02:44
Amount Paid: 62.35 Emdeon Process Date: 031800

Emdeon Ref: EP1234520031211 Emdeon Claim ID: keal2345-0007
Subm Clmid: 123456789012345678901234567890 DOS: 031300-031300

Data in Error:

Status: 3C PENDING: Internal Review/Audit

Provider ID: 341376894 Payer Name: Payer Two

Payer Grp #: 583747423456777 Partial Claim?: Yes - 8

Insured ID: 214563200 Payer ID: 60050

Patient: L Duck Payer Phone: 5555555555

Pat Ctrl #: 123456678 Payer Ref: X158374

Patient DOB: 121256 Payer Report Type: BCBS batch ack
Total Charge: 85.00 Payer Status Date/Time: 031800/23:02:44
Amount Paid: 62.35 Emdeon Process Date: 031800

Emdeon Ref: EP1234520031211 Emdeon Claim ID: keal2345-0007
Subm Clmid: 123456789012345678901234567890 DOS: 031300-031300

Data in Error:

b-RPT-10 Page 2
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RPT-10 Detailed Information

Report

Sorting Sequence

By customer, by status, and by payer

Frequency of Report

Daily if claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor status of claims submitted electronically to payers. Note: Not all payers
provide a claim status electronically, and the amount/frequency of returned information
varies. The RPT-10 does not return Unprocessed, Request for Additional Information, or
Rejected statuses.

Report Field Name

Description

Report Date The date the report was generated by Emdeon
Report # The Emdeon report number
Acct ID The submitter’s login/account ID assigned by Emdeon

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

Customer ID/Sub

The ID/Sub ID used by Emdeon to identify the customer

Customer Name

The name of the customer

DISCLAIMER

Text message explaining that the report is generated if information is available from the
payer(s)

CLAIM STATUS:
Status

Provider ID

Insured ID
Patient

Pat. Ctrl #

Total Charges
Amount Paid

DOS

Status Data
Payer Name
Payer ID

Payer Phone
Payer Ref

Payer Status Date
Emdeon Process Date
Emdeon Claim ID

Indicates the status of the claim and the reason for the status. These status codes could
be payer proprietary codes, ANSI defined codes, or clearinghouse-defined codes for the
payer(s).

The provider number assigned to the provider by the payer. It could be a unique ID or a
tax ID for commercial payers.

The ID of the insured

The name of the patient

The unique identifier assigned by the provider identifying the patient

The total amount of charges for the claim

The payment amount that will be made for the claim by the payer

The beginning and ending date for the services rendered that the claim is covering

Data referenced by status message

The name of the payer providing status

The electronic ID of the payer providing status

The phone number the payer would like the provider to use to make inquiries

The unique payer-assigned number to the claim

The date the status was generated by the payer

The date Emdeon processed the claim

The unique claim identifier assigned by Emdeon
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Report

RPT-11 (Special Handling/Unprocessed Claims Report)

The RPT-11 report contains information provided by payers who receive claims from Emdeon for
adjudication. Not all payers who receive claims from Emdeon provide information for this report, and the
amount/frequency of information produced will vary from payer to payer. The RPT-11 returns

Unprocessed, Request for Additional Information, and Rejected statuses only.

RPT-11 Report Sample

The following sample is provided to illustrate the various sections and fields contained in the RPT-11

report.

Header Section
displays the type of
claims distribution
system (Medical,
Hospital, Dental) and
the report’s title and
date.

Information Section
displays data provider
information. When
applicable, vendor
information also displays.

Disclaimer Section
displays text
message explaining
the intent of the
report. This displays
only once on the
report.

Claim Status
Header and Detail

Emdeon Business Services Division
XXXXXXXX Claims Distribution System

Special Handling/Unprocessed Claims Report

Report Date: MM/DD/YY

Report #: RPT-11

Acct ID: 123 NPI: 1234567890

Submitter ID: 123456789
Submitter Name: Vendor Systems

Customer ID/Sub: 123456789 1234
Customer Name: Prov/Group Name

khkkkkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkkkxkx

__——»

Section displays (on
a daily basis) the __——] Pat Ctrl #:

status of claims if a
status on

a submitted claim has
been received from
the payer. Claims are
grouped according to
status, then payer.

Page Footer
Section displays
report # and page
number(s) of the
report.

T~

Data in Error:

Data in Error:

P RPT-11

DISCLAIMER

THIS REPORT IS GENERATED BY THE PAYERS AND NOT BY EMDEON BUSINESS SERVICES
DIVISION. NOT ALL THE EMDEON PAYERS PARTICIPATE IN THIS CLAIM STATUS REPORT
PROGRAM AND THE AMOUNT OF INFORMATION RECEIVED VARIES FROM PAYER TO PAYER.
THE CLAIMS REPORTED HERE ARE UNABLE TO BE PROCESSED BY THE PAYER AND A
CORRECTIVE ACTION SHOULD BE TAKEN.

khkkkhkhkhkhkhhhhhhhhhhhhhhhhhhhhhkhhhhkhhhkhkhkhhkhhhkhhkhhhkhhkhkhkhkhkhkhkhkhhkhkhkhkhkhkhkhkhkhkhkhkhkhkkhkkkxxkx

CLAIM STATUS

Status: 5A UNPROCESSED: CONTRACT HAS BEEN CANCELED BY THE POLICYHOLDER

Provider ID: 341376894 Payer Name: Payer Two

Payer Grp #: 583747423456777 Partial Claim?: Yes - 8

Insured ID: 214563200 Payer ID: 60050

Patient: L Duck Payer Phone: 5555555555
123456678 Payer Ref: X158374

Patient DOB: 121256 Payer Report Type: BCBS batch ack

Total Charge: 85.00 Payer Status Date/Time: 031800/23:02:44

Amount Paid: 62.35 Emdeon Process Date: 031800

Emdeon Ref: EP1234520031211 Emdeon Claim ID: keal2345-0007

Subm Clmid: 123456789012345678901234567890 DOS: 031300-031300

Provider ID: 341376894 Payer Name: Payer Two

Payer Grp #: 583747423456777 Partial Claim?: Yes - 8

Insured ID: 214563200 Payer ID: 60050

Patient: L Duck Payer Phone: 5555555555

Pat Ctrl #: 123456678 Payer Ref: X158374

Patient DOB: 121256 Payer Report Type: BCBS batch ack
Total Charge: 85.00 Payer Status Date/Time: 031800/23:02:44
Amount Paid: 62.35 Emdeon Process Date: 031800

Emdeon Ref: EP1234520031211 Emdeon Claim ID: keal2345-0007
Subm Clmid: 123456789012345678901234567890 DOS: 031300-031300
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RPT-11 Detailed Information

Report

Sorting Sequence

By customer ID, by status, and by payer

Frequency of Report

Daily for each submitter for payer status updates received within the previous 24 hours if
claim data is submitted by 8:00 p.m. Eastern time

Purpose of Report

To monitor and inform of the status of unprocessed, request for additional information,
and rejected statuses only on claims submitted electronically to payers. Note: Not all
payers provide a claim status electronically, and the amount/frequency of returned
information varies.

Report Field Name

Description

Report Date The date the report was generated by Emdeon
Report # The Emdeon report number
Acct ID The submitter’s login/account ID assigned by Emdeon

Submitter ID

The identifier used by Emdeon to identify the submitter. A submitter is the entity
submitting the file, which could be a provider, vendor, billing service, or clearinghouse.

Submitter Name

The name of the submitter

Customer ID/Sub

The ID/Sub ID used by Emdeon to identify the customer

Customer Name

The name of the customer

DISCLAIMER

Text message explaining that the report is generated if information is available from the
payer(s)

CLAIM STATUS:
Status

Provider ID

Insured ID
Patient

Pat. Ctrl #

Total Charge
Amount Paid

DOS

Payer Name
Payer ID

Payer Phone
Payer Ref

Payer Status Date
Emdeon Process Date
Emdeon Claim ID

Indicates the status of the claim and the reason for the status. These status codes could
be payer proprietary codes, ANSI defined codes, or clearinghouse-defined codes for the
payer(s).

The provider number assigned to the provider by the payer. It could be a unique ID or a
tax ID for commercial payers.

The ID of the insured

The name of the patient

The unique identifier assigned by the provider identifying the patient

The total amount of charges for the claim

The payment amount that will be made for the claim by the payer

The beginning and ending date for the services rendered that the claim is covering

The name of the payer providing status

The electronic ID of the payer providing status

The phone number the payer would like the provider to use to make inquiries

The unique payer-assigned number to the claim

The date the status was generated by the payer

The date Emdeon processed the claim

The unique claim identifier assigned by Emdeon
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Reporting & Analytics

Introduction

When your practice or site submits claims to the Emdeon clearinghouse, Emdeon retains and archives all
claim data per regulatory guidelines. Through a secure, web-based portal, Reporting & Analytics gives
you quick online access and detailed views of the previous 15 months of your claims data. Reporting &
Analytics enables you to customize and submit several claim search options that focus on data specific
to a patient, payer, or a patient claim status. These options are designed to provide you with the type of
summary or detailed information you need to do the following:

Track claims through their life cycle from first submission through payment
Monitor progress according to claim status

Identify claims that need rework, or that have been reworked

Evaluate trends to make needed adjustments to claims administration
Expedite claims payment

[

Note: All confidential data has been obscured in the following images.

Fundamentals

Access Reporting & Analytics

When you access Reporting & Analytics through Emdeon Office by selecting Claims > Reporting &
Analytics, the Reporting & Analytics home page will appear. This screen provides the launching point
for initiating search queries and other product functions.

FPayments ¥ | Analytics ¥ | Preferences¥ | Support ¥

& Claims v

Home

9 e

My Practice Information 3 Print

fou have more payer services available! Click here for details

File Summary Status
Rejected Claims Work Status

Claim Received Emdeon @ Payer Claim
Received File ID Claim . Rejedf Rejedf [
a7.72% Date Quantity Quantity Quantity
05/15/2011 | EP123FILE0O00D00828 |1 1 0 $101.00
05/15/2011 | EP123FILE000000829 |3 3 0 $309.00
05/14/2011 |EP123FILEO00D00828 |1 1 0 $60.00
05/13/2011 | EP123FILEO00000827 |2 2 0 $120.00
09/12/2011 |EP123FILEODOQOOD826 |2 2 0 $710.00
05/11/2011 | EP123FILE0O00D00825 |3 3 0 $770.00
05/10/2011 | EP123FILE000000823 |3 3 0 $33,300.74
05/10/2011 |EP123FILE000000824 |1 1 0 $650.00
05/0%8/2011 | EP123FILEO00D00822 |2 2 0 $3,100.52
05/01/2011 |EP123FILEOQQOO0EB10 |1 0 0 $3,102.00
05/01/2011 |EP123FILEO00D00818 |3 3 0 $517.92
08/25/2011 | EP123FILE000000829 |0 a 0 $0.00
08/28/2011 | EP123FILE000000828 |0 1] 0 $0.00
2.28% 08/27/2011 | EP123FILED0D0000827 |0 0 i $0.00
08/26/2011 | EP123FILEOQQO00E26 |0 0 0 $0.00

Use Search Date Ranges

To optimize system performance, use a date range of seven days or less, if possible. For selected

searches, you can select either Claim Received Date or Service Date. If the date fields are left blank,
Reporting & Analytics will set the date range to the previous seven days by default.
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Limit a Search

When you perform a higher-level (summary) search, Reporting & Analytics displays the first 1,000 rows
of data that match your specified search criteria.

If any search returns more than 1,000 rows of data, Reporting & Analytics displays a message to
indicate that there are more items in the database that match your search criteria than can be
displayed. If you see this message and have not found the data you want, return to the Search screen
and re-enter your search with more restrictive criteria. (For example, consider using a more narrow date
range.)

Filter a Search by Tax ID or Site ID
Searching against a specific Tax ID or Site ID is especially helpful for:

e Limiting search results to a specific provider or specialty area within a practice (by using the
associated Tax ID as search criteria).

e Limiting search results to a specific practice site for providers using multiple site ids for claims
submission.
Use Claim Quick Search
There are no date range options in Quick Search. A 30-day date range is used by default. For detailed
information about this search, see Claim Quick Search on page 104.
Export Entire Report

To view all rows of a report with more than 1,000 rows, you can export the report to a Microsoft Excel
spreadsheet (.xlIs). Click the “Export Entire Report” link located at the upper left of the report. The link is
available only when a report exceeds 1,000 rows.

Home = Work Queue Search > Claim Summary

Claim Received Date Tax ID Site ID Search Type

12/23/2010 12/30/2010 Al [v] m

If no dates are entered, dates will default to last 7 days.

I ] [ 1+ # [100% [v]

Export Entce Repors Claim Summary PR-1009

Search Criteria: Claim Date Range: 12/23/2010-12/30/2010 M Payer ID: < Empty = P Provider Tax ID: < Empty = P Site ID: < Empty >

Claim Status: Any » Worked Status: < Empty = » Emdeon File ID: < Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date  Amount D

Attention: Report display limited to 1,000 rows. Use 'Export Entire Report’ link to export all rows including those that exceed display limit.
Emdeon-Rejected
Site ID: 5885
File ID: EPOCTIVO16UVSTY

u3s 3318 12/20/2010 $100.00 86 CIGNA Medicare EP12
Advantage

Claim Referring Provider NPI: Invalid; Must be 10 numeric characters and must contain a valid NP1 Check Digit

This feature works for the following reports:

Claim Summary

File Summary Report
Summary by Payer ID by Day
Summary by Payer ID
Insured Detail Report
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Set User Preferences

User preferences allow you to set up a default search or system action (e.g., display dashboards). The
default search/action runs automatically upon access to Reporting & Analytics.

[

Note: The preference selections remain in effect until cancelled.

Set up a default search/action for any of the searches in the image below:

Home > Preferred Report
Select Search Type

Payer Search

Work Queue Search

Rejection Since Last Login

File Summary Search

Dashboard

Click "Save’ to set the preferences.

Search Type: Work Queue Search Date Range: Last 20 Days

View your Search Preference

Tax ID: Site ID: Criteria: All Claims

Reset your Search Preference

m Click on "Reset’ to remove your search preference.

Click on the option to be implemented. User Preferences are specific to your user ID; the selections you
make are applied to your user ID only.

Work Queue Search set in Preferences example:

Home > Preferred Report

Select Search Type [Change]

Work Queue Search Select Date Range [Change]
Last 7 Days Select Criteria [Change]
d Un-worked Set Search Criteria [Change]
o[ ]
seero ]

Click "Save' to set the preferences.

Search Type: Work Queue Search Date Range: Last 30 Days

View your Search Preference

Tax ID: Site ID: Criteria: All Claims

Reset your Search Preference

m Click on 'Reset’ to remove your search preference.
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Your saved preferences become active the next time you access Reporting & Analytics. The term User

Preference Report is shown at the top of the report.

Home > Work Queue Search = Claim Summary E B Help
Start Date End Date Tax ID Site ID Search Type )

04/26/2010 05/02/2010 Rejected-Un-Worked [w m

e ] i i1 3 | 100% v [ User Preference Report ]

- PR_1006
Claim Summary
Search Criteria: Claim Date Range: 4/26/2010-5/2/2010 » Payer ID: < Empty = » Provider Tax ID: < Empty > > Site ID: < Empty >
Claim Status: Rejected » Worked Status: NOT_WORKED W Emdeon File ID: < Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date  Amount D

Set Up a User Preference (Default) Search

aOUhWNH

Click Preferences in the navigation bar.

Click on the desired search type.

Specify your search options (making your changes in each sub-section, as applicable).

Optionally, click any “[Change]” link to view additional selection options.

Click Save.

Click the "Home" link on the Breadcrumb bar to return to the Reporting & Analytics main screen, or
select another function from the navigation bar.

When you next access Reporting & Analytics, your selected search will automatically run (with your
saved criteria).

Cancel a User Preference (Default) Search

1. When you access Reporting & Analytics, your previously defined default/preferred search runs.

2. After the report displays, click the "Home"” link on the Breadcrumb bar to return to the main page or
select a different search with the drop-down menus.

3. To cancel the Preferred Search, click the Preferences tab to access the setup screen.

4. In the Preferences screen click Reset to cancel the user preference settings.

5. You can now define a different search preference.

Customizable Alerts

Introduction

Use Customizable Alerts to stay informed via email when your specified claim rejection amount
threshold(s) are exceeded. Alert notifications are sent to the email address on file for your account. To

verify or update your existing email address, go to manage users
for and edit users.

No PHI is included in any Alert.
Note Do not reply to Reporting & Analytics email Alerts.

Click on Preferences > Set Alerts.

under the Setup tab in Office to search

£

Claims ¥ | Payments ¥ | Analytics ¥ | Preferences ¥

Set Preferences

Home Set Alerts

Support ¥
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Customize Your Alerts X

. Alerts should be wsed in addition to your normal claim
( 2mole0ry management practices in Emdeon Vision. Do not rely only on
J Alerts to monitor claims at your facility.

Please select your options to get alerts

Alert 1: Select a threshold for individual rejected claims. You will
receive an email notification when a single claim that exceeds your
specified threshold is rejected.

Select Frequency of alerts | Dally ¥
® Rejected claim amount exceeds $500
O Rejected claim amount exceeds $1000

O Rejected claim amount exceeds £2000

| Alert 2: Select a threshold for multiple rejected claims. You will
receive an email notification when the total amount of rejected,
unworked claims exceeds your specified threshold.

Select Frequency of alerts | Daily %
Total Rejected and Unworked claim amount exceeds $5000
Total Rejected and Unworked claim amount exceeds 510,000

Total Rejected and Unworked claim amount exceeds 520,000

I

The following alerts have been set:
Rejected Claim Amount exceeds $500 Frequency: Daily
Mo alerts set for Alert 2

Email Alert Frequency

You can receive email Alerts daily or weekly. Alerts are generated only if your selected threshold is
reached.

Setup Alerts

Click on Preferences>Set Alerts. The Customize Alerts popup window displays.
Two types of Alerts are available, individual claim-specific (Alert 1) or combined claims totals (Alert
2). Place a check in the checkbox for the Alert type you want.
You can select one Alert type or both.
Set the frequency for each Alert by selecting Daily or Weekly for each Alert.
v' Weekly Alert emails are generated every Monday morning at 6am EST and include last 7 days of claims
data from claims received between yesterday (Sunday) and the previous Monday.

v' Daily Alert emails are generated at 6am EST every day and include claims data of claims received the
previous day.
Select monetary Alert level for each Alert type by placing a check in the applicable checkbox. You
can select one Alert level per Alert type.

Alert 1: Threshold Alert for rejected amounts (in US dollars) for individual claims.
v" Rejected amount exceeds $500.

v' Rejected amount exceeds $1000.
v Rejected amount exceeds $2000.

Alert 2: Threshold Alert for total dollar amounts (in US dollars) for combined rejected and
unworked claims.
v' Rejected amount exceeds $5,000.

v Rejected amount exceeds $10,000.
v Rejected amount exceeds $20,000.

Click Submit to save your Alert settings.

After settings are saved, your saved Alerts and their frequency are displayed in a message at the
bottom of the Customize Alerts window. This information is always displayed whenever the
Alerts window is accessed.

v If no Alert is set the following message is displayed: There are no Alerts set.
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Receiving Email Alerts from Emdeon Reporting & Analytics
Do Not Reply to Alert Email

Email Alerts contain an introductory statement identifying the communication as an Alert from Emdeon.
Do not reply to the Alert email. Note: The terms ‘Emdeon Vision’ and ‘Reporting & Analytics’ are used
interchangeably in this section.

Alert Email Format - Alert 1

For Alert 1, the user will receive the following message:

“This is an alert from Emdeon Claim Vision. <Number of claims> rejected claims exceed your
rejected claim amount alert threshold of <threshold value> per claim. Please visit Emdeon
Vision to review these claims.”

Claim rejection information for individual claims (Alert 1) is organized in a table format with the
following column headings:
v' Claim ID

v" Claim Amount

v" Rejected by
(Either Emdeon or payer - If by payer, payer ID is displayed.)

v" Rejection Date

v Rejection Reason

The table is limited to ten claims and the sort order is by rejected claim amount.

Alert Email Format - Alert 2
For Alert 2, the user will receive the following message:

This is an alert from Emdeon Claim Vision. The total claim amount of your rejected and
unworked claims is <value> which exceeds your <threshold value> setting. Please visit
Emdeon Vision to review these claims.

As rejected, unworked claims are “worked” in Reporting & Analytics; these changes should be reflected
by this Alert. That is, as rejected, unworked claims are corrected in Vision, the claims causing this
threshold to be exceeded should be reduced, eventually to the point where the threshold is no longer
exceeded.

Alert Email Identification

Email address of Emdeon Vision Alerts is VisionAlerts@emdeon.com.

Note Please do not send emails to this address, or reply to Vision Alert emails.

Use the Worked Claim Feature

A claim can be marked “worked” at the Claim Detail level. This feature is used for claims that require
edits or additional information prior to resubmission when the first-pass claim has been rejected by
Emdeon or the payer. The "Worked Claim” feature enables you to quickly identify those rejected claims
that have been worked, and those un-worked claims that require attention.

The term “Worked” may be used to signify any of the following claim conditions:

e The claim has been accessed for corrective action (edits or additional information), but has not been
completely corrected for resubmission.

e Required corrective action (edits or additional required information) is complete, but the claim has
not been resubmitted.

e All required corrective action (edits or additional required information) has been completed, and the
claim has been resubmitted.
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@ Note: The definition of the terms "Worked” and “"Un-Worked” as they relate to your practice’s
workflow should be understood by all Reporting & Analytics users within your
practice/organization.

View Worked vs. Un-worked Claims

Work Queue search enables you to quickly identify worked and un-worked claims. For more information
on performing this search option, please see Rejection Since Last Login Search

Access this search by selecting Claims > Rejection Since Last Login. This search displays a Claim
Summary report of all claims that have been rejected since you last accessed Reporting & Analytics.

Note: There are no search criteria associated with this report. Click Submit to run the search.

Work Queue Search on page 129.

Update Claim “"Worked” Status

The Claim Detail Report includes a "Worked” check box that is unchecked by default. To mark a claim as
“Worked” simply click once in the check box (this will place a check in the box).

The “Worked/Un-worked” status can be viewed in the Claim Summary Report. In the Claim Detail Report
“Worked” status of the claim is shown by a check in the "Worked/Un-worked” check box, see
Descriptions and functions of key user fields in the Claim Detail section are presented below.

Worked Status Indicator on page 142.

My Practice Landing Page

Change View with Date Range

Use the date range list to change the current Landing Page view. When you change the date range, the
view automatically updates.

Landing Page and Preferred Reports

If you have set a Preferred Report in User Preferences, the Preferred Report displays when you access
Reporting & Analytics instead of the Landing Page. To view the Landing Page instead of a Preferred
Report on login, cancel the selected Preferred Report by clicking Preferences, and then Reset.

Data Displayed in Landing Page
¢ Rejected Claims “"Worked’ Status” Clickable Pie Chart

Use the date range list to view any rejected claims for your Provider Organization for the
selected date range. All rejected claims with status of "Worked” or "Un-worked” are included

in the pie chart. Click a pie slice to view a Claim Summary report that contains data based on
the criteria of the pie slice.

e File Summary Status Clickable Table

All batches submitted during the date range displayed in the date list are displayed. You can
readily view the number of batches, value, and if any batches are missing (based on your
local knowledge of what is expected to have been submitted). The Claim Amount column
shows which batches have the most claim dollars at risk. Click the File ID number to view
details of any claims in the selected batch.

e Run a Quick Search

You can do a Quick Search on numerous data points found in a claim. Please see Audit
History Search

Page 93



/\ Emdeon Office Claims User Guide
( J emdeon

Reporting & Analytics

Access this search by selecting Analytics > Audit History. Run a search to display an Audit History
report of all applicable or matching claims whose “worked/unworked” status has changed. Search for
updated claims by single date (or date range) or by Emdeon Claim ID number.

Home > Audit History

Search By Audit History Date
Date Range v 01/01/2010 08/09/2010 m m
If no dates are entered, dates will default to last 7 days.
= 1 /1 i)
Audit History
The results shown below have been limited to 1000 rows. To obtain all results based upon your search criteria, please use the "Export” optic
Username Action Performed Date/Time stamp Emdeon Claim ID
. — Y
— S —
 — [ S—

Page 1

Claim Quick Search on page 103 for more information.

Access Service Enrollment Matrix

Click the link in the Home/My Practice Information landing page. The link is accessible in the upper left
section of the screen. “You have more payer services available! Click here for details.”

ﬁ Claims ¥ | Payments ¥ | Analytics ¥ | Preferences¥ | Support ¥

Home Last

My Practice Information o —

You have more payer services availablg! Click here for details 5

—_— T

Which Payer Services are Available?

Vision includes numerous services that facilitate effective information/data exchanges between providers

and payers. You can easily determine which functions a particular payer supports, and review the
availability of features.
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e Claims ¥ | Payments ¥

Analytics ¥ | Preferences¥ | Support ¥

Home = Service Enrollment Matrix

Payer Service Enrollment Matrix

Payer Name Payer ID ERA EFT

CIGNA 62308 Available Mot Available
UNICARE 80314 Available Mot Available
Network Health 04332 Available Available

Tufts Health Plan 04298 Not Available | Mot Available
UnitedHealthcare 87726 Available Not Available
ExpressBill SPRNT Not Available | Mot Available
Blue Cross Blue Shield of Massachusetts SB700 Available Not Available
Harvard Pilgrim Health Care 04271 Not Available | Mot Available
Aetna 650054 Available Not Available
MA Medicare Part B (114 - NHIC) SMMAQD Available Not Available

Review Payer Offerings

E| @ Hep

3 Print

The offerings of each payer are displayed in the payer row of the Service Enroliment table.
v Available
If the payer offers this function but your account is not currently configured to use it, "Available" appears in
the applicable box in the table. Click link to display instructions and a registration form in a separate
window to setup your account for the EFT function.
Note:
If you click on the Available link in the ERA or Claims columns an instructional message is displayed.

v" Not Available
If the payer does not offer this function "Not Available" appears in the applicable box in the table.

Payer Functions

The following payer offerings/functions are displayed as column headers in the Service Enrollment

matrix table. Look on the row for a specific payer to determine if a particular function is available (for

your account) from that payer.
v' Payer Name

v' Payer ID
v ERA

o Possible values are Available, Not Available, and Yes.

o ERA - Electronic Remittance Advice; an electronic version of a payment explanation which provides
details about providers' claim(s) payment, and if the claim(s) is denied. If claim was denied the ERA
includes the required explanations. The industry standard for sending of ERA data is the HIPAA
X12N 835 standard.

v EFT
o Possible values are Available, Not Available, and Yes.
o EFT - Electronic Funds Transfer; electronic receipt of funds from payers.

Emdeon Payer ERA Enrollment Form

Emdeon can accept ERA enrollment information for all payers listed below through a
single electronic form. Please provide your practice, provider, and contact information
below and then select all payers from whom you wish to receive ERAs. When completed,
press the submit button to send this information to Emdeon and we will facilitate the
registration process with each selected payer.

ATTENTION DENTAL PROVIDERS: Completion of this form is NOT required for all
submitters to receive DENTAL ERAs. Please verify with your PMS Vendor or
dentalsupport@emdeon.com prior to completing this form.

ATTENTION CONNECTICARE PROVIDERS: If you select the Connecticare Payer option
below, you will be presented a field to enter your Connecticare payer ID. THIS IS A
REQUIRED FIELD. If you do not have a Connecticare ID number, contact Connecticare to
obtain one.
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EFT Registration

Only Emdeon's ePayment suite provides you single-enrollment access to the nation's
leading healthcare payment network. Emdeon ePayment can dramatically reduce
expenses, shorten the reimbursement cycle and streamline workflow through the
broadest payer network in the market! Simple enrollment. Incredible benefits.

Please complete the following information and Emdeon will email you a welcome kit with

instructions on next steps in the EFT enrollment process!

Organization Contact Information Primary Contact Information

*Tax ID

(If you need to enroll multiple Tax
1Ds/facilities, please submit a separate
request for each)

*Organization Name

*Same as Organization Contact

Information?

[ ves

FEFT Contact Name

“Email Address

*Contact Name

*Phone Number

“Email Address

| | =Street Address
*Phone Number |

| | |

*Street Address =City

| | |

| | *State *ZIP Code
. C® [ ]

| |
=State *ZIP Code

B

*Are you a billing service?

Cvyes @& No

*Do you use a billing service?

Cves @® No

System Vendor Name

*Are you an existing Claim Master Suite
customer?

® ves O No O Notsure

Emdeon Office Claims User Guide
Reporting & Analytics
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Dashboard Overview

The Reporting & Analytics Dashboard includes four views, three of which provide a clickable graphical
representation of important claim data.

Claim acceptance/rejection status percentages
Highest dollar amounts for rejected claims by payer
Monthly dollar sum totals for submitted claims
Frequently occurring reasons for claim rejections

This information can be helpful in analyzing your practice’s performance, and help in increasing
efficiencies and reducing rejections.

Home = Dashboard Search

Select Date Range Tax ID

Last 7 Days
Last 8 Weeks

Last 6 Maonths, )

Use the Select Date Range drop-down list to set the date range. The optional Provider Tax ID field
allows you to limit the displayed dashboard data to only those claim summaries for a specific provider or
specialty area (or site) within your practice for which a Tax ID is set up. Click Submit to display
dashboards.

[

Note: Tax ID must be a valid 9-digit numeric string.

Dashboard Views
The Reporting & Analytics Dashboard includes four views:

Claim Status Summary (pie chart)

Top Payers by Sum of Rejected Dollar Amounts (bar graph)
Claim Charge Amount (line graph)

Top 10 Rejection Reasons (text table)

R Top Payers by Sum of Rejected Dollar Amounts
Claim Status Summary 1,300,000

86.24%

41,040,000

$780,000 FE18,964

$416,647

$520,000 4358781 s34z 191

Sum of reject dollar amount

$260,000

0

F.51% 3.56% ‘
87 &0 55 5B ao
Weroeon_accerten [lBoTH_accerTep [ EMpEON REJECTED [l PAVER_REJECTED Payer 1D
Top 10 Rejection Reasons
Rejection Message Source Quantity
Claim Charge Amount Duplicate Claim: Invalid; Claim submitted SR 7916
419,000,000 presshy
' o Destination Payer Primary Identifier: Invalid;
3 Must be a valid Payer ID from the Emdeon Payer | EMDEON 3554
°E: $15,200,000 List
Payer Secondary Identifier: Invalid; Must be a
R ey valid Claim Office Number for Payer EMBEON =333
1 i ACK/RETURNED - Missing/invalid data prevents
2 X y : PAYER 3276
E payer from processing claim. - Receiver
£ $7.500.000 Service Line Procedure Cede Modifier: Invalid;
Y Must be a valid CMS (HCPCS) modifier EMBEON 1439
% 43,000,000 Subseriber Primary Identifier: Invalid; Does not | prveq i
B match Payer eligibility
3 Subscriber Primary Identifier: Invalid, Must be 12
vl = = = = 5 S = characters with position 1 equal to H or C,
P o ~ S o position 2 must contain an alpha-numeric EMDEON 632
3 & o G ¢ & o o character and positions 3-12 must be numeric for
> g g g ¥ N e g Payer
Patient: Invalid; Patient was not eligible for
Claim Date benefits with Payer for Service Dates entered EocE i
Claim: Denied; Missing or invalid data prevents
Payer from processing thi claim. Please contact | PAYER 504
the payer directly for further infermation
Diagnosis Code Pointer: Invalid; Diagnosis Code | guneon i

indicated by Pointer must be entered
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The table below describes the information that is provided in each of the four dashboard views.

Dashboard View

Information Provided for Specified Date Range

Drill-Down to Claim
Summary Report

Claim Status
Summary

Clickable pie chart:

¢ claims accepted at Emdeon clearinghouse, but no status
received yet from payer

e claims accepted at Emdeon clearinghouse and by payer
¢ claims rejected by Emdeon clearinghouse

¢ claims rejected by payer

Yes - for claim status

Top Payers by Sum
of Rejected Dollar

Displays a bar graph for each of 5 payers (the top 5 payers
by Payer ID) with the largest rejected claim dollar amounts

Yes - for selected payer

Amounts
Claim Charge Displays total charges for all claims submitted to the Emdeon Yes - for selected day, week,
Amount clearinghouse during the specified time period or month

Top 10 Rejection
Reasons

Displays count and detailed description of the top 10 reasons
why claims were rejected, either by the Emdeon
clearinghouse or by the payer

No - this table is not clickable

Access Dashboard Views

1. Select Analytics > Dashboard.

2. Select a date range from the drop-down list.

3. Enter a Provider Tax ID (optional) to limit the display to only a specific provider or specialty area (or
site) within your practice for which a Tax ID is set up.

L

4. Click Submit.

Dashboard Search

Note: Provider Tax ID is a 9-digit numeric string.

Access this search by selecting Analytics > Dashboard. Use this search to launch a dashboard view of
your claims processing in Reporting & Analytics for the date range selected. Leave the Tax ID field

blank to view data specific to your own provider tax ID. For more information, see Dashboard
Overview on page 97.

L

Note: If your account is an organization-level account, you can see a dashboard view of data for

all the provider tax IDs associated with your organization ID by leaving the Tax ID field empty.

Enter a specific provider tax ID in the Tax ID field to limit the dashboard data to only the

specified provider tax ID.
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Claim Status Summary

Claim Status Summary

86, 24%

-ze9wm
7.51% 3.56%

[l evoeon_sccepten [l otH_accerTep [ empeon_ReJecTED [l PAYER_REJECTED

Top Payers by Sum of Rejected Dollar Amounts

Top Payers by Sum of Rejected Dollar Amounts
$1,300,000

41,040,000

$780,000 |

$416,647

$520,000

Ee

SEASE T §34E,181

$260,000

Sum of reject dollar amount

87% = E0s S5p%* SBpe. DO0Aw

Payer ID

The dollar amount increments shown on the “y” (vertical) axis are determined according to the amounts
calculated for the top five payers.
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Claim Charge Amount

Claim Charge Amount

2 $19,000,000

=

-]

E $15,200,000

=

]

g $11,400,000

-

(=]

E  47.600,000

L]

=]

% $3,200,000

£

=l

& 0

o Q ) ) o ) o o
I e S G R e
I @ o V' v 2 i X
2 g ¥ ¥ ¥ 5 ” 5
Claim Date

The dollar amount increments shown on the “y” (vertical) axis are determined according to the claim
dollar amounts calculated for the specified day, week, or month.

Top 10 Rejection Reasons

Top 10 Rejection Reasons

Rejection Message Source Quantity
Duplicate Claim: Inwvalid; Claim submitted EMDEON 7018
previously

Destination Payer Primary Identifier: Invalid;

Must be a valid Payer ID from the Emdeon Payer | EMDECN 3554
List

Payer Secondary Identifier: Invalid; Must be a EMDEON 3335

valid Claim Office Number for Payer
ACK/RETURNED - Missing/invalid data prevents
payer from processing claim. - Receiver
Service Line Procedure Code Modifier: Invalid;
Must be a valid CMS (HCPCS) modifier
Subscriber Primary _Identlfler: Invalid; Does not PAYER 1066
match Payer eligibility

Subscriber Primary Identifier: Invalid, Must be 12

characters with position 1 equal to H or C,

PAYER 3276

EMDECN 1456

position 2 must contain an alpha-numeric EMDECN 632
character and positions 3-12 must be numeric for

Pavyer

Patient: Invalid; Patient was not eligible for PAYER 614

benefits with Payer for Service Dates entered
Claim: Denied; Mis=sing or invalid data prevents

Payer from processing this claim. Flease contact PAYER 504
the payer directly for further infermation
Diagnosis Code Pointer: Invalid; Diagnosis Code EMDEGN 406

indicated by Pointer must be entered

The Top 10 Rejection Reasons table is not currently clickable.
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You can access two kinds of reports via the clickable dashboard views, Claim Summary Report and Claim
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Detail Report. Both reports are described in detail in the following section of this document. A Claim
Summary Report can be accessed by clicking on a pie chart pie piece, graph point, or graph bar.

L

Note: The Top 10 Reject Reasons table is not clickable.

Dashboard views are built upon pre-selected search criteria but with a user-defined date range. The
criteria of the views are displayed on the dashboards themselves:

e By claim status.
e By significant rejection dollar amounts (for payers with the highest dollar amounts.
e By claim charge dollar amounts for a selected time period (day, week, or month).

Claim Data Searches

These searches are currently available in Reporting & Analytics:

Audit History Search

Claim Quick Search

Claims with ERA Search

File Summary Search

Patient Search

Patient Pay Search

Payer Search

Rejection Since Last Login Search
Work Queue Search

Options by Search Type

Search Type

Available Search Options

Search Criteria

Audit History

Display claims that have “worked” or “unworked”

e Date

Search status change during the specified date range or e Emdeon Claim ID
specific date

Claim Quick Quickly access claim information based on known e Emdeon Claim ID

Search search criteria e Submitter Claim ID

e Payer Claim ID

e Insured ID

e PCN (Patient Control Number)

¢ Patient Last Name (with optional date of birth)
e Patient date of birth

Claims with ERA
Search

Find claims that have ERAs associated with them.

Use (optional) Tax ID or Site ID to limit search
results. If your practice is part of a large
organization, using your own Tax ID or Site ID will
help limit search results.

File Summary
Search

View all claims by claim batch that were received
by Emdeon during a time frame (date range).
Each claim batch is identified by a File ID (Emdeon
batch identifier).

e Received Date range

and optionally, either or both of the following:
e Tax ID

e Site ID

Patient Pay Search

1. View all patient payments made through Patient
Pay Online for a specified date range

2. View all patient payments made through Patient
Pay Online for a specified date range and a
specific patient name or patient account number.

Search by Transaction Date:

e Transaction Date range

and optionally

e Worked status

Search by Patient Name:

e Transaction Date range

¢ Patient Name

Search by Patient Account Number:
e Transaction Date range

e Patient Account Number
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Search Type

Available Search Options

Search Criteria

Patient Search

1. View all claims for a specific insured party and
dependents (by Insured ID)

2. Locate all claims for a specific Patient Control
Number (PCN)

3. Locate all claims for a specific patient

* Date range (service date OR received date)
and one of the following

e Insured ID

e PCN

e Patient Last Name (with optional date of birth)

Payer Search

1. Display a summary of all claims
2. Display a summary of all claims for a specific
payer

e Received Date range

and optionally, any combination of the following:
e Tax ID

e Site ID

e Payer ID

Rejection Since
Last Login Search

View all claims that have been rejected by all
payers since last user login

None required

Work Queue 1. Display a summary of all claims for a specific e Received Date range
Search status ¢ Claim Status
2. Display a summary of all claims for Rejected and optionally
Claims with “Worked” or "Un-Worked” sub-status e Tax ID
¢ Site ID
o If Rejected status selected: “All,” *Worked,” or “Un-
worked” sub-status
'

results.

Work with Search

Required fields are indicated by a red asterisk (*).

Note: The table in the Search Results section on page 130 lists each search and reporting

Enter a date range for your search. You can manually enter a date (mm/dd/yyyy format) or use the
calendar tool. If no dates are selected the default date range (inclusive of the last seven days) is
entered automatically.

Home = Patient Search m @ Help
Select Date Type | Rec [v] Claim Received Date m m
Search By | Insul ~| *Insured ID
If no dates are entered, dates will default to last 7 days.
Date fields without calendar tool shown.
Home > Patient Search m @ Help
Select Date Type | Received Date |w Claim Received Date | September[wv][2010[v
- = . smTwTES [ sumit | Reet |
Search By | [nsured 1D E4 Insured ID —
If no dates are entered, dates will default to last 7 days. eﬂ 8 910
13 14 15 16 17
20 21 22 23 24
27 28 29 30
Today

Date field with calendar tool shown. Click in the date field to show the calendar tool for that

field.

Run a Search

Default date range is the last seven days.

Results can be searched and/or printed.

1. Select a search type.
2. Enter all required data.
3. Enter any desired optional data.
4.
default date range automatically.

5.
6. Click Submit.
7.

3

Select a date range (if applicable). If dates are not selected, Reporting & Analytics will enter the

Note: If no matches are found, change your search criteria, then rerun the search.
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8. After the report displays click on any underlined hyperlink for further details. For more information,
see Detail Links on page 130.

Work with Dates

Date Criteria are Retained across Searches
The date or date range used in your most recent search is retained across all searches during a session.
When you select a different search type, the date or date range from the previous search is
automatically entered in the date fields of the new search. The purpose of this date retention
functionality is to save time and keystrokes as you navigate from search to search.
Run a Single Date Search
If you enter a date in either the Start Date or End Date field only, when you click Submit, the
remaining open field is filled with the same date. The resulting search will run on a single date only.
Use Default Date Range
If both date fields are left empty, the system will automatically enter a date range of the last 7 days
(inclusive of today) when you click Submit.
Date Format Options
Basic syntax of manually entered dates: mm/dd/yyyy.
Additional allowed date configurations:

¢ Month can be entered as either mm or m.
e Day can be entered as either dd or d.
e Year can be entered as either yyyy or yy.

Date Entry Shortcut
e Type the letter t to enter today’s date in date field.

Type the letter t in the date field to place today’s date in that field. The letter t is displayed
until you click Submit, after which t is replaced with today’s date.

e Use t-xx to enter a past date in the date field.

For example, type t-3 in the date field to enter the date that occurred three days before
today. The shortcut that you typed, t-3 in this case, is displayed in the date field until you
click Submit, after which t-3 is replaced with a format-compliant date.

" 4 Note: Claims data for the previous 15 months can be viewed in Reporting & Analytics.

Audit History Search

Access this search by selecting Analytics > Audit History. Run a search to display an Audit History
report of all applicable or matching claims whose “worked/unworked” status has changed. Search for
updated claims by single date (or date range) or by Emdeon Claim ID number.
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Home > Audit History

Search By

L2

Audit History Date

If r es are entered, dates will default to last 7 days
=} /1 )]
Audit History
The results shown below have been limited to 1000 rows. To obtain all results based upon your search criteria, please use the "Export” optic
Username Action Performed Date/Time stamp Emdeon Claim ID
S E— =
[ S Ee——F
——— EC— 10

Page 1

Claim Quick Search

This search field is located in the upper right corner of the landing page. When searching with IDs or any
allowable data element in Quick Search, only those claims that exactly match your search criteria are

displayed. However, when searching by a patient first or last name, you can use a name segment (three
consecutive letters must be used).

i) @ Help
Next 30 Days >>
/1 @ | 100% v
Claim Summary PR-1005
Search Criteria: Claim Date Range: 2/26/2010-3/28/2010 > Payer ID: » Provider Tax ID: > Site ID:
Claim Status: > Worked Status: » Emdeon File ID: = Empty =
[

Note: The 30-day navigation links display at the top of the resulting report after a Quick Search
is performed. If your search returns no results when the report is loaded, you can use the "Prev
30 days” link to search for results of your initial search for an earlier time period.

Claim Quick Search Results

Quick Search results are delivered in a Claim Summary Report (see Claim Summary Report on page
149).

Launch a Quick Search

Enter one or more criteria in the search field, and then click the search icon at the right of the field. At
least one search criteria must be entered to run a search. (Search criteria are not case sensitive.) There
are no date range selection options in “Quick Search.” A 30-day date range is used by default.

Search Results

If a search results in a single matching claim only, the Claim Detail for that claim is displayed. When
more than one claim match the search criteria all matching claims for the previous 30 days are
displayed in the Claim Summary report. Click “View More"” to see claims older than 30 days.

L

Note: Reporting & Analytics can search up to 15 months of claims data.

Allowed Search Criteria

Only those claims that match all entered search criteria are displayed. Search criteria must match the
format of at least one of the following searchable claim fields.

Searchable Claim Field Description
PCN

Patient Control Number. An alphanumeric string that can include up to 20 characters.
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Searchable Claim Field

Description

Insured ID

An alphanumeric string that can include up to 20 characters.

Patient Name (Last Name
and/or First Name)

Enter a patient’s exact first name and/or the exact spelling of the last name. The only
claims shown are those that match exactly the criteria entered. To search on the patient’s
full name, use quotations: “John Smith”.

Patient DOB

Use the format mm/dd/yyyy (or m/d/yy) to locate claims. A forward slash (/) must be used
when searching against a date. For example, to find claims for January 4, 2008, enter
either 01/04/2008 or 1/4/08.

Emdeon Claim ID

CORN. This ID contains 17 characters (two letters followed by 15 numbers). All 17
characters must be entered.

Submitter Claim ID

This ID is applied to a claim by the provider’s submission application vendor at the time of
submission.

Payer Claim ID

This ID is assigned to a claim by the payer.

Combining Criteria

Use a separator for effective searching.

Character or Word Used

Result

Space or comma (,)

All claims that include one or more keywords are shown; inclusive search.

Plus symbol (+) or the word
and

The resulting search is exclusive. That is, only those claims are shown that match ALL the
search criteria.

The word or

The resulting search shows all those claims that match at least one of the criteria. That is,
if Jones and Louie are the keywords, claims for Jones and claims for Louie are both shown.
Those claims for Louie Jones are also shown (see below).

Quotes (Y or ™)

Use single or double quotes to search for multiple keywords, as in a name. For example,
to locate claims for an individual named John Adams, place quotes on both ends of the

name: “John Adams”. The benefit of this type of search is that the results are limited to
only those claims that match John Adams; claims that match only John or only Adams are
not shown. (Claims for Lou Adams or John Hancock are not shown.)

Claims with ERA Search

Access this search by selecting Payments > Claims with ERA. Use this search to locate claims that
have ERAs for a specified date or date range. Searches can also be performed on a specific tax ID or site

ID, which are useful if you are part of a large organization.

Click the link in the Claim Received Date column to view the Claim Summary Report.

Claim Received Date Tax ID

1

w3

i1

Search Criteria:

Claim Received Date

12/22/2010 ‘

12/23/2010
12/24/2010
12/27/2010

Home = Claims with ERA > ERA Summary by Day

If no dates are entered, dates will default to last 7 days.

Claim Date Range: 12,

Site ID

o0 [v]

PR_1015
ERA Summary by Day

[22/2010 9, >

Provider Tax ID :

22/2010 - 12/2 < Empty > » SiteID: < Empty =

ERA Received Quantity

oo G

o

Totals:
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When viewing the Claim Detail of a claim that has ERA(s) associated to it, the Additional ID heading in
the Payer Claim Status History section of the Claim Detail includes a check number link.

Home

= Claims with ERA >

ERA Summary by Day =

Claim Summary =

Claim Detail

Claim Received Date Tax ID Site ID
If no dates are entered, dates will default to last 7 days
Emdeon Accept Date 11/15/2010 Payer Accept Date 11/14
Emdeon Reject Date Payer Reject Date
Message Detail
Standard Code Message Error D

Payment Recej

Payer Clai

Additional ID"
00021715

tatus History

Status Date
11/16/2010

Status Description

[Check Number] For payment status, ple)

Click the check number link to view the Payment Detail for the selected check.

Home > Claims with ERA = ERA Summary by Day > Claim Summary > Claim Detail > Payment Detail
Claim Received Date Tax ID Site ID
If no dates are entered, dates will default to last 7 days.
=] 1 /1 @ [ 100% v
PR_1012
Search Criteria: Check Number: 008 » Payer ID: 01
Patient Control  Patient Name Claim Claim Paid  Difference Service Service Receiver ID Transaction ID
Number Charge Amount in Payment From Date Thru Date
& m— f 295.00 183 L 4 L ) ( 3
Totals: $295.00 $183.60 $111.40

File Summary Search

Access this search by selecting Claims > File Summary Search. A successful File Summary search
displays a File Summary Report that provides details on all claim batches submitted to the Emdeon
clearinghouse during the specified (or default) date range. Each claim batch is identified by a File ID
(Emdeon batch identifier). For more information, see ERA Linking in Claim Detail

If your practice has ERA contracts with payers, ERA data is displayed in the “Payer Claim Status History”

under certain conditions.
The claim has associated ERA(S).

Your practice has ERA contract with the payer on the claim.

If an ERA is associated to the claim a generic message is displayed in the Status Description field.

If the claim has been paid (and there is an ERA associated to the claim), the check nhumber is displayed
in the Additional ID’s column. Click the check number to display the Payment Detail report.
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Start Date End Date Tax ID
B S KA 2 /2
Claim Detall

Additional ID's

Payer Claim Status History

Status Date

1 01/06/2010
@ [Check Number] 04/26/2010

Claim Detail

Search Type

Isearch Criteria: Emdeon Claim ID: DK _——"—"—""],

Status Description
Acknowledgement/Acceptance in adjudication system

For payment status, please refer message detail

Payment Detail Report

Emdeon Office Claims User Guide
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If a linked check number is displayed in the Claim Detail Report you can access the Payment Detail
report by clicking the check number.

The Payment Detail report provides key information on the claim (and the payment) including claim
amount and the difference between paid amount and claim amount.

Payer Claim ID in Claim Detail Report

If the payer has received the claim and if the payer issues claim IDs to Emdeon, then the payer’s claim
ID appears in the Payer Claim ID field. However, a blank Payer Claim ID field does not necessarily
mean that the payer has not received the claim.

Payer Claim ID

Claim Status History

Emdeon Received 12/23/2010
Emdeon Accept Date
Emdeon Reject Date 12/23/2010

Claim Detail
Search Criteria: Emdeon Claim ID: FEP122310776533048

Insured ID 108889 Provider Tax ID 04
Patient Name LR R Billing Provider ID 049
Patient DOB Billing Provider NPI 11
Claim Amount $67.00 Site ID 58
Service From 12/17/2010 Patient Control No. 33
Service To 12/17/2010 Payer Name Col

Cal

Payer Acknowledge Date

Payer Accept Date
Payer Reject Date

In the screen shot above, no payer claim ID appears in the Claim Detail report because the claim was

rejected at Emdeon.

Note: While most payers do issue claim IDs upon receipt of a claim (which appear in the Claim
Detail report) some payers do not.

View Audit History

Note: This function, which allows you to view the audit history in a Claim Detail Report, is
different from the Audit History Report which is generated by performing an Audit History search
(see Audit History Report on p. 110).

Click the “View Audit History” link to view the audit history of a claim.
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Home > Work Queue Search > Claim Summary = Claim Detail E
Claim Received Date Tax ID Site ID Search Type )
12/23/2010 12/30/2010 Al v | submit | m
If no dates are entered, dates will default to last 7 days.
o S 1 /1 # [ 100% [v]
PR_1002
Claim Detail
Search Criteria: Emdeon Claim ID: EP122310776593048 View Audit History Get Help with this Claim
Insured ID 1 D Provider Tax ID 042 Claim Received Date 12/23/2010
Patient Name . #raen Billing Provider ID 042 Emdeon File ID EPOC
Patient DOB . Billing Provider NPI 118 Emdeon Claim ID EP12

The following actions are tracked in Audit History:

Click on View Claim button

Click on “Eligibility” link

Click on “Claim Status” link

All "Worked/Unworked” status changes for the last 15 months on the claim are shown with
username and date/time stamp

If the Audit History report is longer than 1,000, rows the report can be exported in Microsoft Excel
format. The export will include all rows including those rows that were not displayed due to the 1,000
row display limit.

When you click the “View Audit History” link, a new window appears. The Audit History window can be
moved in the same manner that the Help window can be moved (click and drag the title bar of the
window).

Home = Claim Summary = Claim Detail

WS [kt /1t # [ 100% [w]
PR_1002
Claim Detail
Search Criteria: Emdeon Claim ID: EP12 View Audit History Get Help with this Claim
Audit History @) X
Insured ID 225 im Received Date 12/27/2010
Patient Name Len, Audit History Report For Claim: EP122710780521153 deon File ID EPODE &
Patient DOB 05/ Username Action Performed Date/Time stamp deon Claim ID EP12
Claim Amount %31 = yer ID SMVAQD
ew Claim Correction View 12/29/2010 08:46:31
Service From 124 rked Status ]
Service To 124 I XWalk Check Claim
Payer Claim ID iely Filing Letter Display Letter

Workers’ Compensation Attachments
Overview

Reporting & Analytics provides you with a convenient and powerful way to manage workers’
compensation claims.

Functionality includes both claim management and the ability to respond directly to payers with
requested attachments. Workers’ Compensation Attachments is available by subscription only from
Reporting & Analytics.

If you have pending workers’ compensation claims, you can easily find those claims and respond to
payer requests for further documentation.

Locate Claims Easily

To locate claims in Reporting & Analytics that the payer requires additional information for, begin the
search by selecting Claims > Work Queue Search.

In the Search Type drop-down list, select “"Requires Attachment”. Enter your Tax ID or Site ID for a
more specific search (both fields are optional).
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Home > Work Queue Search @ Help
Claim Received Date Tax ID Site ID Search Type =
[ps/oe/2010 | [ps/07/2010 [ ] | Al M m
All
If no dates are entered, dates will default to last 7 days. Accepted
Rejected-All
Rejected-Un-Worked

All claims that match the selected search criteria for which the payer on workers’ compensation claim(s)
has requested additional documentation are shown.

Payer Allowed Response Period

On workers’ compensation claims that require attachments, payers provide a 15-day response period,
during which time the provider can upload files and send them to the payer. If the provider does not
respond within the 15-day response period, the claim is rejected and no longer appears in the Work
Queue Search > “"Requires Attachment” search results report.

Access Attachments Functionality

In the Claim Summary report, click the highlighted Emdeon Claim ID to show the Claim Detail report
for the selected claim. In the far right column of the Claim Detail report, click the “Claim Attachment”
link to show the workers’ compensation attachments application window.

Home > Work Queue Search > Claim Summary > Claim Detail

Claim Received Date Tax ID Site ID Search Type

[osfo1/zo11 J[1o/17/z011 | | | [ | an - m m

If no dates are entered, dates will default to last 7 days.

& S 1 /1 #® 100 ~
PR_1002

Claim Detall

Search Criteria: Emdeon Claim ID: EP12345DEMO00043 View Audit History Get Help with this Claim
Insured ID 1230 Provider Tax ID 998} Claim Received Date  09/10/2011
Patient Name Erlan___} Billing Provider ID ~ 998d__) Emdeon File ID Ep123F )
Patient DOB 05/03/1993 Billing Provider NPT  1998877PR6 Emdeon Claim ID EP12345D|:
Claim Amount $650.00 Site ID ABCD Payer ID PAYOS
Service From 05/31/2011 Patient Control No. PcNi[___ ] Worked Status
Service To 06/04/2011 5010 Format Mo NPI XWalk XWalk Review
Payer Claim ID Payer Name Timely Filing Letter Display Letter

Attachments Claim Attachment

Workers’ compensation attachments window within Reporting & Analytics:

Print Clos

kct # Total Charges Employer Carrier DOI Service Dates Patient Name Status Date Status Attachments
260 $630.00 RAM TEXAS 01/05/2007 12/04/2009 01/25/2010 PDCO &
MUTUAL 12/04/2009 RAMIREZ WMiew Bill Upload Fax
INSU Commit P
“Attachment Type:| Admission Summary M

Description
Limit 80 Chars

*Attach File:
*Indicates Required Field
(ACN) Date/Time Attachment Type Delivery Method Description Detail
01/27/2010 16:31 CST  Consukttation Report Electronically Only View Remaove
01/27/2010 16:32 CST Certffication Electronically Only View Remove

Click the Upload button at the upper right to show the Upload fields. Click the Upload button directly
beneath the Attach File field for each attachment to add to the bill. After all files are uploaded, click the
“Commit” link to send your bill and files to the payer for review.
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Use the Workers’ Compensation Attachments Interface

1.

2.
3

Click the “Claim Attachment” link in the Claim Detail report. The workers’ compensation claim
attachment window appears.

To view an attachment, click the applicable “View” link. A graphic or PDF viewer appears.

Click the Print button to print a summary view. You can print uploaded files directly from the View
window.

Click Upload in the upper right corner to show the file upload window. Only PDF and TIFF format
files can be uploaded.

Click Browse to locate the file to upload.

Select an attachment type from the Attachment Type drop-down list (required field).

Enter a description of the file (optional field).

Click the Upload button to upload the file. Repeat these four steps for each file to attach to the
claim.

Status conditions:

:__.!Prim X Close
DOI Service Dates Patient Name Status Date Status Attachments
01/05/2007 12/04/2009 01/25/2010 PDCO &
12/04/2009 RAMIREZ View Bill u
- pload Fax
Commit
mary V
red Field
[t |
hment Type Delivery Method Description Detail
Btion Report Electronically Only Wiew Remove
ion Electronically Only View Remove

e PNDA - Pending Attachments. Attachments are pending to be sent to the payer.

e PDCO - Pending Commit. You can add files while bill is in this status. Click the "Commit” link to
send the bill with attachments to the payer for review. Do not click *"Commit” until all of your
files are attached.

e PEND - All attachments and bill documents are ready to be sent to payer. This status occurs
after “"Commit” is clicked. This status is the condition prior to SENT. No action can be taken in
the workers’ compensation claim attachment window while in this status.

e SENT - Bill and attachments sent to payer.

Note: After bill and attachments are sent, the Upload and Fax buttons are removed.

Fax documents so that they are correctly received by the payer.

e If you have paper documents that you want to scan and send to the payer, click Fax.

e Print the fax cover sheet, and then fax all paper documents to the payer (at the fax number
shown on the fax cover sheet) with fax cover sheet as the first document in the communication.
Using the fax cover sheet ensures that your faxed documents are associated to the bill.

You can view or remove uploaded files from the bill prior to clicking "Commit.” Once committed,
uploaded files cannot be removed.

Review the billing image created by clicking the “View Bill” link (located in the Status column in the
upper right of the workers’ compensation attachments window).

Status
PDCO

View Bill
Commit

Click “"Commit” to send uploaded files to payer for review.
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Note: You must click "Commit” to complete the bill/claim submission process. If "Commit” is not
clicked, attached files are not sent to the payer, and the claim will remain in PDCO/Pending
Commitment status.
View and Edit Claim
View and Edit Claims

Viewing and editing claims is a feature you can access through the Claim Detail Report. For details on
how to view and edit claims, see the View and Edit Claims section on page 126.

“Get Help with this Claim” Link

Using the “Get Help with this Claim” link enables you to access Customer Service Alerts (CSAs) and
submit a support ticket for the claim you are viewing.

1. In a Claim Detail report, click the “Get Help with this Claim” link.

Home > Work Queue Search = Claim Summary = Claim Detail
Claim Received Date Tax ID Site ID Search Type
PZEFTIN PETEIT | | g ] —
If no dates are entered, dates will default to last 7 days.
= t s #
PR_1002
Claim Detail
Search Criteria: Emdeon Claim ID: EP122310776533048 View Audit History Get Help with this Claim
Insured ID 1066838 Provider Tax ID D428 55k 8 Claim Received Date 12/23/2010
Patient Name Fram b, aliss Billing Provider ID 0424855843 Emdeon File ID EPOC v

2. The “Claim Support” message window appears.
Two links may be available:

e Customer Alerts link - If there are recent (last 30 days) Customer Service Alerts (CSAs) on the
claim from the payer, a link to the CSA will appear. Hover your cursor over the CSA to view a
short description. Click the link to view the CSA.

s Our records indicate that vour claims are being submitted through a software
vendor who has selected Emdeon as the electronic clearinghouse, or some
other means not directly supported by Emdeon.

* & search has been performed, and there are recent service alerts relating to the
payer on this daim, which is #ifadbuea®yare, Please click here to view
them.

¢ If the alert information does not resolve your issue, please contact your
saoftware vendar for further assistance with this claim.

e Service Request link - This link appears for all claims in Reporting & Analytics. Click the link to
create a service request for the claim you are viewing.

+ A search has been performed, and there are no recent service alerts relating
to the payer on this claim, which is

* Please click here to have the claim reviewed by a service representative

3. If you click the service request link, the Create Service Request form appears. The form is pre-
populated with key details from the claim.
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ON 24/7 SEARCH (-) emdeon

— - —e

= SERVICE REQUESTS
Create
View

= SELF HELP TOOLS
Error Code Search
FAQ

Create Service Request

Claim Details From Emdeon Vision

= PROJECTS Claim ID Number: DKODOSSOFF BCEdb4 Claim Amount: $650.00
Implementations Insured ID: 12345 KA Patient Name:

= COMMUNICATIONS Service From Date: 5/31/2010 Payer Name: LR RS
Most Recent Service To Date: 5/31/2010 Payer ID: PAYEE
Detailed Search Submitter ID: 22348 Claim Tax Id: 343434 e

Map Search

Preferences
= REFERENCES
Payer Lists

. = = . e
Payer Fact Sheets What type of issues are you having with this claim?

= ON24/7 " Claim Rejection
What's New " Claim Missing at Payer
Coming Soon ' Other
Technical Support ol

Workers Comp Claim Attachment

Click the option that describes the issue you are having with the claim, and then click Continue.
Enter identifying information on the pages that follow, clicking Continue at the bottom of each
page. You will be able to review the information you entered before you submit the service request.
6. If you would like to change the information you entered, click Start Over.

vie

Note: Clicking Start Over does not erase the claim information that was present when you
created the service request.

7. Click Submit.

8. The Confirmation window appears, where you can choose from several options or close the window
by clicking OK.

Your service request has been entered successfully.

Please reference service request number 1-565316636 in any communications with
customer support regarding this issue.

If you need to provide additional information to Emdeon via FAX, please click on the
following link to create a cover sheet and fax to 615.238.0949. Create Cover Sheet

If you wish to provide supporting attachments, please click on the following link to
include supporting files.
Upload Attachment(s)

Flag this case as parent Flag this case as child

To manage your service requests, click the Online Support link in Emdeon Office to
return to this site. Then choose View under Service Requests from the menu on the
left of the screen.

e Service request reference number - Click to access details on the service request: view the
request history, add a comment, add files, flag, etc.

¢ Create Cover Sheet - If you need to fax documents to Emdeon relating to the service request,
click this link to open a fax cover sheet. The cover sheet is pre-populated with information that
will associate the fax with the service request. Print the cover sheet and use it as the first page
of the fax you send to Emdeon regarding the service request.

¢ Upload Attachments - Click to upload any standard file type up to 50 MB. You can upload only
one file at a time.

 Flag this case as parent - If you need to link cases with related issues, click to set the service
request as a parent in relation to one or more service requests. Use the search function to locate
a service request, select the check box next to the service request, and then click Save. This will
create a hierarchical linkage.

e Flag this case as child - If you need to link cases with related issues, click to set the service
request as a child in relation to another service request. Use the search function to locate a
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service request, select the check box next to the service request, and then click Save. This will
create a hierarchical linkage.

Claim Summary Report
The Claim Summary Report can be generated from several areas within Reporting & Analytics:

e Run a Work Queue search for any claim status.
e Click a link in the Claim Received Date column on the Summary by Payer by Day report.
e Run a Rejection Since Last Login search.
e Click a link in the File ID column of the File Summary report.
e Run a Quick search.
e Click on a pie chart slice, graph bar, or graph data point in the Dashboard view.
Home > Work Queue Search = Claim Summary E @ uelp
Start Date End Date Tax ID Site ID Search Type
01/01/2010 05/03/2010 Al ~
S [ bt /1+ # | 100% [
Claim Summary PR-1008
Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty = » Provider Tax ID: < Empty = » Site ID: < Empty =
Claim Status: Any » Worked Status: = Empty = » Emdeon File ID: < Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date Amount D
Emdeon-Rejected
Site ID: LMNO
File ID: EP123Deiewiain &8
Ye TE TE 09/15/2008  $750.00 PAYO1 EP00000D
Admission Sourc
File ID:
Yes TE TE 09/04/2009  $66.00 AYD2 EP000DOLY,
pal Procedure Date: Invalid; Must be less than or equal to Statement Period Thru Date

Claim Summary Column Headings

Heading

Description

Worked

“Worked” progress status; determined by the “Worked” check box in the Claim
Detail report

Patient Name

Name of the patient submitted on the claim

Insured ID

Insured ID submitted on the claim

Patient Control Number

Provider’s control/tracking number for patient on claim

Service From Date

Date of service

Claim Amount

Dollar amount (in US dollars) of the submitted claim

Payer ID

Payer ID submitted on the claim

Payer Name

Payer name submitted on the claim

Emdeon Claim ID

Claim ID assigned by Emdeon for the specific claim

Claim Summary Report List Order

Emdeon Rejected - Claims rejected by Emdeon

Payer Rejected - Claims rejected by the payer

Emdeon Accepted - Claims accepted by Emdeon but no notification from the payer received
Accepted - Claims accepted by payer and the claim is pending adjudication

pPE

Note: File ID is the second level of sorting That is, the first level is one of the four levels listed
above, the second level sort is by File ID (File ID: includes both Site ID and Emdeon Batch File
number, where applicable.)

Layered sorting of Claim Summary results:
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</

Claim Summary

Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 > Payer ID: < Empty =
Claim Status: Any » Worked Status: = Empty >
Worked Patient Name Insured ID Patient Control Service Claim
Number From Date Amount

Emdeon-Rejected

Site ID: LMNO
File ID: EP123Deaimrasi s &
Yes Patientlastnms, TE TE 09/15/2009 $750.00
Patientfirstnm06
Message
Admission Source Code: Invalid; Must be a valid code for Admission Type Code
File ID: EP123DWiersiag s
ERA Summary by Day Report
This report is generated from the Claims with ERA search.
Home = Claims with ERA = ERA Summary by Day |:
Claim Received Date Tax ID Site ID
[fz72272010 J[t2/2s/2010 | | ] [ | m
If no dates are entered, dates will default to last 7 days.
P 5 r i #
PR_1016
ERA Summary by Day
Search Criteria: Claim Date Range: 12/22/2010 - 12/25/2010 B Provider Tax ID: < Empty = > Site ID : < Empty >
Claim Received Date ERA Received Quantity
12/22/2010 433
12/23/2010 170
12/24/2010 58
12/27/2010 1
Totals: 663

Click a link in the Claim Received Date column to view the Claim Summary Report for all claims with

ERAs for the date listed, and then click the Emdeon Claim ID link to view the Claim Detail Report for that
claim.

File Summary Report

The File Summary Report provides details on all claim batches submitted to the Emdeon clearinghouse
during a specific date range. Each claim batch is identified by a File ID (Emdeon batch identifier).

Home = File Summary Search = File Summary @ uelp
Start Date End Date Tax ID Site ID
s ] sy ]| I |

@S N2 /1| # [ 100% [v]

PR_1010

Search Criteria: Claim Date Range: 2/27/2010 - 3/2/2010 Provider Tax ID: < Empty > Site ID: = Empty =

Claim Received File ID Received Claim Emdeon Reject Payer Reject Claim Amount

Date Quantity Quantity Quantity

2/27/2010 EP123DLMsile 2 0 o $69.00

2/28/2010 EP123 Dol 3 1 o $356.00

3/1/2010 EP123D i 4 2 1 $1,440.00

3/2/2010 EP123 DG 3 1 o $189.30

Totals: 12 4 1 $2,054.30
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File Summary Column Headings

Heading

Description

Claim Received Date

Date claim was received by Emdeon

File ID

File ID assigned by Emdeon for the electronic file in which the claim was submitted

Received Claim Quantity

Total number of claims received by Emdeon

Emdeon Reject Quantity

Number of claims rejected by Emdeon

Payer Reject Quantity

Number of claims rejected by the payer

Claim Amount

Total dollar amount of all claims received (total dollar amount for total number of

claims shown in the Received Claim Quantity column)

Insured Detail Report
The Insured Detail Report is displayed when you run a Patient Search.
This report provides a list of all claims for the specified patient for the date range specified in the Claim
Date Range field.
Run a Patient Search with Insured ID

When you use Insured ID as search criteria in Patient Search the Insured Detail report displays a list of
all claims for all patients (the insured party and their dependents) that are covered under the specified
Insured ID (Subscriber ID) for the stated date range.

Home > Patient Search > Insured Detal

Select Date Type | Received Date |
Search By | Insured ID

@ S 1

i1

Search Criteria:

Claim Received Patient Name
Date

Claim Date Range: 1/1/2010 -

Patient Last Name:

Ell @ Hep
Start Date |01/01/201 End Date |05/03/2010
=
] *Insured IDTESTSUEBMEMID]|
# [ 100% [v]
PR_1001
Insured Detail
5/3/2010 » Patient Control ID: =< Empty > » Insured ID: TESTSUBMEMIDL
< Empty = » Patient DOB: < Empty >
Patient Control Service Claim Claim Payer ID Emdeon Claim ID Emdeon
No. From Date Amount Status File ID
TESTPCNOL EP0000OC
TESTPCNOZ PAYD1 EP0000OC EP123C
TESTPCNOZ Emdeon-Accepted  payD1 EPO00OOD EP123D

Click the highlighted “Emdeon

Claim ID” to view Claim Detail report for the selected claim.

Insured Detail Column Headings

Heading

Description

Claim Received Date

Date claim was received by Emdeon or payer

Patient Name

Name of the patient submitted on the claim

Patient Control No.

Insured ID submitted on the claim

Service From Date

Date of service submitted on the claim

Claim Amount

Dollar amount of the submitted claim

Claim Status Current claim status with Emdeon or payer
Payer ID Payer ID submitted on the claim
Payer Name Payer Name submitted on the claim

Emdeon Claim ID

Claim ID assigned by Emdeon for the specific claim

Emdeon File ID

File ID assigned by Emdeon for the electronic file in which the claim was submitted
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The Payment Summary Report displays when you perform a Patient Pay Search and search by
transaction date. It shows patient payments made through Patient Pay Online for a specified date range
and worked status. Click the date link in the Transaction Date column to display a Patient Payment

Summary by Day Report for the date you selected.

Home = Patient Pay Search > Payment Summary

Transaction Date

1/2011 06/23/2011

Search Type
T
If no dates are entered, dates will default to last 7 d
@ S e # [100% [~

S.

Payment Summary

Search Criteria: Transaction Date Range: 3/1/2011 - 6/23/2011 »Worked Status: ALL

Transaction Date Quantity Amount

06/20/2011 3
06/15/2011 1
06/11/2011 1
06/08/2011 1
06/07/2011 2
05/30/2011 4
05/27/2011 1
05/26/2011 1

Bl @ Hep

PR_1013

Payment Summary Report Column Headings

Heading Description

Transaction Date
Day Report for the date you selected.

Date that the payment was made. Click the link to view the Payment Summary by

Quantity

Number of payments made on the specified transaction date.

Amount

Total amount of all payments made on the specified transaction date.

Patient Payment Summary by Day Report

The Patient Payment Summary by Day Report displays when you perform a Patient Pay Search and
search by patient name or patient account number as well as when you click a transaction date link on

the Payment Summary Report.

Search by Patient Name or Patient Account Number

When you perform a Patient Pay Search and search by patient name or patient account nhumber, the
report will show the same patient name or patient account humber for the transaction date range you

selected.

Home = Patient Pay Search = Payment Summary By Day

Search B _ Transaction Date *Patient Name
Enter at least 3 consecutive characters. If no dates are entered, dates will default to last 7 days.
B S 1 /1 # [ 100% [s]

Patient Payment Summary By Day

Search Criteria: Transaction Date Range: 1/3/2011 - 6/23/2011 » Patient Name : dan

Worked Transaction Service Patient Name Patient Account Payment Receipt Payment
Date Date Number Amount Number Method

05/30/2011 DARIEL ORDUS DAOMDEZE $ 20.00 7376477 MasterCard

05/30/2011 DANIEL OMDUS DAONDE3ZE $ 20.00 7375833 MasterCard

PR_1014

Check Number
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Click a Transaction Date Link

When you click a transaction date link on the Payment Summary Report, the Patient Payment Summary
by Day Report shows payments for all patient names and patient account numbers for the transaction
date range you selected.

Home > Patient Pay Search > Payment Summary > Payment Summary By Day E @ Help
| T T o Ceumit | neset |
If no dates are entered, dates will default to last 7 days.
=] 1 | i
PR_1014

Patient Payment Summary By Day

Search Criteria: Transaction Date Range: 5/30/2011 - 5/30/2011 » Worked Status : ALL

Worked E;z:sattinn gn;;:i(e Patient Name zzt':inetrjh(tuunt P:vr/"rgﬁ:g ﬁzﬁﬂp‘;tr ;Zgrl::]%nt Check Number

MOAH B.WALKER MASLKT 253 7376469 Visa

MARABETH TERRELL MTERROS27 7376303 visa

JACKIE WEBSTER MNEBSTZ45 $ 20.00 7376477 MasterCard

JACKIE WEBSTER SNERST 245 $ 20.00 7375833 MasterCard

Patient Payment Summary by Day Report Column Headings

Heading Description

Worked If there is a check in the check box, the payment is worked. If there is not a check
in the check box, the payment is un-worked.

Transaction Date Date that the payment was made

Service Date Reserved for future use

Patient Name If\lame of the patient who received the healthcare treatment the payment was made

or

Patient Account Number Provider account number for the patient

Payment Amount Amount included in payment

Receipt Number Unique receipt number of the transaction. Click the link to view the Payment Detail
report for the specified payment.

Payment Method Type of card used in the payment (Visa, MasterCard, Discover, or American
Express)

Check Number Reserved for future use

Payment Detail Report

The Payment Detail Report displays when you click a date link in the Receipt Number column on the
Patient Payment Summary by Day Report. The report shows the payment and transaction details for the
transaction you selected.
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Search Type

If no dates are entered, dates will default to last 7 days.
@ S s m.
Payment Detail
Search Criteria: Transaction Date : 5/30/2011 P Receipt Number : 7375469

Payment Details Transaction Details

NO&H B WALKER

Patient Name Transaction Date/Time

MAALKT 253

WHSIE4SK245K33

E @ Help

PR_1015

Patient Account No
Service Date
Payment Amount
Payment Method
Check Number
Money Order No

Worked

$135.03

Visa

Transaction 1D

Authorization Code

Receipt No

Open Date

Close Date

Guarantor Name

Guarantor Account

647380
7376469

5/30/2011 11:26:14AM

MOAH B WALKER

MALKT253

Payment Detail Report Rows

Heading

Description

Payment Details Column

Patient Name

Name of the patient

Patient Account No

Provider account number for the patient

Service Date

Reserved for future use

Payment Amount

Amount of the payment

Payment Method

Type of card used in the payment

Check Number

Reserved for future use

Money Order No

Reserved for future use

Worked

If there is a check in the check box, the payment is worked. If there is not a check
in the check box, the payment is un-worked.

Transaction Details Column

Transaction Date/Time

Date and time of the payment

Transaction ID

Unique transaction identifier (assigned by system)

Authorization Code

Card authorization code (assigned by system)

Receipt No Unique receipt number (assigned by system)
Open Date Date and time the transaction started
Close Date Reserved for future use

Guarantor Name

Name of the person making payment

Guarantor Account

Account number of the person making payment

Summary by Payer Report

The Summary by Payer Report is displayed when you perform a Payer Search without specifying a Payer
ID. The report includes a claim summary for each payer (sorted by Payer ID).
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Home = Payer Search = Summary by Payer E ® welp
Start Date End Date Tax ID Site ID Payer ID
01/01/2010 05/03/2010
B T s I
PR_1004

Summary by Payer

Search Criteria: Claim Date Range: 1/1/2010 - 5/3/2010

Payer ID Payer Name Received Emdeon Reject Emdeon Paper Claim Payer Reject Payer Claim Amount
Claim Quantity Quantity Reject % Quantity Quantity Reject %
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Totals: 45 11 0 ] $18,834.09

Summary by Payer Column Headings

Heading Description

Payer ID 5-character alphanumeric string; ID number of payers that had claims received by
Emdeon during the specified date range. Click the highlighted date link to view the
Summary by Payer by Day report for the selected Payer ID.

Payer Name Name of payer organization

Received Claim Quantity Total number of claims received by Emdeon.

Number of claims received by Emdeon during the specified date range from the
payer. Click the link in the Payer ID field to view details of these claims in the
Summary by Payer by Day report.

Emdeon Reject Quantity Number of claims rejected by Emdeon from the number received

Emdeon Reject % Percentage of claims rejected by Emdeon

Paper Claim Quantity Number of claims printed to paper by Emdeon

Payer Reject Quantity Number of rejected claims from among those received by Emdeon during the

specified date range that were rejected by the payer specified in the Payer
ID/Payer Name fields.

Payer Reject % Percentage of those claims received by Emdeon that were rejected by the payer.

Claim Amount Total amount (in US dollars) of all claims received by Emdeon for the report row.
This amount includes any rejected claim amounts. The Claim Amount displayed is
the totality of all Emdeon claims received from the payer for the specified date
range.

Summary by Payer by Day Report
The Summary by Payer by Day report can be generated in two ways:

e Perform a Payer Search with a specified Payer ID
e Click on a Payer ID link in a Summary by Payer report

The Summary by Payer by Day report displays a summary of claims for the specified Payer ID. Each row
in the report shows the total quantity of claims received by the payer for the displayed date for that row.
The amount in the Claim Amount column is the total amount in US dollars of claims (including rejected
amounts) received on the specified Claim Received Date for the specified payer ID.
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Home = Payer Search B @ welp
Start Date End Date Tax ID Site ID Payer ID
b1/01/2010 05/03/2010 PAYOL | submit |
@ = 1 /1 (# | 100% v User Preference Report
PR_1005

Summary by Payer by Day

Search Criteria: Claim Date Range: 1/1/2010 - 5/3/2010 » Payer ID: PAYOL

Claim Received Received Claim Emdecn Reject Emdeon Paper Claim Payer Reject Payer Claim Amount
Date Quantity Quantity Reject % Quantity Quantity Reject %

01/25/2010 2 0 0% 0 0 0%
02/01/2010 S 0 0% 0 1 33%
02/08/2010 2 1 50% 0 i} 0%
02/26/2010 1

02/27/2010

Totals: 9 1 0 1 $3,125.00

Summary by Payer by Day Column Headings

Heading Description

Claim Received Date This report displays a summary of all those claims received on the specific date
shown per report row (per specified payer). Click the highlighted date to view
details for each claim received on the claim received date. That is, if the number
displayed in the Claim Received Date column is 12, then 12 claims are displayed
in the resulting report.

Received Claim Quantity Number of claims that were received on the Claim Received Date.
Note: When you click the Claim Received Date link those claims that are specified
in the Received Claim Quantity field are displayed.

Emdeon Reject Quantity Number of claims (from those that were received on the claim received date) that
were rejected by Emdeon

Emdeon Reject % Percentage of claims (from those that were received on the claim received date)
that were rejected by Emdeon

Paper Claim Quantity Number of claims received in paper format (rather than electronically) from among
those claims in the Claim Received Date number.

Payer Reject Quantity Number of claims rejected by the specified payer from among those claims in the
Claim Received Date number.

Payer Reject % Percentage of claims rejected by the specified payer from among those claims in
the Claim Received Date number.

Claim Amount Total amount in US dollars of claims (including rejected amounts) received on the
specified Claim Received Date for the specified payer ID.

on page 143.

File Summary Search Tips

Use the (optional) “Tax ID” filter to refine your search so that only those claim batches that contain
claims for the specified Tax ID are displayed.

e Tax ID format is 9-character numeric string.

Use the (optional) “Site ID” filter to refine your search so that only those claim batches that contain
claims relating to the specified Site ID are displayed.

e Site ID must be a 4-character string (alpha and/or numeric).

You can also enter both optional criteria.

Patient Pay Search

Access this search by selecting Payments > Patient Pay Search. Use the Patient Pay Search to
display a report that shows all patient payments made through Patient Pay Online for a specified date
range.
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@ Note: The Patient Pay Search is available to all Reporting & Analytics users, but the search will
only yield results if your account is set up for the Patient Pay Online service.

Patient Pay Online

Patient Pay Online is a self-service, patient-facing application that provides comprehensive and secure
online billing and payment management for healthcare bills. If your practice is set up for this online
payment portal, when patients receive a healthcare bill from your practice, they can go to the web
address displayed on the bill and make a secure payment with the type of cards your practice accepts. If
you want the ability to collect patient payments online, contact Emdeon sales at 1-866-369-8805.

Launch a Patient Pay Search

You can search by transaction date, patient name, or patient account number.
Search by Transaction Date

If you want to search by transaction date, select “"Transaction Date” in the Search By list, select a date
range, and then select the search type. The search type choices are All, Un-Worked, and Worked. This
search generates a Payment Summary Report (page 153) for the date range you selected.

Home = Patient Pay Search E 3 Help
Search By _ Transaction Date Search Type

Transaction Date b All Rd

If no dates are entered, dates will default to last 7 days.

Search by Patient Name

If you want to search by patient name, select “Patient Name” in the Search By list, select the date
range, and then enter part or all of the patient’s name (at least three characters). This search generates
a Patient Payment Summary by Day Report (page 153) for the patient name and date range you
selected.

Home = Patient Pay Search

2 @ Help

Search By Transaction Date *patient Name

Patient Name W Reset

Enter at least 3 consecutive characters. If no dates are entered, dates will default to last 7 days.

Search by Patient Account Number

If you want to search by patient account number, select “Patient Account Number” in the Search By list,
select the date range, and then enter the patient’s account number. This search generates a Patient
Payment Summary by Day Report (page 153) for the patient account number and date range you
selected.

Home = Patient Pay Search

E| @ Help

Search By _ Transaction Date *patient Account Number

Patient Account Number v

If no dates are entered, dates will default to last 7 days.

= =N

Patient Search

Access this search by selecting Claims > Patient Search. Use the following search criteria to generate
a report that lists all patient claims for a specified (or default) date range.

Use the Search Date Type list:

e Received Date
e Date of Service

Use the Search By list:

e Insured ID
e Patient Control Number (PCN)
e Patient Last Name with optional Patient DOB (Date of Birth).
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e Partial last name is allowed though at least 3 consecutive characters required. For example,
“Smi” will return not only those patients with the last name of “"Smith”, but also “"Smithson”,
“Smithfield”, etc.

e Patient DOB is optional and must be in mm/dd/yyyy format. The Patient DOB data field displays
only when “Patient Last Name” is your selection in the Search By drop-down list.

Home = Patient Search E 3 Help
Select Date Type | Recsived Dats | Claim Received Date m m
Search By | Insured 1D ] *Insured ID
If no dates are entered, dates will default to last 7 days.

Note that optional Patient DOB field is not displayed.

Home > Patient Search m & Help

Claim Received Date

T *Patient Last -
il Name Patient DOB

Select Date Type |R

N BN

Search By [iF;

1f no dates are entered, dates will default to last 7 days.

Patient DOB (optional field) displays only when “Patient Last Name” is selected in the Search By list.

Search Using Last Name Results
A successful Patient Last Name search displays the Insured Detail Report and includes a list of all claims
for the specified patient (PCN) or patients.

Search Using Insured ID Results

A successful Insured ID search displays the Insured Detail Report and includes a list of all claims for the
primary insured party and all dependents under the Insured ID (subscriber ID) number.

For more information, see Claim Summary Report
The Claim Summary Report can be generated from several areas within Reporting & Analytics:

¢ Run a Work Queue search for any claim status.

e Click a link in the Claim Received Date column on the Summary by Payer by Day report.

e Run a Rejection Since Last Login search.

e Click a link in the File ID column of the File Summary report.

e Run a Quick search.

e Click on a pie chart slice, graph bar, or graph data point in the Dashboard view.
Home = Work Queue Search > Claim Summary m 3 Help
Start Date End Date Tax ID Site ID Search Type
01/01/2010 05/03/2010 All v
o S [ bt [ 1+ (# | 100% ||

Claim Summary PR-1008
Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty = » Provider Tax ID: < Empty = » Site ID: < Empty =
Claim Status: Any » Worked Status: = Empty = » Emdeon File ID: < Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date Amount D
Emdeon-Rejected
Site ID: LMNO
File ID: EP123Desieewiain & 8
TE TH 09/1 $£750.00 PAYO1 EF00000D
Admi Source Code: Invalid; Must be a valid code for Admission Type Code
File ID: EP123Diesasig %
Yes P 11 TE TE 09/04/2009 $66.00 PAY0D2 EPDOODOCE,
Principal Procedure Date: Invalid; Must be less than or equal to Statement Period Thru Date

Claim Summary Column Headings

Heading Description
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Heading Description
Worked “Worked” progress status; determined by the “Worked” check box in the Claim

Detail report

Patient Name

Name of the patient submitted on the claim

Insured ID Insured ID submitted on the claim

Patient Control Number

Provider’s control/tracking number for patient on claim

Service From Date Date of service

Claim Amount

Dollar amount (in US dollars) of the submitted claim

Payer ID Payer ID submitted on the claim

Payer Name Payer name submitted on the claim

Emdeon Claim ID

Claim ID assigned by Emdeon for the specific claim

Claim Summary Report List Order

Emdeon Rejected - Claims rejected by Emdeon
Payer Rejected - Claims rejected by the payer

PN W

Emdeon Accepted - Claims accepted by Emdeon but no notification from the payer received
Accepted - Claims accepted by payer and the claim is pending adjudication

Note: File ID is the second level of sorting That is, the first level is one of the four levels listed
above, the second level sort is by File ID (File ID: includes both Site ID and Emdeon Batch File

number, where applicable.)

Layered sorting of Claim Summary results:

Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty
Claim Status: Any » Worked Status: = Empty =
Worked Patient Name Insured ID Patient Control Service Claim
Number From Date Amount
Emdeon-Rejected
Site ID: LMNO
File ID: EP123Deimmeieloh b §
Yes PatientlastnmO6, TE TE 09/15/2009 £750.00
FatientfirstnmO6
Message
Admission Source Code: Invalid; Must be a valid code for Admission Type Code
File ID: EP123 Dl s
ERA Summary by Day Report
This report is generated from the Claims with ERA search.
Home = Claims with ERA = ERA Summary by Day I:
Claim Received Date Tax ID Site ID
12/22/2010 |[12/29/2010 | | | m
If no dates are enterad, dates will default to last 7 days.
o L "
PR_1015
ERA Summary by Day
Search Criteria: Claim Date Range: 12/ 12/29/201C P Provider Tax ID: = Empty = > Site ID : < Empty =

Claim Received Date

12/22/2010 43
12/23/2010 17
12/24/2010 59
12/27/2010 1

Totals:
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Click a link in the Claim Received Date column to view the Claim Summary Report for all claims with
ERAs for the date listed, and then click the Emdeon Claim ID link to view the Claim Detail Report for that

claim.

File Summary Report

The File Summary Report provides details on all claim batches submitted to the Emdeon clearinghouse
during a specific date range. Each claim batch is identified by a File ID (Emdeon batch identifier).

Home > File Summary Search > File Summary

@ e

Start Date End Date Tax ID Site ID
=] 1 /1 # | 100%
PR_1010
File Summary
Search Criteria: Claim Date Range: 2/27/2010 - 3/2/2010 Provider Tax ID: < Empty = Site ID: < Empty =
Claim Received File ID Received Claim Emdeon Reject Payer Reject Claim Amount
Date Quantity Quantity Quantity
EP123D} 2 0 o $69.00
EP123 D 3 1 o $356.00
EP123D 4 2 1 $1,440.00
EP123 Dt 3 1 o $189.30
Totals: 12 4 1 $2,054.30
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File Summary Column Headings

Heading Description

Claim Received Date Date claim was received by Emdeon

File ID File ID assigned by Emdeon for the electronic file in which the claim was submitted

Received Claim Quantity Total number of claims received by Emdeon

Emdeon Reject Quantity Number of claims rejected by Emdeon

Payer Reject Quantity Number of claims rejected by the payer

Claim Amount Total dollar amount of all claims received (total dollar amount for total number of
claims shown in the Received Claim Quantity column)

Insured Detail Report on page 149.

Payer Search

Access this search by selecting Claims > Payer Search. Use the Payer Search to display a report that
includes all claims for a specified (or default) date range.

4 Note: The Payer ID must be a 5 character alphanumeric string.

Home = Payer Search E D Help

= k=N

Claim Received Date Tax ID Site ID Payer ID

If no dates are entered, dates will default to last 7 days.

Search Without a Payer ID Results

A successful Payer Search without a Payer ID results in the Summary by Payer Report. For more
information, see Export and Print Reports

Export allows you to export a report; several file formats are available including Excel. Print allows you
to print a report by opening the report in Adobe Viewer.

Note: Your browser must allow pop-up windows in order to use the Print or Export features.

Export a Report

Export enables you to export a report from Reporting & Analytics and save it in a different format, such
as Microsoft Word or Excel.

1. Click the Export icon.

o S 1 /1 ) | 100% |w|

2. Select the export format from the File Format list.
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‘€ Export Report - Windows Internet Explorer E]
File Format: Adobe Acrobat (POF)
Crystal Reports (RPT)
iAdobe Acrobat (PDF)

Microzoft Excel $7-2000 (XLS)
Microsoft Excel $7-2000 - Data Only (XLS)
Microzoft Word (RTF)
Microzoft Word - Editable (RTF)
Page Range: Rich Text Format (RTF)

O Pages:

From: To:

QK Cancel

3. All pages will be exported unless you specify a page range. If you do not want to export the entire
document, click the Pages option, and then enter a page range.

4. Click OK. The File Download window appears.

5. Click Save.

6. Select the target location for the file, and change the name to a more descriptive filename.
7. Click Save.

Print a Report
The Print Report function allows you to select print options prior to printing a report.
1. Click the Print icon.

& 1 /1 # | 100% ||

2. All pages will print unless you specify a page range. If you do not want to print the entire document,
click the Pages option, and then enter a page range.

‘€ Print Report - Windows Internet Explorer E]
Page Range: @ an
OPages:
From: |1 To: |1

To Print:

1. In the next dialog that appears, select the "Open this file” option and click
the OK button.

2. Click the printer icon on the Acrobat Reader Menu rather than the print
button on your internet browser.

0K Cancel

Click OK.

The File Download window appears. Click Open.

The report opens in Adobe Reader (or the PDF reader that is set as the default viewer on your
computer).

6. Click the Print icon from the Adobe Reader window, or select File > Print.

nhw

Audit History Report

Note: This report, generated by performing an Audit History search, is different from viewing the
audit history in a Claim Detail Report (see View Audit History on page 113).

Data displayed in the Audit History report is sorted by Date/Time Stamp in descending order, with the
most recent event at the top of the table.
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¢ Username
Reporting & Analytics user ID of the user who made the change described in the table row.

Note: The Reporting & Analytics user ID is typically the same or very similar to the Emdeon
Office user ID.

e Action Performed
One of two possible actions is displayed in this field.

¢ Marked claim as Worked: Specified user changed claim status to Worked.
e Marked claim as Unworked: Specified user changed claim status to Unworked.
e Date/Time Stamp

Date and time of action.
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¢ Emdeon Claim ID

Specific Emdeon Claim ID (Claim Original Reference Number) of claim.

Note: This column is not displayed if a specific Emdeon Claim ID was used in search criteria.

on page 139.

Search With a Payer ID Results

A successful Payer Search with a Payer ID results in the Summary by Payer by Day Report. For more
information, see Summary by Payer by Day Report on page 156.
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Rejection Since Last Login Search

Access this search by selecting Claims > Rejection Since Last Login. This search displays a Claim
Summary report of all claims that have been rejected since you last accessed Reporting & Analytics.

L

Note: There are no search criteria associated with this report. Click Submit to run the search.

Work Queue Search

Access this search by selecting Claims > Work Queue Search. Use this search to locate claims based
on their "“Worked” status. Use the Search Type list to select the claim status to be searched.

Home = Work Queue Search

E @ Help

Claim Received Date Tax ID Site ID Search Type

co/oe/2010 ] [ps/o772010 I > Co ) ey

If no dates are entered, dates will default to last 7 days.

Search Types - Accepted, Rejected, Requires Attachment

If you select “"Rejected” status, the following additional criteria are available. Only one of the following
can be selected:

All

Accepted

Rejected - All
Rejected - Un-Worked
Rejected - Worked
Requires Attachment

Search Criteria Formats

e “Tax ID” - 9-digit numeric string
e “Site ID” - 4-digit string (alpha and/or numeric)

“Requires Attachment” Search

All claims with status “Requires Attachment” that match all other entered search criteria for the specified
date range are displayed. Claims that “require attachments” are those claims to which the payer has
requested supporting documents be added.

Work Queue Search Results
e “Accepted”

Displays only claims with an “Accepted” status.
° \\A”II

Displays all claims regardless of accepted/rejected status.
e “Rejected” ("Worked” or “Un-worked”)

Displays all claims that are currently identified with the selected status condition.
" 4 Note: For more information on how to change the status of a claim from "“Un-Worked” to
"Worked” please see Descriptions and functions of key user fields in the Claim Detail section
are presented below.

Worked Status Indicator on page 142.
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Reports

Report Screen Layout

@3 1 i # [100% [v]

PR_1010
File Summary

Search Criteria: Claim Date Range: 2/11/2010 - 5/3/2010 Provider Tax ID: < Empty = Site ID: < Empty =

Search criteria used
to generate the report

Claim Received File ID Received Claim Emdeon Reject Payer Reject Claim Amount

Date Quantity Quantity Quantity
Report
EP123Dg
EP123D;
EP123Dg

Detail Links

Most reports include links that provide access to additional reports. Links are shown as underlined, dark
blue text.

[

Note: Some reports are only accessed via links and are not accessible directly from the search
screen.

Search Results

Searches and their resulting reports are shown in the following table. The “+” symbol in the Report
Result column below indicates that further reports are available via links.

Search Report Result
Type >
Search
Option
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Search
Type >
Search
Option

Report Result

Audit
History
Search

Export and Print Reports
Export allows you to export a report; several file formats are available including
Excel. Print allows you to print a report by opening the report in Adobe Viewer.

Note: Your browser must allow pop-up windows in order to use the Print or
Export features.
Export a Report

Export enables you to export a report from Reporting & Analytics and save it in a
different format, such as Microsoft Word or Excel.

7. Click the Export icon.

@ 3 t
8. Select the export format from the File Format list.
=)

Adobe Acrobat (PDF)
Crystal Reports (RPT)

/1 # | 100% |w|

= Export Report - Windows Internet Explorer

File Format:

Microzoft Excel $7-2000 (XLS)

Microzoft Excel $7-2000 - Data Only (XLS)
Microzoft Word (RTF)

Wicresoft Word - Editable (RTF)

Rich Text Format (RTF)

O Pages:

From: To:

Page Range:

QK Cancel

9. All pages will be exported unless you specify a page range. If you do not want to
export the entire document, click the Pages option, and then enter a page
range.

10. Click OK. The File Download window appears.

11. Click Save.

12. Select the target location for the file, and change the name to a more descriptive
filename.

13. Click Save.

Print a Report

The Print Report function allows you to select print options prior to printing a
report.

14. Click the Print icon.

= 1

15. All pages will print unless you specify a page range. If you do not want to print
the entire document, click the Pages option, and then enter a page range.

1

# | 100% [+

‘€ Print Report - Windows Internet Explorer E]
Page Range: ® an
OPages:
From: |1 To: |1
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Claim
Quick
Search

Claim Summary Report
v

Claim Detail Report
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Search
Type >
Search
Option

Report Result

Claims
with ERA
Search

Export and Print Reports
Export allows you to export a report; several file formats are available including Excel. Print allows you to print a
report by opening the report in Adobe Viewer.

Note: Your browser must allow pop-up windows in order to use the Print or
Export features.
Export a Report

Export enables you to export a report from Reporting & Analytics and save it in a
different format, such as Microsoft Word or Excel.

20. Click the Export icon.

& S 1 /1 # | 100% [+
21. Select the export format from the File Format list.
‘€ Export Report - Windows Internet Explorer E]
File Format: Adobe Acrobat (POF)

Crystal Reports (RPT)

=0ft Excel §7-2000 (XLS)

Microzoft Excel $7-2000 - Data Only (XLS)
Microzoft Word (RTF)

Microzoft Word - Editable (RTF)

Rich Text Format (RTF)

O Pages:

From: To:

Page Range:

QK Cancel

22. All pages will be exported unless you specify a page range. If you do not want to
export the entire document, click the Pages option, and then enter a page
range.

23. Click OK. The File Download window appears.

24. Click Save.

25. Select the target location for the file, and change the name to a more descriptive
filename.

26. Click Save.

Print a Report

The Print Report function allows you to select print options prior to printing a
report.

27. Click the Print icon.

W S 1 /1

# | 100% [+

28. All pages will print unless you specify a page range. If you do not want to print
the entire document, click the Pages option, and then enter a page range.

To Print:

‘€ Print Report - Windows Internet Explorer E]
Page Range: ® an
OPages:
From: |1 To: |1

1. In the next dialog that appears, select the "0Open thiz file” option and click
the OK button.
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Search
Type >
Search
Option

Report Result

Dashboard
Search

e Claim
Status
Summary
(pie chart)
e Payers
with
Largest
Rejection
Dollar
Amounts
(bar
graph)

e Claim
Charge
Amount
(line
graph)
For more
informatio
n, see
Accessin
g Claim
Detail
through
Dashboar
d Views
on page
101.

Claim Summary Report
¥
Claim Detail Report

File
Summary
Search

Claim Summary Report
¥

Claim Detail Report

Patient
Pay
Search >
View all
patient
payments
made
through
Patient
Pay Online
for a date
range

Payment Summary Report
¥
Patient Payment Summary by Day Report
v

Payment Detail Report

Patient
Pay
Search >
View all
patient
payments
made
through
Patient
Pay Online
for a
patient
name or
patient
account
number

Patient Payment Summary by Day Report
2

Payment Detail Report

Page 134




-

(

J emdeon

Emdeon Office Claims User Guide
Reporting & Analytics

Search Report Result

Type >
Search
Option
Patient Claim Summary Report
Search > X ey .
View all The Claim Summary Report can be generated from several areas within Reporting &
claims for Analytics:
a specific ]
insured e Run a Work Queue search for any claim status.
party and e Click a link in the Claim Received Date column on the Summary by Payer by
dependent
s (by Day report.
Insured ¢ Run a Rejection Since Last Login search.
ID) e Click a link in the File ID column of the File Summary report.
e Run a Quick search.
e Click on a pie chart slice, graph bar, or graph data point in the Dashboard view.
Home = Work Queue Search > Claim Summary E 3 Help
Start Date End Date Tax ID Site ID Search Type
p1/01/2010 05/03/2010 All ] | submit | m
WS (SR /1+ % [100% [
Claim Summary FR-1008
Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty = B Provider Tax ID: < Empty = > Site ID: < Empty =
Claim Status: Any » Worked Status: < Empty = » Emdeon File ID: < Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date Amount I
Emdeon-Rejected
Site ID: LMNO
File ID: EP123Diimesiaig s 4
Yes TE TE 09/15/2009 $750.00 PAY0O1 EP0000OD:
Source Code: Invalid; Must be a valid code for Admission Type Code
EP123Duiesatiig i
TE TE 09/04/2009 $66.00 PAY02 EP0D0DOCE,
rincipal Procedure Date: Invalid; Must be less than or equal to Statement Period Thru Date
Claim Summary Column Headings
Heading Description
Worked “Worked"” progress status; determined by the “Worked” check box in the
Detail report
Patient Name Name of the patient submitted on the claim
Insured ID Insured ID submitted on the claim
Patient Control Number Provider’s control/tracking number for patient on claim
Service From Date Date of service
Claim Amount Dollar amount (in US dollars) of the submitted claim
Payer ID Payer ID submitted on the claim
Payer Name Payer name submitted on the claim
Emdeon Claim ID Claim ID assigned by Emdeon for the specific claim

Claim Summary Report List Order

33. Emdeon Rejected - Claims rejected by Emdeon

34. Payer Rejected - Claims rejected by the payer

35. Emdeon Accepted - Claims accepted by Emdeon but no notification from the
payer received

36. Accepted - Claims accepted by payer and the claim is pending adjudication

Note: File ID is the second level of sorting That is, the first level is one of the
four levels listed above, the second level sort is by File ID (File ID: includes
both Site ID and Emdeon Batch File number, where applicable.)

Layered sorting of Claim Summary results: Page 135
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Search
Type >
Search
Option

Report Result

Patient
Search >
Locate all
claims for
a specific
PCN

Claim Summary Report

The Claim Summary Report can be generated from several areas within Reporting &
Analytics:

¢ Run a Work Queue search for any claim status.
e Click a link in the Claim Received Date column on the Summary by Payer by
Day report.

¢ Run a Rejection Since Last Login search.
e Click a link in the File ID column of the File Summary report.
e Run a Quick search.
e Click on a pie chart slice, graph bar, or graph data point in the Dashboard view.
Home = Work Queue Search > Claim Summary E 3 Help
Start Date End Date Tax ID Site ID Search Type
p1/01/2010 05/03/2010 All ] | submit | m
WS (SR 71+ % [100% [
Claim Summary FR-1008
Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty = B Provider Tax ID: < Empty = > Site ID: < Empty =
Claim Status: Any » Worked Status: < Empty = » Emdeon File ID: < Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date Amount D
Emdeon-Rejected
Site ID: LMNO
File ID: EP123Diimesiaig s 4
Yes TE TE 09/15/2009 $750.00 PAY0O1 EP0000OD:
Source Code: Invalid; Must be a valid code for Admission Type Code
EP123Dwimsesiuind %
TE TE 09/04/2009 $66.00 PAY02 EP0D0DOCE,
rincipal Procedure Date: Invalid; Must be less than or equal to Statement Period Thru Date
Claim Summary Column Headings
Heading Description
Worked “Worked"” progress status; determined by the “Worked” check box in the
Detail report
Patient Name Name of the patient submitted on the claim
Insured ID Insured ID submitted on the claim
Patient Control Number Provider’s control/tracking number for patient on claim
Service From Date Date of service
Claim Amount Dollar amount (in US dollars) of the submitted claim
Payer ID Payer ID submitted on the claim
Payer Name Payer name submitted on the claim
Emdeon Claim ID Claim ID assigned by Emdeon for the specific claim

Claim Summary Report List Order

37. Emdeon Rejected - Claims rejected by Emdeon

38. Payer Rejected - Claims rejected by the payer

39. Emdeon Accepted - Claims accepted by Emdeon but no notification from the
payer received

40. Accepted - Claims accepted by payer and the claim is pending adjudication

Note: File ID is the second level of sorting That is, the first level is one of the
four levels listed above, the second level sort is by File ID (File ID: includes
both Site ID and Emdeon Batch File number, where applicable.)

Layered sorting of Claim Summary results: Page 136

| Claim Summarv |




-

Emdeon Office Claims User Guide

( J emdeOI’T Reporting & Analytics

Search
Type >
Search
Option

Report Result

Patient
Search >
Locate all
claims for
a specific
patient

Claim Summary Report

The Claim Summary Report can be generated from several areas within Reporting &
Analytics:

e Run a Work Queue search for any claim status.
e Click a link in the Claim Received Date column on the Summary by Payer by
Day report.

¢ Run a Rejection Since Last Login search.
e Click a link in the File ID column of the File Summary report.
e Run a Quick search.
e Click on a pie chart slice, graph bar, or graph data point in the Dashboard view.
Home = Work Queue Search > Claim Summary E 3 Help
Start Date End Date Tax ID Site ID Search Type
p1/01/2010 05/03/2010 All ] | submit | m
WS (SR 71+ % [100% [
Claim Summary FR-1008
Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty = B Provider Tax ID: < Empty = > Site ID: < Empty =
Claim Status: Any » Worked Status: < Empty = » Emdeon File ID: < Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date Amount D
Emdeon-Rejected
Site ID: LMNO
File ID: EP123Diimesiaig s 4
Yes P TE TE 09/15/2009 $750.00 PAY0O1 EP0000OD:
Source Code: Invalid; Must be a valid code for Admission Type Code
EP123Dwimsesiuind %
TE TE 09/04/2009 $66.00 PAY02 EP0D0DOCE,
rincipal Procedure Date: Invalid; Must be less than or equal to Statement Period Thru Date
Claim Summary Column Headings
Heading Description
Worked “Worked"” progress status; determined by the “Worked” check box in the
Detail report
Patient Name Name of the patient submitted on the claim
Insured ID Insured ID submitted on the claim
Patient Control Number Provider’s control/tracking number for patient on claim
Service From Date Date of service
Claim Amount Dollar amount (in US dollars) of the submitted claim
Payer ID Payer ID submitted on the claim
Payer Name Payer name submitted on the claim
Emdeon Claim ID Claim ID assigned by Emdeon for the specific claim

Claim Summary Report List Order

41. Emdeon Rejected - Claims rejected by Emdeon

42. Payer Rejected - Claims rejected by the payer

43. Emdeon Accepted - Claims accepted by Emdeon but no notification from the
payer received

44, Accepted - Claims accepted by payer and the claim is pending adjudication

Note: File ID is the second level of sorting That is, the first level is one of the
four levels listed above, the second level sort is by File ID (File ID: includes
both Site ID and Emdeon Batch File number, where applicable.)

Layered sorting of Claim Summary results: Page 137
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Report Result

Payer
Search >
Display a
summary
of all
claims

The Payment Summary Report displays when you perform a Patient Pay Search and search by transaction date. It
shows patient payments made through Patient Pay Online for a specified date range and worked status. Click the
date link in the Transaction Date column to display a Patient Payment Summary by Day Report for the date you

Payment Summary Report

selected.

Home = Patient Pay Search > Payment Summary

El| @ Help

Search Type

If no dates are entered, dates will default to last 7 days.

P b W[ i 0 o0 o]

PR_1013
Payment Summary

»Worked Status: ALL

Search Criteria: Transaction Date Range: 3/1/2011 - 6/23/2011

Transaction Date Quantity Amount

06/20/2011 3
06/15/2011 1
06/11/2011 1
06/08/2011 1
06/07/2011 2
05/30/2011 4
05/27/2011 1
05/26/2011 1

Payment Summary Report Column Headings

Heading

Description

Transaction Date

Date that the payment was made. Click the link to view the Payment Sun
Day Report for the date you selected.

Quantity

Number of payments made on the specified transaction date.

Amount

Total amount of all payments made on the specified transaction date.

Patient Payment Summary by Day Report

The Patient Payment Summary by Day Report displays when you perform a Patient
Pay Search and search by patient name or patient account humber as well as when
you click a transaction date link on the Payment Summary Report.

Search by Patient Name or Patient Account Number

When you perform a Patient Pay Search and search by patient name or patient
account number, the report will show the same patient name or patient account
number for the transaction date range you selected.

Home = Patient Pay Search > Payment Summary By Day

Search B Transaction Date *Patient Name
Enter at least 3 consecutive characters. If no dates are entered, dates will default to last 7 days.
53 r i #

Patient Payment Summary By Day

Search Criteria: Transaction Date Range: 1/3/2011 - 6/23/2011 » Patient Name : dan

Worked Transaction Service Patient Name Patient Account Payment Receipt Payment Check Number
Date Number Amount Number Method

05/30/2011 DARIEL ORDUS DAOMNDE3E $ 20.00 7376477 MasterCard

05/30/2011 DAMNEL CHNDUS DACNDOZE $ 20.00 7375833 MasterCard

PR_1014

Click a Transaction Date Link Page 138

When you click a transaction date link on the Payment Summary Report, the Patient



'\ Emdeon Office Claims User Guide
( J emdeOﬂ” Reporting & Analytics

Search Report Result
Type >
Search
Option

Payer Summary by Payer by Day Report
Search > v

Display a Claim Summary Report
summary v

of all Claim Detail Report
claims for
a specific
payer

Rejection Claim Summary Report
Since Last +

Login Claim Detail Report
Search

Work Claim Summary Report
Queue (sorted by status)
Search > v

Display a Claim Detail Report
summary
of all
claims for
a specific
status

Work Claim Summary Report
Queue (for specified sub-status)
Search > v

Display a Claim Detail Report
summary
of all
claims for
“Rejected”
claims
with either
“Worked”
or “Un-
Worked”
sub-status

Export and Print Reports

Export allows you to export a report; several file formats are available including Excel. Print allows you
to print a report by opening the report in Adobe Viewer.

Note: Your browser must allow pop-up windows in order to use the Print or Export features.

Export a Report

Export enables you to export a report from Reporting & Analytics and save it in a different format, such
as Microsoft Word or Excel.

45. Click the Export icon.

o< 1 /1 # | 100% v |

46. Select the export format from the File Format list.
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‘€ Export Report - Windows Internet Explorer E]
File Format: Adobe Acrobat (POF)
Crystal Reports (RPT)
iAdobe Acrobat (PDF)

Microzoft Excel $7-2000 (XLS)

Microsoft Excel $7-2000 - Data Only (XLS)
Microzoft Word (RTF)

Microzoft Word - Editable (RTF)

Page Range: Rich Text Format (RTF)
O Pages:
From: To:
QK Cancel

47. All pages will be exported unless you specify a page range. If you do not want to export the entire
document, click the Pages option, and then enter a page range.

48. Click OK. The File Download window appears.

49, Click Save.

50. Select the target location for the file, and change the name to a more descriptive filename.

51. Click Save.

Print a Report
The Print Report function allows you to select print options prior to printing a report.
52. Click the Print icon.

o S<— 1 /1 ) | 100% [+

53. All pages will print unless you specify a page range. If you do not want to print the entire document,
click the Pages option, and then enter a page range.

‘€ Print Report - Windows Internet Explorer E]
Page Range: @ an
OPages:
From: |1 To: |1

To Print:

1. In the next dialog that appears, select the "Open this file” option and click
the OK button.

2. Click the printer icon on the Acrobat Reader Menu rather than the print
button on your internet browser.

0K Cancel

54. Click OK.

55. The File Download window appears. Click Open.

56. The report opens in Adobe Reader (or the PDF reader that is set as the default viewer on your
computer).

57. Click the Print icon from the Adobe Reader window, or select File > Print.

Audit History Report
@

Note: This report, generated by performing an Audit History search, is different from viewing the
audit history in a Claim Detail Report (see View Audit History on page 144).

Data displayed in the Audit History report is sorted by Date/Time Stamp in descending order, with the
most recent event at the top of the table.
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¢ Username
Reporting & Analytics user ID of the user who made the change described in the table row.

" 4 Note: The Reporting & Analytics user ID is typically the same or very similar to the Emdeon
Office user ID.

e Action Performed
One of two possible actions is displayed in this field.

¢ Marked claim as Worked: Specified user changed claim status to Worked.
e Marked claim as Unworked: Specified user changed claim status to Unworked.
e Date/Time Stamp

Date and time of action.
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¢ Emdeon Claim ID

Specific Emdeon Claim ID (Claim Original Reference Number) of claim.

4 Note: This column is not displayed if a specific Emdeon Claim ID was used in search criteria.

Claim Detail Report
You can access a Claim Detail Report in two ways.

e In an Insured Detail Report, click a link in the Claim Received Date column.
e In a Claim Summary Report, click a link in the Emdeon Claim ID column.

Home > Work Queuve Search > Claim Summary > Claim Detail

Claim Received Date Tax ID Site ID Search Type

[os/ot/z011 [io/1i7/z011 | | | [ | an - m m

If no dates are entered, dates will default to last 7 days.

@S 1 /1 #® 100 -
PR_1002

Claim Detalil

Search Criteria: Emdeon Claim ID: EP12345DEMO00048 View Audit History Get Help with this Claim
Insured ID 123 Provider Tax ID gos | Claim Received Date  09/10/2011
Patient Name 3 — Billing Provider ID 998}, Emdeon File ID Ep123FIL]
Patient DOB 05/03/1993 Billing Provider NPT  1998877PR6 Emdeon Claim ID EP123450|:
Claim Amount $650.00 Site ID ABCD Payer ID PAYQS
Service From 05/31/2011 Patient Control No. PcN1[_____ ) Worked Status
Service To 06/04/2011 5010 Format Mo NPI XWalk HWalk Review
Payer Claim ID Payer Name Timely Filing Letter Display Letter

Claim Status History

Emdeon Received 09/10/2011 Payer Acknowledge Date
Emdeon Accept Date Payer Accept Date
Emdeon Reject Date 09/10/2011 Payer Reject Date

Message Detall

Standard Code Message Error Data Error Code Source

1625 Occurrence Date: Invalid; Must be greater thanor 40158 Emdeon
equal to Patient Date of Birth when Occurrence Code is
equal to 01-06 or 11

Payer Claim Status History

Additional ID's Status Date Status Description

Page 1

1/1
Descriptions and functions of key user fields in the Claim Detail section are presented below.
Worked Status Indicator

Use the “"Worked Status” check box to mark a claim as “worked.”

When the “Worked” check box is checked the claim is shown as “worked” on the Claim Summary Report.
To search for “worked” claims, use the “All” or “"Rejected/All” criteria in “Work Queue” search.
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@ Note: The definition of “worked” is practice (or site) specific. Please be sure that all Reporting &
Analytics users in your organization have a clear understanding of how your practice/site uses
the “"worked” feature.

NPI XWalk

If your site has registered for the Emdeon NPI X-Walk service, the report shows if a match was found in
the Emdeon Enrollment Database to perform the X-Walk, and whether the crosswalk was executed
successfully. If executed successfully, the Provider NPI is inserted into the correct segment of the 837
file prior to submission to the payer. To view this information, click the “Check Claim” link.

Timely Filing Letter

Click “Display Letter” to view the Request for Claim Review Letter. The resulting screen is a printable
letter that a provider can send to a payer to support assertions of proper and timely claim filing by the
provider. If you are a provider you can print this letter, enter the appropriate information, attach any
pertinent supporting documentation then send the letter (with attachments) to the payer.

ERA Linking in Claim Detail

If your practice has ERA contracts with payers, ERA data is displayed in the “Payer Claim Status History”
under certain conditions.

The claim has associated ERA(S).
Your practice has ERA contract with the payer on the claim.
If an ERA is associated to the claim a generic message is displayed in the Status Description field.

If the claim has been paid (and there is an ERA associated to the claim), the check number is displayed
in the Additional ID’s column. Click the check number to display the Payment Detail report.

Home Work Queue Search Claim Summary Claim Detail

Start Date End Date Tax ID Site ID Search Type
01/01/2010 04/29/2010 A v m m
= LR 2 /2 i [ 100% [
Claim Detail
Isearch Criteria: Emdeon Claim 1D: DK ]

Payer Claim Status History

Additional ID's Status Date Status Description
1 01/06/2010 Acknowledgement/Acceptance in adjudication system
@ [Check Number] 04/26/2010 For payment status, please refer message detail

Payment Detail Report

If a linked check number is displayed in the Claim Detail Report you can access the Payment Detail
report by clicking the check number.

The Payment Detail report provides key information on the claim (and the payment) including claim
amount and the difference between paid amount and claim amount.

Payer Claim ID in Claim Detail Report

If the payer has received the claim and if the payer issues claim IDs to Emdeon, then the payer’s claim
ID appears in the Payer Claim ID field. However, a blank Payer Claim ID field does not necessarily
mean that the payer has not received the claim.
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Claim Detail

Search Criteria: Emdeon Claim ID: EP12231
Insured ID 10688 po Provider Tax ID 04
Patient Name R R Billing Provider ID 044
Patient DOB e Billing Provider NPL 11
Claim Amount $67.00 Site ID 58
Service From 12/17/2010 Patient Control No. 33
Service To 12/17/2010 Payer Name Col
Payer Claim ID -
Claim Status History
Emdeon Received 12/23/2010 Payer Acknowledge Date
Emdeon Accept Date Payer Accept Date
Emdeon Reject Date 12/23/2010 Payer Reject Date

In the screen shot above, no payer claim ID appears in the Claim Detail report because the claim was
rejected at Emdeon.

d Note: While most payers do issue claim IDs upon receipt of a claim (which appear in the Claim
Detail report) some payers do not.

View Audit History
¢ Note: This function, which allows you to view the audit history in a Claim Detail Report, is
different from the Audit History Report which is generated by performing an Audit History search

(see Audit History Report on p. 140).

Click the “View Audit History” link to view the audit history of a claim.

Home > Work Queue Search > Claim Summary = Claim Detail E
Claim Received Date Tax ID Site ID Search Type
12/23/2010 12/30/2010 | submit | m
If no dates are entered, dates will default to last 7 days.
=] 1 |/ i
PR_1002
Claim Detail
Search Criteria: Emdeon Claim ID: EP122310776593048 View Audit History Get Help with this Claim
Insured ID 1 D Provider Tax ID 042 Claim Received Da 12/23/2010
Patient Name s o Billing Provider ID 042 Emdeon File ID EPOC
Patient DOB o Billing Provider NPT 118 Emdeon Claim ID EP12

The following actions are tracked in Audit History:

Click on View Claim button

Click on “Eligibility” link

Click on “Claim Status” link

All "Worked/Unworked” status changes for the last 15 months on the claim are shown with
username and date/time stamp

If the Audit History report is longer than 1,000, rows the report can be exported in Microsoft Excel
format. The export will include all rows including those rows that were not displayed due to the 1,000
row display limit.

When you click the “View Audit History” link, a new window appears. The Audit History window can be
moved in the same manner that the Help window can be moved (click and drag the title bar of the
window).
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PR_1002

12/27/2010

( ) emdeon
Home = Claim Summary = Claim Detail
o S b M1 J1+ # [ 100% [w]
Search Criteria: Emdeon Claim ID: EP12 View Audit History Get Help with this Claim
Audit History <@> X
Insured ID 225 im Received Date
Patient Name Len! Audit History Report For Claim: EP122710780521153 deon File ID

Patient DOB 05/ Username Action Performed Date/Time stamp deon Claim ID

Claim Amount 531 = ver ID

ew Claim Correction View 12/29/2010 08:46:31
Service From 12/ rked Status
Service To 12/ I XWalk

Payer Claim ID iely Filing Letter

Workers’ Compensation Attachments

Overview

EPOD- &

EP12

SMVAQD

O

Check Claim
Display Letter

Reporting & Analytics provides you with a convenient and powerful way to manage workers’

compensation claims.

Functionality includes both claim management and the ability to respond directly to payers with
requested attachments. Workers’ Compensation Attachments is available by subscription only from

Reporting & Analytics.

If you have pending workers’ compensation claims, you can easily find those claims and respond to

payer requests for further documentation.

Locate Claims Easily

To locate claims in Reporting & Analytics that the payer requires additional information for, begin the

search by selecting Claims > Work Queue Search.

In the Search Type drop-down list, select “Requires Attachment”. Enter your Tax ID or Site ID for a

more specific search (both fields are optional).

Home > Work Queue Search

Claim Received Date Tax ID Site ID

09/06/2010 09/07/2010

Search Type

If no dates are entered, dates will default to last 7 days.

E @ Hep

All claims that match the selected search criteria for which the payer on workers’ compensation claim(s)

has requested additional documentation are shown.

Payer Allowed Response Period

On workers’ compensation claims that require attachments, payers provide a 15-day response period,
during which time the provider can upload files and send them to the payer. If the provider does not
respond within the 15-day response period, the claim is rejected and no longer appears in the Work

Queue Search > “Requires Attachment” search results report.

Access Attachments Functionality

In the Claim Summary report, click the highlighted Emdeon Claim ID to show the Claim Detail report
for the selected claim. In the far right column of the Claim Detail report, click the “Claim Attachment”

link to show the workers’ compensation attachments application window.
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Home > Work Queuve Search = Claim Summary > Claim Detail

Claim Received Date Tax ID Site ID Search Type

[ps/o1/2011 | [to/17/2011 | | | Al - m m

If no dates are entered, dates will default to last 7 days.

= 1 /1 # 100 -
PR_1002

Claim Detall

Search Criteria: Emdeon Claim ID: EP12345DEMO00043 View Audit History Get Help with this Claim
Insured ID 123 Provider Tax ID g8} Claim Received Date  09/10/2011
Patient Name Erlan____} Billing Provider I gos___) Emdeon File ID ep12aF] |
Patient DOB 05/03/1993 Billing Provider NPI  1998877PR6 Emdeon Claim ID EP12345D|:
Claim Amount $650.00 Site ID ABCD Payer ID PAYOS
Service From 05/31/2011 Patient Control No. PcNi____ ] Worked Status
Service To 06/04/2011 5010 Format Mo NPI XWalk XWalk Review
Payer Claim ID Payer Name Timely Filing Letter Display Letter ’

Attachments Claim Attachment

Workers’ compensation attachments window within Reporting & Analytics:

a';Print X Close

kct # Total Charges Employer Carrier DOI Service Dates Patient Name Status Date Status AkMechments
260 $630.00 RAM TEXAS 01/05/2007 12/04/2009 01/25/2010 PDCO [ =
MUTUAL 12/04/2009 RAMIREZ Wiew Bill U

INSU Commit \JPload/ax

“Attachment Type:| Admission Summary M

Description
Limit 80 Chars

*Attach File:
“Indicates Required Field
Uplod
(ACN) Date/Time Delivery Method Description Detail
01/27/2010 16:31 CST Consuttati\gR=nort Electronically Only View Remove
01/27/2010 16:32 CST  Cerffication! Electronically Only View Remaove

Click the Upload button at the upper right to show the Upload fields. Click the Upload button directly
beneath the Attach File field for each attachment to add to the bill. After all files are uploaded, click the
“Commit” link to send your bill and files to the payer for review.

Use the Workers’ Compensation Attachments Interface

58. Click the “Claim Attachment” link in the Claim Detail report. The workers’ compensation claim
attachment window appears.

59. To view an attachment, click the applicable “View” link. A graphic or PDF viewer appears.

60. Click the Print button to print a summary view. You can print uploaded files directly from the View
window.

61. Click Upload in the upper right corner to show the file upload window. Only PDF and TIFF format
files can be uploaded.

Click Browse to locate the file to upload.

Select an attachment type from the Attachment Type drop-down list (required field).

Enter a description of the file (optional field).

Click the Upload button to upload the file. Repeat these four steps for each file to attach to the
claim.

62. Status conditions:
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63.

64.

65.

DOI

01/05/2007 12/04/2009 01/25/2010 FPDCT =
12/04/2009 RAMIREZ m B =

Service Dates Patient Name Status Date Status Attachments

 — Upload Fax

mary

red Field

][ conce |

hment Type Delivery Method Description Detail
ftion Report Electronically Only View Remove
ion

Browse...

Electronically Only Wiew Remove

PNDA - Pending Attachments. Attachments are pending to be sent to the payer.

PDCO - Pending Commit. You can add files while bill is in this status. Click the "Commit” link to
send the bill with attachments to the payer for review. Do not click "Commit” until all of your
files are attached.

PEND - All attachments and bill documents are ready to be sent to payer. This status occurs
after “Commit” is clicked. This status is the condition prior to SENT. No action can be taken in
the workers’ compensation claim attachment window while in this status.

SENT - Bill and attachments sent to payer.

Note: After bill and attachments are sent, the Upload and Fax buttons are removed.

Fax documents so that they are correctly received by the payer.

If you have paper documents that you want to scan and send to the payer, click Fax.

Print the fax cover sheet, and then fax all paper documents to the payer (at the fax number
shown on the fax cover sheet) with fax cover sheet as the first document in the communication.
Using the fax cover sheet ensures that your faxed documents are associated to the bill.

You can view or remove uploaded files from the bill prior to clicking "Commit.” Once committed,

uploaded files cannot be removed.
Review the billing image created by clicking the “View Bill” link (located in the Status column in the

upper right of the workers’ compensation attachments window).

Status
PDCO

View Bill
Commit

66. Click "Commit” to send uploaded files to payer for review.

L

Note: You must click "Commit” to complete the bill/claim submission process. If "Commit” is not
clicked, attached files are not sent to the payer, and the claim will remain in PDCO/Pending
Commitment status.

View and Edit Claim

View and Edit Claims

Viewing and editing claims is a feature you can access through the Claim Detail Report. For details on
how to view and edit claims, see the View and Edit Claims section on page 157.

“Get Help with this Claim” Link

Using the “Get Help with this Claim” link enables you to access Customer Service Alerts (CSAs) and
submit a support ticket for the claim you are viewing.

67. In a Claim Detail report, click the “Get Help with this Claim” link.
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Home = Work Queue Search = Claim Summary > Claim Detail

Claim Received Date Tax ID Site ID Search Type

[t2/23/2010 | [t2/30/2010 ] | [ | Lan [v] Su m

If no dates are entered, dates will default to last 7 days.

@S 1| i

PR_1002

Claim Detall

Search Criteria: Emdeon Claim ID: EP122310776593048 View Audit History Get Help with this Claim
Insured ID 1088800 Provider Tax ID 04285800 Claim Received Date 120/2010
Patient Name Frome s, fllins Billing Provider ID 042855043 Emdeon File ID EP S T

68. The “Claim Support” message window appears.
Two links may be available:

e Customer Alerts link - If there are recent (last 30 days) Customer Service Alerts (CSAs) on the
claim from the payer, a link to the CSA will appear. Hover your cursor over the CSA to view a
short description. Click the link to view the CSA.

s Our records indicate that your claims are being submitted through a software
vendor whao has selected Emdeon as the electronic clearinghouse, or some
other means not directly supported by Emndeon.

e A search has been performed, and there are recent service alerts relating to the
paver on this claim, which is 508 Lssdbae sy e, Please click here to view
therm.

¢ If the alert information does not resolve your issue, please contact your
software vendor for further assistance with this claim,

e Service Request link — This link appears for all claims in Reporting & Analytics. Click the link to
create a service request for the claim you are viewing.

* A search has been performed, and there are no recent service alerts relating
to the payer on this claim, which is

+ Please click here to have the claim reviewed by a service representative

69. If you click the service request link, the Create Service Request form appears. The form is pre-
populated with key details from the claim.

(bN 24/7 SEARCH () emdeon

e J— JRR—

= SERVICE REQUESTS
Create
View

= SELF HELP TOOLS

Error Code Search

Create Service Request

Claim Details From Emdeon Vision

FAQ

= PROJECTS Claim ID Number: DKOOOSSOFFCENbes Claim Amount: $650.00
Implementations Insured ID: 12345HNAAdE Patient Name:

= COMMUNICATIONS Service From Date: 5/31/2010 Payer Name: ninrwe
Most Recent Service To Date: 5/31/2010 Payer ID: PAwEA
Detailed Search Submitter ID: 223 7FY Claim Tax Id: 343458843
Map Search

Preferences
= REFERENCES
Payer Lists
payer Fact Sheets What type of issues are you having with this claim?
= ON24/7 © Claim Rejection
What's New © claim Missing at Payer
Coming Soon  other
-

Technical Support workers Comp Claim Attachment

PREVIOUS N CONTINUE

70. Click the option that describes the issue you are having with the claim, and then click Continue.
71. Enter identifying information on the pages that follow, clicking Continue at the bottom of each

page. You will be able to review the information you entered before you submit the service request.
72. If you would like to change the information you entered, click Start Over.
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Note: Clicking Start Over does not erase the claim information that was present when you
created the service request.

73. Click Submit.

74. The Confirmation window appears, where you can choose from several options or close the window

If you need to prov
following link to create a cover sheet and fax to 615.238.0949. Create Cover Sheet

by clicking OK.

Your service request has been entered successfully.

Please reference service request number 1-565316636 in any communications with
customer support regarding this issue.

de additional information to Emdeon via FAX, please click on the

If you wish to provide supporting attachments, please click on the following link to
include supporting files.

Upload Attachment(s)

Flag this case as parent Flag this case as child

To manage your service requests, click the Online Support link in Emdeon Office to
return to this site. Then choose View under Service Requests from the menu on the
left of the screen.

Service request reference number - Click to access details on the service request: view the
request history, add a comment, add files, flag, etc.

Create Cover Sheet - If you need to fax documents to Emdeon relating to the service request,
click this link to open a fax cover sheet. The cover sheet is pre-populated with information that
will associate the fax with the service request. Print the cover sheet and use it as the first page
of the fax you send to Emdeon regarding the service request.

Upload Attachments - Click to upload any standard file type up to 50 MB. You can upload only
one file at a time.

Flag this case as parent - If you need to link cases with related issues, click to set the service
request as a parent in relation to one or more service requests. Use the search function to locate
a service request, select the check box next to the service request, and then click Save. This will
create a hierarchical linkage.

Flag this case as child - If you need to link cases with related issues, click to set the service
request as a child in relation to another service request. Use the search function to locate a
service request, select the check box next to the service request, and then click Save. This will
create a hierarchical linkage.

Claim Summary Report

The Claim Summary Report can be generated from several areas within Reporting & Analytics:

Run a Work Queue search for any claim status.

Click a link in the Claim Received Date column on the Summary by Payer by Day report.
Run a Rejection Since Last Login search.

Click a link in the File ID column of the File Summary report.

Run a Quick search.

Click on a pie chart slice, graph bar, or graph data point in the Dashboard view.
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Home = Work Queue Search > Claim Summary a Help
Start Date End Date Tax ID Site ID Search Type )
[pr/or/zoi0 | ps/os/zoio | | ] [ NED [+] m
S [ ES f1+ (# [ 100% [w]
- PR_1006
Claim Summary -
Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty = » Provider Tax ID: < Empty = » Site ID: < Empty >
Claim Status: Any » Worked Status: =< Empty = » Emdeon File ID: = Empty =
Worked Patient Name Insured ID Patient Control Service Claim Payer Payer Name Emdeon Claim ID
Number From Date  Amount D

Emdeon-Rejected

Site ID: LMNO
File ID: EP123Deiassiaig b 5
Yes Patientlastnm0§, TE TH 09/15/2009 £750.00 PAY01 EF00000D
Patientfirstnm0s
Message
Admission Source Code: Invalid; Must be a valid code for Admission Type Code
File ID: EP123DuiNsssiaig %
Yes Patientiastnmii, TE TE 09/04/2009  $66.00 PAY02 EPODDDOCK s mgm s,
Patientfirstnm11
Message

Principal Procedure Date: Invalid; Must be less than or equal to Statement Period Thru Date

Claim Summary Column Headings

Heading Description

Worked “Worked” progress status; determined by the “Worked” check box in the Claim
Detail report

Patient Name Name of the patient submitted on the claim

Insured ID Insured ID submitted on the claim

Patient Control Number Provider’s control/tracking number for patient on claim

Service From Date Date of service

Claim Amount Dollar amount (in US dollars) of the submitted claim

Payer ID Payer ID submitted on the claim

Payer Name Payer name submitted on the claim

Emdeon Claim ID Claim ID assigned by Emdeon for the specific claim

Claim Summary Report List Order

75. Emdeon Rejected - Claims rejected by Emdeon

76. Payer Rejected - Claims rejected by the payer

77. Emdeon Accepted - Claims accepted by Emdeon but no notification from the payer received
78. Accepted - Claims accepted by payer and the claim is pending adjudication

d Note: File ID is the second level of sorting That is, the first level is one of the four levels listed
above, the second level sort is by File ID (File ID: includes both Site ID and Emdeon Batch File
number, where applicable.)

Layered sorting of Claim Summary results:

Claim Summary

Search Criteria: Claim Date Range: 1/1/2010-5/3/2010 » Payer ID: < Empty =
Claim Status: Any » Worked Status: = Empty >
Worked Patient Name Insured ID Patient Control Service Claim
Number From Date Amount

— Level 1 sort
—» Level 2 sort

Efndeon-Rejected

Site ID: LMNO
File ID:
Yes Patientlastnms, TE TE 09/15/2009 $750.00
PatientfirstnmO6
Message
Admission Source Code: Invalid; Must be a valid code for Admission Type Code
File ID: EP123Duiresiaieh it
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Home > Claims with ERA = ERA Summary by Day

Claim Received Date Tax ID Site ID

[t2/22/2010__ |[t2/29/2000 | | ] [ |

If no dates are entered, dates will default to last 7 days.

@ 3 i 6 [z00% ]

ERA Summary by Day

PR_1016

Search Criteria: Claim Date Range: 12/22/2010 - 12/25/2010 P Provider Tax ID: = Empty = > Site ID: < Empty =
Claim Received Date ERA Received Quantity
12/22/2010 433
12/23/2010 170
12/24/2010 59
12/27/2010 1
Totals: 663

Click a link in the Claim Received Date column to view the Claim Summary Report for all claims with
ERAs for the date listed, and then click the Emdeon Claim ID link to view the Claim Detail Report for that

claim.

File Summary Report

The File Summary Report provides details on all claim batches submitted to the Emdeon clearinghouse
during a specific date range. Each claim batch is identified by a File ID (Emdeon batch identifier).

Home = File Summary Search > File Summary a Help
Start Date End Date Tax ID Site ID
pz/z7/z010 | ps/oz/zoin | | | [ |

] 1 /1 % | 1005

PR_1010
File Summary

Search Criteria: Claim Date Range: 2/27/2010 - 3/2/2010 Provider Tax ID: < Empty = Site ID: < Empty =

Claim Received File ID Received Claim Emdeon Reject Payer Reject Claim Amount

Date Quantity Quantity Quantity

2/27/2010 EP123Dk N 2 0 o $69.00

2/28/2010 EP12 3 D 3 1 o $356.00

3/1/2010 EP123 Dz =2 4 2 1 $1,440.00

3/2/2010 EP123Dgaiiss 3 1 0 $189.30

Totals: 12 4 1 $2,054.30
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File Summary Column Headings

Heading

Description

Claim Received Date

Date claim was received by Emdeon

File ID

File ID assigned by Emdeon for the electronic file in which the claim was submitted

Received Claim Quantity

Total number of claims received by Emdeon

Emdeon Reject Quantity

Number of claims rejected by Emdeon

Payer Reject Quantity

Number of claims rejected by the payer

Claim Amount

Total dollar amount of all claims received (total dollar amount for total number of

claims shown in the Received Claim Quantity column)

Insured Detail Report
The Insured Detail Report is displayed when you run a Patient Search.
This report provides a list of all claims for the specified patient for the date range specified in the Claim
Date Range field.
Run a Patient Search with Insured ID

When you use Insured ID as search criteria in Patient Search the Insured Detail report displays a list of
all claims for all patients (the insured party and their dependents) that are covered under the specified
Insured ID (Subscriber ID) for the stated date range.

Home > Patient Search > Insured Detal

Select Date Type | Received Date |
Search By | Insured ID

@ S 1

i1

Search Criteria:

Claim Received Patient Name
Date

Claim Date Range: 1/1/2010 -

Patient Last Name:

Ell @ Hep
Start Date |01/01/201 End Date |05/03/2010
=
] *Insured IDTESTSUEBMEMID]|
# [ 100% [v]
PR_1001
Insured Detail
5/3/2010 » Patient Control ID: =< Empty > » Insured ID: TESTSUBMEMIDL
< Empty = » Patient DOB: < Empty >
Patient Control Service Claim Claim Payer ID Emdeon Claim ID Emdeon
No. From Date Amount Status File ID
TESTPCNOL EP0000OC
TESTPCNOZ PAYD1 EP0000OC EP123C
TESTPCNOZ Emdeon-Accepted  payD1 EPO00OOD EP123D

Click the highlighted “Emdeon

Claim ID” to view Claim Detail report for the selected claim.

Insured Detail Column Headings

Heading

Description

Claim Received Date

Date claim was received by Emdeon or payer

Patient Name

Name of the patient submitted on the claim

Patient Control No.

Insured ID submitted on the claim

Service From Date

Date of service submitted on the claim

Claim Amount

Dollar amount of the submitted claim

Claim Status Current claim status with Emdeon or payer
Payer ID Payer ID submitted on the claim
Payer Name Payer Name submitted on the claim

Emdeon Claim ID

Claim ID assigned by Emdeon for the specific claim

Emdeon File ID

File ID assigned by Emdeon for the electronic file in which the claim was submitted
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The Payment Summary Report displays when you perform a Patient Pay Search and search by
transaction date. It shows patient payments made through Patient Pay Online for a specified date range
and worked status. Click the date link in the Transaction Date column to display a Patient Payment

Summary by Day Report for the date you selected.

Home = Patient Pay Search > Payment Summary

Transaction Date

1/2011 06/23/2011

Search Type
T
If no dates are entered, dates will default to last 7 d
@ S e # [100% [~

S.

Payment Summary

Search Criteria: Transaction Date Range: 3/1/2011 - 6/23/2011 »Worked Status: ALL

Transaction Date Quantity Amount

06/20/2011 3
06/15/2011 1
06/11/2011 1
06/08/2011 1
06/07/2011 2
05/30/2011 4
05/27/2011 1
05/26/2011 1

Bl @ Hep

PR_1013

Payment Summary Report Column Headings

Heading Description

Transaction Date
Day Report for the date you selected.

Date that the payment was made. Click the link to view the Payment Summary by

Quantity

Number of payments made on the specified transaction date.

Amount

Total amount of all payments made on the specified transaction date.

Patient Payment Summary by Day Report

The Patient Payment Summary by Day Report displays when you perform a Patient Pay Search and
search by patient name or patient account number as well as when you click a transaction date link on

the Payment Summary Report.

Search by Patient Name or Patient Account Number

When you perform a Patient Pay Search and search by patient name or patient account humber, the
report will show the same patient name or patient account humber for the transaction date range you

selected.

Home = Patient Pay Search = Payment Summary By Day

Search B _ Transaction Date *Patient Name
Enter at least 3 consecutive characters. If no dates are entered, dates will default to last 7 days.
B S 1 /1 # [ 100% [s]

Patient Payment Summary By Day

Search Criteria: Transaction Date Range: 1/3/2011 - 6/23/2011 » Patient Name : dan

Worked Transaction Service Patient Name Patient Account Payment Receipt Payment
Date Date Number Amount Number Method

05/30/2011 DARIEL ORDUS DAOMDEZE $ 20.00 7376477 MasterCard

05/30/2011 DANIEL OMDUS DAONDE3ZE $ 20.00 7375833 MasterCard

PR_1014

Check Number
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Click a Transaction Date Link

When you click a transaction date link on the Payment Summary Report, the Patient Payment Summary
by Day Report shows payments for all patient names and patient account numbers for the transaction
date range you selected.

Home > Patient Pay Search > Payment Summary > Payment Summary By Day E @ Help
| T T o Ceumit | neset |
If no dates are entered, dates will default to last 7 days.
=] 1 | i
PR_1014

Patient Payment Summary By Day

Search Criteria: Transaction Date Range: 5/30/2011 - 5/30/2011 » Worked Status : ALL

Worked E;z:sattinn gn;;:i(e Patient Name zzt':inetrjh(tuunt P:vr/"rgﬁ:g ﬁzﬁﬂp‘;tr ;Zgrl::]%nt Check Number

MOAH B.WALKER MASLKT 253 7376469 Visa

MARABETH TERRELL MTERROS27 7376303 visa

JACKIE WEBSTER MNEBSTZ45 $ 20.00 7376477 MasterCard

JACKIE WEBSTER SNERST 245 $ 20.00 7375833 MasterCard

Patient Payment Summary by Day Report Column Headings

Heading Description

Worked If there is a check in the check box, the payment is worked. If there is not a check
in the check box, the payment is un-worked.

Transaction Date Date that the payment was made

Service Date Reserved for future use

Patient Name If\lame of the patient who received the healthcare treatment the payment was made

or

Patient Account Number Provider account number for the patient

Payment Amount Amount included in payment

Receipt Number Unique receipt number of the transaction. Click the link to view the Payment Detail
report for the specified payment.

Payment Method Type of card used in the payment (Visa, MasterCard, Discover, or American
Express)

Check Number Reserved for future use

Payment Detail Report

The Payment Detail Report displays when you click a date link in the Receipt Number column on the
Patient Payment Summary by Day Report. The report shows the payment and transaction details for the
transaction you selected.
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Search Type

If no dates are entered, dates will default to last 7 days.
@ S s m.
Payment Detail
Search Criteria: Transaction Date : 5/30/2011 P Receipt Number : 7375469

Payment Details Transaction Details

NO&H B WALKER

Patient Name Transaction Date/Time

MAALKT 253

WHSIE4SK245K33

E @ Help

PR_1015

Patient Account No
Service Date
Payment Amount
Payment Method
Check Number
Money Order No

Worked

$135.03

Visa

Transaction 1D

Authorization Code

Receipt No

Open Date

Close Date

Guarantor Name

Guarantor Account

647380
7376469

5/30/2011 11:26:14AM

MOAH B WALKER

MALKT253

Payment Detail Report Rows

Heading

Description

Payment Details Column

Patient Name

Name of the patient

Patient Account No

Provider account number for the patient

Service Date

Reserved for future use

Payment Amount

Amount of the payment

Payment Method

Type of card used in the payment

Check Number

Reserved for future use

Money Order No

Reserved for future use

Worked

If there is a check in the check box, the payment is worked. If there is not a check
in the check box, the payment is un-worked.

Transaction Details Column

Transaction Date/Time

Date and time of the payment

Transaction ID

Unique transaction identifier (assigned by system)

Authorization Code

Card authorization code (assigned by system)

Receipt No Unique receipt number (assigned by system)
Open Date Date and time the transaction started
Close Date Reserved for future use

Guarantor Name

Name of the person making payment

Guarantor Account

Account number of the person making payment

Summary by Payer Report

The Summary by Payer Report is displayed when you perform a Payer Search without specifying a Payer
ID. The report includes a claim summary for each payer (sorted by Payer ID).
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Home = Payer Search = Summary by Payer E ® welp
Start Date End Date Tax ID Site ID Payer ID
01/01/2010 05/03/2010
B T s I
PR_1004

Summary by Payer

Search Criteria: Claim Date Range: 1/1/2010 - 5/3/2010

Payer ID Payer Name Received Emdeon Reject Emdeon Paper Claim Payer Reject Payer Claim Amount
Claim Quantity Quantity Reject % Quantity Quantity Reject %

oo
=
i
tn
B

r 2 EDI Testing - Dummy

r1d

Pap
Pa

o @

o
3
=
=4

o
=
=
3

o
£
=]
=

o
=
=
S
]

BB oW oo oo
:

o
=
=
il
i

Totals: 45 11 0 ] $18,834.09

Summary by Payer Column Headings

Heading Description

Payer ID 5-character alphanumeric string; ID number of payers that had claims received by
Emdeon during the specified date range. Click the highlighted date link to view the
Summary by Payer by Day report for the selected Payer ID.

Payer Name Name of payer organization

Received Claim Quantity Total number of claims received by Emdeon.

Number of claims received by Emdeon during the specified date range from the
payer. Click the link in the Payer ID field to view details of these claims in the
Summary by Payer by Day report.

Emdeon Reject Quantity Number of claims rejected by Emdeon from the number received

Emdeon Reject % Percentage of claims rejected by Emdeon

Paper Claim Quantity Number of claims printed to paper by Emdeon

Payer Reject Quantity Number of rejected claims from among those received by Emdeon during the

specified date range that were rejected by the payer specified in the Payer
ID/Payer Name fields.

Payer Reject % Percentage of those claims received by Emdeon that were rejected by the payer.

Claim Amount Total amount (in US dollars) of all claims received by Emdeon for the report row.
This amount includes any rejected claim amounts. The Claim Amount displayed is
the totality of all Emdeon claims received from the payer for the specified date
range.

Summary by Payer by Day Report
The Summary by Payer by Day report can be generated in two ways:

e Perform a Payer Search with a specified Payer ID
e Click on a Payer ID link in a Summary by Payer report

The Summary by Payer by Day report displays a summary of claims for the specified Payer ID. Each row
in the report shows the total quantity of claims received by the payer for the displayed date for that row.
The amount in the Claim Amount column is the total amount in US dollars of claims (including rejected
amounts) received on the specified Claim Received Date for the specified payer ID.
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Home > Payer Search

Search Criteria:

Claim Received
Date Quantity

01/25/2010
02/01/2010
02/08/2010
02/26/2010 1
02/27/2010 1

Mow R

Tax ID

Received Claim

Claim Date Range: 1/1/2010 - 5/3/2010 » Payer ID: PAYOL

Emdecn Reject
Quantity

oo~ oo

E @ Hep

Site ID Payer ID

(# | 100% v User Preference Report

PR_1005

Summary by Payer by Day

i

Emdeon Claim Amount

Paper Claim
Reject % i

Payer Reject Payer
Quantity i

Quantity Reject %

0%
0%,
50%,

0%,

oo oo o

oo o R

0%

Totals: 9

Summary by Payer by Day Column Headings

Heading

Description

Claim Received Date

This report displays a summary of all those claims received on the specific date
shown per report row (per specified payer). Click the highlighted date to view
details for each claim received on the claim received date. That is, if the number
displayed in the Claim Received Date column is 12, then 12 claims are displayed
in the resulting report.

Received Claim Quantity

Number of claims that were received on the Claim Received Date.
Note: When you click the Claim Received Date link those claims that are specified
in the Received Claim Quantity field are displayed.

Emdeon Reject Quantity

Number of claims (from those that were received on the claim received date) that
were rejected by Emdeon

Emdeon Reject %

Percentage of claims (from those that were received on the claim received date)
that were rejected by Emdeon

Paper Claim Quantity

Number of claims received in paper format (rather than electronically) from among
those claims in the Claim Received Date number.

Payer Reject Quantity

Number of claims rejected by the specified payer from among those claims in the
Claim Received Date number.

Payer Reject %

Percentage of claims rejected by the specified payer from among those claims in
the Claim Received Date number.

Claim Amount

Total amount in US dollars of claims (including rejected amounts) received on the
specified Claim Received Date for the specified payer ID.

Overview

You can correct and refile claims from within Reporting & Analytics. You can review all the fields of a
primary or secondary claim, correct errors that may have caused the claim to be rejected, and re-submit
the updated claim to the payer.

You can also create secondary claims when the primary claim has been partially paid and you want to
obtain payment from an additional payer for unpaid amounts. You can only create a secondary claim

from a primary claim.

Information displayed in the claim editor is always specific to the claim you access in Reporting &

Analytics.
4

Note: Claim viewing and editing may not be available to all Emdeon Office users. If these

services are not available to you, contact customer service for information on how to upgrade

your account.
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View/Edit Permissions

If you can see the View/Edit Claim button, you can view, correct, and refile claims.

PR_1002

Search Criteria: Emdeon Claim ID: EPO71 View Audit History Get Help with this Claim

If you can see the View Claim button, you can only view claims; you cannot correct or refile a claim.
You must upgrade your account to be able to correct and refile claims.

PR_1002

Search Criteria: Emdeon Claim ID: EPOS1 View Audit History Get Help with this Claim

Primary, Secondary, and Tertiary Claims

Primary Claims

You can correct and refile primary claims, and you can create a secondary claim from a primary claim.

Secondary Claims
You can correct and refile secondary claims, and you can create a secondary claim from a primary claim.
A claim is considered a secondary claim when the following conditions are true:
The claim has Claim Adjudication and Claim Line Adjudication tabs (see the
Secondary and Tertiary Claim Tabs section on page 163)

and

The Sequence field is populated with “Secondary” on the Payer/Billing Provider tab in the Payer
Information section.

Tertiary Claims

Currently, you can only correct and refile tertiary claims; you cannot create tertiary claims from
secondary claims. If you click Create Secondary Claim on a secondary claim, this message appears:

Secondary claims can only be created from primary claims. To make changes on secondary or tertiary claims, please click View /Edit.

There is an additional limitation to tertiary claims: there is no indicator that shows whether the payer
information in the Other Insurance tab and the claim adjudication information are from the primary or
secondary claim. You can effectively view and edit only the current destination payer information.

A claim is considered a tertiary claim when the following conditions are true:
The claim has Claim Adjudication and Claim Line Adjudication tabs (see the
Secondary and Tertiary Claim Tabs section on page 163)
and

The Sequence field is populated with “Tertiary” on the Payer/Billing Provider tab in the Payer
Information section.

Limitations

Refile Date

Claims with a Receipt Date prior to 6/01/2010 are not available for viewing or correcting in Reporting &
Analytics. If the claim you are trying to view in Reporting & Analytics has a Receipt Date prior to
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6/01/2010, an error message appears when you click View/Edit Claim, View Claim, or Create
Secondary Claim.

Claim Output Format

Claim viewing and editing is only available if you submit claims in ANSI X12 4010 or NSF+ output
format. Many Emdeon Office users create claims in formats other than ANSI X12 4010 or NSF+ (for
example, NSF2.5), but their accounts are set up so that the claims are converted to ANSI X12 4010 or
NSF+; these users will be able to view and edit claims. If you do not know what the submission format
of your claims is, you can find out by clicking the View/Edit Claim, View Claim, or Create
Secondary Claim buttons on a Claim Detail Report. If a format-related error is displayed—such as
“Only professional claims submitted in the ANSI 837 version 4010 format can be viewed or edited at this

time”—you cannot view or edit claims. If you want to upgrade your claim format, contact customer
service.

Non-Use Timeout

If you have Reporting & Analytics open but do not perform any actions for 15 minutes, your session will
time out and you will lose your changes.

Context-Sensitive Help

A comprehensive, context-sensitive help reference is available for each section on all tabs. Click the
“Help” link in the far right of the section header to open the Help window. Each Help window contains
information specific to that section.

Payer/Billing Provider | Subscriber/Patient || Service Line || Visit || Authorzation || Additional Providers/Faciity | Other Insurance | Errors

CORN ID: EP12345DEMO00037

ubmitter Information

Last /Organization Name. First Name. Middie Name Submitter ID

Contact Name

[maIn sTREET CLINIE | [ ] ——  jp—m [PAM HOWARD

Emat Fax Tetephone
] [ ] [B546378673

Payer Information

Payer 1D Name sequence

[pavos ] [--select--

secondary 1D Claim Office # NAIC Payer Tax ID

Strect Address Line2 city State Tip Code Country Code
] \

To move the Help window, click and drag the header bar of the window.

Contact N — "
Payer/Billing Provider

Submitter Information

Claim submitter information is contained in this ion
_3|esfe review the information in the section and correct any H
arro /hen all sections and tabs are reviewsd, click Re-file B
to re-file the claim
Segquence
Primary

Required Fields
All fields displayed with an asterisk ("*") are required

A highlighted d is required when data is present in 2
related field. (If data is not present in a related field, the
field is otherwise not required and, therefore, not
. highlighted.)
Zip Code ame :
|: ® last/Organization Name

If the submitter is an organization, for
example a practice or network, the name of
the organization appears in this field. In such
cases, the first, and middle name fields are
blank. If the submitter was an individual the
last name of the individual (i.e
provider/billing person) appears in this field

Field-Level Help

Click the “Help” link, and then scroll down to the field name. Field-level help information can include the
following:
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¢ Note - Any pertinent additional information about the field (for example, alternative name,
situational requirements, etc.)

e Loop - Name and location of the ANSI X12 field that will carry this content. The loop and field
names are frequently referenced in rejection and error messages.

e Drop-down list - List and/or description of values in the drop-down list

¢ Range of Allowed Characters in Field - Minimum/maximum number of characters allowed in the

field
e Allowed Character Types - Type of character(s) allowed in the field (for example, letters,
numbers, spaces, etc.)

¢ Required - “Yes” if the field is required; “No” if the field is not required. Situational requirements

are explained if applicable.

Sub-Window Help

If the sub-window that opens when you click a More or More Fields button does not have a “Help” link,

refer to the help from the section that the More or More Fields sub-window was launched from.

Payer/Biling Provider | Subscriber/Patient || Service Line || Visit || Authorization || Additional Provid

ubscriber Information
Entity Type

Last Mame

More Fields

dle N
* Subscriber Information - More Fields —

30 LAMDRY ROAD RMIT]
2000B

O Range of Allowed Characters in Field
Please select from drop-down list

% [m
T e
2 |=
- m
= |®
=3
L
a
4

Patient Information - Not applicable -

0 Required
Patient Account # I

B4745376374644

Last Name

m

B

x

m

e
-
|
i

Street Address d Character Types —

30 LANDRY ROAD " Numbers only RMTT

0 Required
No. unle

field is highlighted

Access Claim Viewing and Editing

Follow these steps to access claim viewing and editing:

-

Select Claims > Reporting & Analytics from the main menu.

2. Search for and open the Claim Detail Report of the claim you want to use. (See the Claim Data
Searches section on page 101 for details on search types.)

3. Click the View/Edit Claim button.

PR_1002

Claim Detalil
Search Criteria: Emdeon Claim ID: EP071 View/ Edit Claim View Audit History Get Help with this Claim

Insured ID 501 508NEE S Provider Tax ID 41200 s Claim Received Date 07/12/2010
Patient Name B an Billing Provider ID 4120 Emdeon File ID EPOQIL S s
Patient DOB e < * Billing Provider NPI Emdeon Claim ID EPO71: VS ASE
Claim Amount $112.50 Site ID 3475 Payer ID
Service From 01/22/2010 Patient Control No. baleatl el Worked Status
Service To 01/22/2010 Payer Name Medica NPI XWalk XWalk Review
Payer Claim ID Timely Filing Letter Display Letter

4. The claim opens in a new window, with the Errors tab selected.
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Payer/Biling Provider || Subscriber/Patient || Service Line || Visit

Rejected Error Message(s)
Standard Error Code Standard Error Message

Payer/Billing Provider

Paver Information

Payer Mame is required.

Invalid Payer 1D.

EBilling Provider Information

MPI should contain only digits.

[Tax |0 must be 9 digits and may contain one dash.
ISubscriber/Patient

Subscriber Information.

jGroup/Policy # may contain letters, numbers, dashes, periods, spaces, asterisks and ampersands.

Authorization Additional Providers/Faciity || Other Insurance || Errors

Navigation

Tabs and Sections

Main Tabs

There are eight main tabs. Each tab is a component of the claim form. Tabs are organized into sections,
and some tabs have sub-windows with additional tabs. You can view a new tab at any time by clicking

the tab at the top of the window.

Payer/Billing Provider || Subscriber/Patient || Service Line

Visit || Authorization || Additional Providers/Facility || Other Insurance || Errors

Before you submit a claim, you must make all of the required changes on every tab. The changes you
make on one tab will be retained when you click another tab, but there is no way to save the claim as a
work in progress if you close the claim editor window or allow your session to time out.

d Note: If you close the main window without clicking Refile or Submit, all of your changes will

be lost.

The following is a list of the main tabs and their sections:

Payer/Billing Provider

Submitter Information

[ ]

e Payer Information

e Billing Provider Information
e Pay-To Provider
Subscriber/Patient

e Subscriber Information
e More Fields — Subscriber Information
e Patient Information

e More Fields - Patient Information

Service Line

e Diagnosis Codes
e Claim Line Information

¢ More - see

e Service Line Tab’s Claim Line More Button section on page 162
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Visit
Occurrence Date and Details
Ambulance Information

[ ]
[ ]
e Spinal Manipulation Services
e Vision Services

Authorization

e Release Information
e Reference Information

Additional Providers/Facility

Facility/Location Information
Rendering Provider
Referring Provider
Supervising Provider
Purchased Service Provider

Other Insurance

e Other Subscriber
e Other Payer Release
e Other Payer

Errors

e Rejected Error Message(s)
e Validation Errors

Service Line Tab’s Claim Line More Button

The Service Line tab includes a More button for each claim line.

Payer/Biling Provider || Subscriber/Patient || Service Line || Visit || Authorization || Additional Providers/Faciity || Other Insurance || Clim Adjudication || Errors

Mote:

ked * are required.

ser on the highlighted fields to see the error.

Diagnosis Codes

Diagnosis Codes

1[ga210 | 2[111 | 3 | 4] |
5| |6 7| K] |
¥ ¢ [/01/20097 [11/01/2009F [Ofice v[no vlpozez | [T RICICIL] feo 1 [s000.00 [--setect--[w] [-setect--[w
= 3 [t/01/20097 [11/01/2009 % [Ofice v[ho vlposrz | [T RICICICT o 1 [2670.00 [--setect-[w] [-setect-- v ’
T o3 | Fa | [ -select-  [se] ~setect—-[w | IO IO | | | —select-- | v | [~setect--[w
= 4 | | --Select-- W[ --Select-- |» | DDDD DDDD | I I --Select-- s | [--Setect-- s
Display Lines
Claim Total Charge Patient Paid Amount
[870.00 | |
Reset || Cancel

Click the More button on each claim line that requires additional information. A separate sub-window
with additional tabs opens.

Other Information || Additional Providers || DME Inforrmation || Ambulnce Information

The information entered in this sub-window refers only to the specific claim line that the More button
was clicked from.
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The following is a list of the More Claim Line Information sub-window tabs and sections:

Other Information (Claim Line)

Other Information

Occurrence Dates

Prescription and Purchase Service Details
Line Supplemental Information

Additional Providers (Claim Line)

Facility Information
Referring Provider
Rendering Provider
Supervising Provider
Ordering Provider
Purchased Service Provider

DME Information (Claim Line)

e DME Information

Ambulance Information (Claim Line)

¢ Ambulance Information

Secondary and Tertiary Claim Tabs

A secondary or tertiary claim contains all the tabs (and data) from the primary claim, with the addition
of two tabs:

Claim Adjudication

Claim Adjudication

Claim Adjustment

Medicare Outpatient Adjudication
Prior Payer Authorization

Prior Payer Provider Identifiers

Payer/Biling Provider || Subscriber/Patient || Service Line | Vist || Authorization | Additional Providers/Faciity | Other Insurance[ Claim Adjudication | |Errors

Claim Line Adjudication

This tab is within the Service Line tab. To view this tab, select the Service Line tab, click the More
button, and then select the Claim Line Adjudication tab.

e Claim Line Adjudication
e Claim Line Adjustment

Other Information || Additional Providers || DME Information || Ambulance Information]|| Claim Line Adjudication

Buttons

Done

Click the Done button in a sub-window to save any changes that you have made in that sub-window.

Page 163



\ Emdeon Office Claims User Guide

( J emdeOﬂ” Reporting & Analytics

Cancel

In a sub-window, click the Cancel button to close the sub-window without saving any changes. In a
main tab, click Cancel to close the claim editor.

More/More Fields

Click the More or More Fields button to open a sub-window that contains additional tabs specific to a
section or claim line. If you make changes in the sub-window, click Done to save your work.

Reset

Click the Reset button to remove any changes that you have made in a tab or sub-window. The fields
are returned to the condition they were prior to your changes. Fields that you did not change will not be
affected.

Reset does not remove any data that was in the claim when you opened the claim. Reset affects only
the edited data in the tab or sub-window in which you click the Reset button.

Refile

Click the Refile button only after you correct as many errors as possible. Once you click Refile, the
payer will receive the claim in one business day (if the claim is not rejected at the Emdeon
clearinghouse). For information on how to correct errors before refiling, see the Correct a Claim section
on page 164.

Submit

If you create a secondary claim from a primary claim, the Submit button appears instead of the Refile
button. Click the Submit button only after you have supplied all the necessary information and
corrected any errors that may exist. Once you click Submit, the payer will receive the claim in one
business day (if the claim is not rejected at the Emdeon clearinghouse). For information on how to
correct errors before submitting, see the Correct a Claim section on page 164.

Save Changes in a Sub-Window

Because changes in sub-windows are not automatically saved, click the Done button to save any
changes that you make in a sub-window. If you close a sub-window without clicking Done, all of your
changes will be lost.

Correct a Claim

Review and correct all errors (or as many as possible) before you refile or submit a claim. If you refile or
submit a claim without correcting errors, the claim may be rejected by the payer. However, you may
refile or submit a claim even if all errors have not been corrected. (Refiling or submitting a claim with
errors is permitted because payers have different data requirements; some payers may disregard
certain errors.)

4 Note: If you have the claim editor open but do not perform any actions for 15 minutes, your
session will time out and you will lose your changes.

Validation and Rejection

There are three distinct levels of validation that occur at different stages in the claim submission
process:

1. In real time, claim fields are validated based on standard industry guidelines. For each error
detected, an error is displayed in the Validation Error(s) section of the Errors tab. You can refile or
submit a claim even if the claim has validation errors. (See the Validation Error(s) section on page
166.)

2. After you refile or submit a claim, the Emdeon clearinghouse validates the claim based on known
payer submission requirements. The Emdeon clearinghouse can either reject the claim due to errors
or pass the claim on to the payer. Errors generated by the Emdeon clearinghouse are known as
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rejections, and they are listed in the Rejected Error Message(s) section of the Errors tab. You can
refile or submit a claim even if the claim has rejection errors. (See the Rejected Error Message(s)
section on page 165.)

3. If a claim successfully passes through the Emdeon clearinghouse to the payer, the payer processes
the claim. Based on its criteria and business rules, the payer can pay a claim in full, pay a claim in
part, or reject a claim. Errors generated by the payer are also known as rejections, and they are
listed in the Rejection Error Message(s) section of the Errors tab. You can refile or submit a claim
even if the claim has rejection errors from the payer. (See the Rejected Error Message(s) section
on page 165.)

Error Indicators
These indicators help you locate errors in a claim:

e If a tab contains errors, the tab name is in red text. If a tab does not contain errors, the tab name is
in blue text.

If a field contains an error or is required but blank, the field is highlighted yellow, and the error
appears in a tooltip when you hold your cursor over the field.

The Errors tab lists errors in two categories:

e Errors detected by Emdeon or the payer when the claim was rejected
e Validation errors based on standard industry guidelines for each field included in the claim

Use the Errors Tab

When you click the View/Edit Claim or Create Secondary Claim button in a Claim Detail Report, the
claim opens in a new window with the Errors tab selected.

4 Note: If the claim is accepted and the claim amount paid in full, no rejection errors will appear
in the Errors tab. Typically, there will also be no validation errors in this case, but where there
are validation errors for an accepted or paid claim, you can safely disregard those errors.

There is an upper section and a lower section in the Errors tab, and the sections display different types
of errors.

Payer/Biling Provider || Subscriber/Patient || Service Line || Visit || Authorization || Additional Providers/Faciity || Other Insurance || Ckim Adjudication || Errors

Rejected Error Message(s)

Standard Error Code Standard Error Message
W 1737 Line Item Charge Amount: Invalid; Must be numeric
W 1740 subscriber Primary Identifier: Invalid; Must be 2 to 15 alpha-numeric characters for Payer
W 1741 subscriber Primary |dentifier: Invalid; Must be 2 to 12 alpha-numeric characters for Payer
v 2877 Provider Secondary |dentifier: Reguired; Must not equal all zeros for Payer
v 2878 Admission Source Code: Invalid; Must be 1-9 for Payer
v 2879 Other Payer Primary |dentifier: Required; Must be entered on all secondary /tertiary claims
v 2880 Release of Information Code: Invalid; Must equal ¥, N or R for Payer
™ 1454 service Facility Information: Invalid; Must not be entered on Medicare claims
™ 1455 Procedure Code: Invalid; Must be valid Procedure Code for Payer

alidation Error(s

Payer/Billing Provider

Payer Information
Payer Name is required.

Payer D is required.
|Authorization Information
Release Information.

Release of Information is required.

|Assignment of Bene is required.
Patient Signature Source is required.

Rejected Error Message(s)

The upper section, Rejected Error Message(s), displays errors that were generated if the claim was
rejected at the Emdeon clearinghouse or the payer. Typically, these errors are generated regarding the
payer’s specific requirements.

These errors are not re-evaluated as you make changes to the claim; the application will not
automatically detect that you have corrected the reason for the rejection or that you have made a
change that might result in a new rejection reason that was not previously in the claim. Instead, each
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error message in this section has a check box beside the error code. As you correct errors in the claim,
you can select the corresponding check box to track your correction of the error. The check boxes will
remain selected until you refile or submit the claim or close the window.

d Note: Using the check boxes in the Errors tab is optional. However, if you have not selected all
the check boxes when you click Refile or Submit, a confirmation window will appear that
advises you to make all required changes. You can click Cancel to return to the claim and
correct the remaining errors or click OK to refile or submit the claim.

Validation Error(s)

The lower section, Validation Error(s), displays errors generated in real time by comparing the data in
every field on every tab to standard industry guidelines. These errors are warnings that a field’s value is
not valid or that a required field is blank. Some errors in this section may be duplicates of errors
displayed in the upper section.

When you correct errors in the lower section, the error message is removed from the lower section
automatically.

Red Error Messages

Validation and Rejection error messages that are displayed in red text are linked to the field that
contains the error. Click an error message in red text to go directly to the error on the tab that it
appears. The field the error appears in is highlighted yellow, and the related error message appears as a
tooltip when you hold your cursor over the field.

In the example below, the error *"NPI should contain only digits” is in red text and is a link. Clicking the
error opens the Payer/Billing Provider tab, and the cursor is automatically placed in the NPI field,
which is highlighted yellow.

Payer/Billing Provider || Subscriber/Patient || Service Line || Vis

Note:

ghiight

ubmitter Information
Last/Organization Hame First Name

[MAIN STREET cLIniE | | |

Email Fax
Payer Information

Payer ID MName
[73895738346 | [--select--
Secondary ID Claim Office #

alidation Error(s Street Address Line 2

Payer/Billing Provider | | |
Paver Information

Payer Name is requirsd. Billing Provider Information
Invalid Payer 1D.
Billing Provider Informaticn HPI T Tax ID Type
NP1 should confain only digits. [ta9za77PRE L] [Tax ID [+]
Tax |0 must digits and may contain one dash. NP_I =hould contain only digits.
Subscriber/Patient |'a":'”l°“:t
Subscriber Information. =l -
Last/Organization Hame First Mame

iGroup/ Policy # may contain letters, numbers, dashes, periods, spaces, asterisks and ampersands.
|MAIN STREET CLINIC

Black Error Messages

Error messages that are displayed in black text are not linked. These errors may not correspond to a
particular field, or the errors may relate to a field with multiple instances and the application is unable to
determine which instance of the field contains the error. For example, a rejection error message caused
by an error on a claim line is likely to be shown in black text, not linked, because the rejection errors do
not identify the claim line that contained the error. You will need to use your own expertise and
judgment to correct these types of errors.
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Enable Sections

Some sections are grayed out by default. No changes can be made to a grayed-out section. Each
grayed-out section has a check box in the section header. This may happen when the original claim
contained no information relevant to that section.

To be able to edit a grayed-out section, select the check box in that section’s header. Make changes to
that section if necessary. Selecting the check box indicates that you are choosing to include the section’s
information on the claim even though it is not included by default. Once you enable the section by
selecting the check box, field requirements will apply. As shown below, the Other Subscriber/Patient
section is not required, but if you select the “Include Other Insurance on Claim” check box, the
Individual Relationship, Other Insured ID, Last Name, and First Name fields become required.

Payer/Biling Provider || Subscriber/Patient || Service Line || Visit || Authorization | Additional Providers/Faciity || Other Insurance || Errors

Other Subscriber/Patient

B 1nclude Other Insurance on Claim

Entity Type | Individual Relationship |
Other Insured ID Poticy/Group # Group Name 55N
]
Last Name First Hame Middle Name Suffix
Street Address Line 2 City State
I I s |
Patient 1D Patient 55N
Payer/Biling Provider || Subscriber/Patient || Service Ling Visit || Authorization Additional Providers/Faciity || Other Insurance || Errors

Hote:

Dther Subscriber/Patient Include Other Insurance on Claim
Entity Type Individual Relationship
[-select-- ]
Other Insured ID Palicy/Group # Group Hame S5H
Last Mame First Name Middle Mame Suffix
Street Address Line 2 City State
— — Ere—r
Patient ID Patient 55M
Exception

There is one section that does not follow the pattern described above. On the Additional
Providers/Facility tab, the Rendering Provider section is grayed out by default, but the section header
check box is selected.

To be able to edit this section, clear the check box in the section header. Make changes to that section if
necessary.

As shown below, clearing the check box indicates that the rendering provider is not the same as the
billing provider, so the rendering provider information should be changed.
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Payer/Biling Provider | Subscriber/Patient
MNote:

Fields marked * are required.

Mou ver on the highlighted fields to

e the error.

Facility / Location Information

* Facility Type

Faciity ]

Service Line || Vistt || Authorization || Additional Providers/Facility

& include Facility/Location Information on Claim

* Lab/ Facility Mame MPI

CLINICAL LAE

* Street Address Line 1 Line 2 * City
5038 MAIN STREET ANYTOWN
Additional ID Type Additional 1D

[--zelect-- [a] | e

Rendering Provider

M sameas Billing Provider

]

Other Insurance Errors

Facility / Location Information
* Facility Type
Facility ]

Street Address Line 1

5038 MAIN STREET

Entity Type Last Name First Name
NPI Tax ID Type Tax ID
T
Additional ID Type Additional 1D
Payer/Biling Provider || Subscrber/Patient || Service Line || Vist || Authorization || Additional Providers/Facility || Other Insurance || Errors
Mote:
Fields marked * are required.
IMouse hover on the highlighted fields to ses the error.

@ include Facility/Location Information on Claim

* Lab/ Facility Mame MPI

CLINICAL LAB

Line 2 city

|

|

ANYTOWN

Additional ID Type Additional 1D

[Ssleat- 2| — | =
Rendering Provider M sameas Billing Provider

* Entity Type * Last Name First Name

MPI Tax ID Type Tax 1D

L ] [seect- [v] [
T

—select-- [~

Additional ID Type

Additional 1D

|--Sa|ec:t--

o] | | =

Refile a Claim

The application allows you to refile a claim whether or not all errors have been corrected. If you refile a
claim that contains errors, the claim is still sent to the payer; however, the payer may reject the claim.

[

Follow these steps to refile a claim:

1. Correct as many errors as possible.
2. Click the Refile button.
3.

Note: It is recommended that you correct all errors if possible before you refile a claim.

If there are one or more uncorrected errors, a confirmation window appears. Click Cancel to return

to the claim and correct the remaining error(s), or click OK to submit the claim with errors.
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Message from webpage

‘-?J/ Please ensure that all the required changes have been made and claim is ready for submission. Do you want bo continue?

I OK, l [ Cancel ]

If there are no errors, the claim is submitted to the Emdeon clearinghouse. A confirmation window
appears with the message, “The claim has been successfully refiled.”

If the claim is not rejected by the Emdeon clearinghouse, it is sent to the payer. The next business
day, you should receive a claim confirmation report indicating whether the claim was rejected at the
Emdeon clearinghouse or sent to the payer. (You will see this report in either Reporting & Analytics
or your Office email depending on how your account is set up.)

Secondary Claims

When a claim is not paid in full by the payer, you can create a secondary claim from the primary claim.
You can then send the secondary claim to another payer for payment of all or part of the remaining
claim amount.

4 Note: The insured person on the claim must be enrolled and eligible with the payer that the
secondary claim is sent to.

When you create the secondary claim, the application automatically populates most of the fields in the
secondary claim with data from the primary claim. For example, if the primary claim included
information in the Other Insurance tab, it will be moved to the Payer/Billing Provider and
Subscriber/Patient tabs as applicable in the secondary claim. For a list of the minimum required
information you need to submit a secondary claim that you created from a primary claim, see the
Minimum Required Data section on page 172.

You can create a secondary claim from a primary claim that has errors, but you should correct as many
errors as possible before you submit the secondary claim. See the Correct a Claim section on page 164
for more information.

Secondary Claims in Office

Currently, there are two ways to create secondary claims in Office: through Reporting & Analytics and
through Supplement Claims (see the Supplement Claims section on page 33). This section describes
how to create secondary claims through Reporting & Analytics, but there are some fundamental
differences between the two methods.

Feature Secondary Claims: Reporting & Analytics | Secondary Claims: Supplement Claims
Create secondary claim Create a secondary claim only from a primary Upload a primary claim for the purpose of
claim that has already been submitted through converting it to a secondary claim to submit to
the Emdeon clearinghouse to the payer. Using another payer. Make changes needed to create
this method, you will upload the claim once, not the secondary claim immediately after you upload
twice. the claim. The changes you make are

independent of the submission of the primary
claim to the primary payer.

Change field values Make changes to any field Make changes only to certain fields
Submission format Submit claims only in ANSI X12 4010 or NSF+ Submit claims in multiple formats
format

Validate Claim Charges

Because secondary claim amounts are based on the primary claim, the application validates all claim
amounts at both the claim level and the service line level on secondary claims. If these amounts do not
calculate correctly according to the primary claim, it will be treated as a validation error.
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Claim Amount Level Validation

This level of validation ensures that the claim level payer paid amount plus all adjustment amounts
entered at the claim level and line level equals the primary claim charge. If claim level payments and
adjustments do not equal the primary claim charge, this error will appear on the Errors tab: “Claim
does not balance. Adjustments and payments must equal claim total charges.”

Validation logic for claim amount field validation involves the following calculation:

Payer paid amount (claim adjudication tab)

+

all the claim line adjustment amounts (claim line adjudication tab)
+

all the claim adjustment amounts (claim adjudication amount)

Total claim charge
Service Line Amount Level Validation

This level of validation ensures that the service line level payments and adjustments equal the primary
service line charge. If service line level payments and adjustments do not equal the primary line charge,
this error will appear on the Errors tab: “Service line <#> does not balance. Service line payment
amount and adjustment amounts must equal original line charge.”

Service line level validation logic involves the following calculation:

Service line payer paid amount
+
All claim line adjustment amounts

Total line charge

Create a Secondary Claim from a Primary Claim

1. Select Claims > Reporting & Analytics from the main menu.

2. Search for and open the Claim Detail Report of the primary claim you want create a secondary claim
for. (See the Claim Data Searches section on page 101 for details on search types.)

3. Click the Create Secondary Claim button.

PR_1002
Claim Detalil
Search Criteria: Emdeon Claim ID: EP071 Create Sacondary Claim View Audit History Get Help with this Claim
Insured ID 501508 St Provider Tax ID 41200 Claim Received Date 07/12/2010
Patient Name L R ) Billing Provider ID 4120 Emdeon File ID EPOQIL S inyins
Patient DOB + Billing Provider NPI Emdeon Claim ID EPO71
Claim Amount $112.50 Site ID 3475 Payer ID
Service From 01/22/2010 Patient Control No. ' T¥ § Worked Status
Service To 01/22/2010 Payer Name Medica NPI XWalk XWalk Review
Payer Claim ID Timely Filing Letter Display Letter

4. On the Payer/Billing Provider tab, enter the Payer ID and Name, and for the Sequence field,
select “Secondary”.
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Payer/Billing Provider | Subscriber/Patient || Service Line || Visit || Authorization || Additional Providers/Facilty || Other Insurance || Caim Adjudication | Errors

ubmitter Information

Last/Organization Name First Hame Middle Name Submitter ID Contact Name

Forsewices ] | | — oncoonea
Email Fax Telephone
| o |

Payer Information

Payer ID Name
[poos4 | [AETHA ]

Secondary ID Claim Office # HAIC # Payer Tax ID
Street Address Line 2 City State
| | | -

Billing Provider Information

NPI Tax ID Type Tax ID

4 Note: Some fields may already be pre-populated with data from the primary claim. See the

PNoW

10.
11.

Minimum Required Data section on page 172 for more information.

On the Subscriber/Patient tab, enter information about the subscriber/patient.

On the Authorization tab, select the correct values in the Release Information section.

On the Other Insurance tab, enter required information in the Other Payer section.

On the Claim Adjudication tab, enter the Adjudication/Payment Date and Payer Paid Amount
concerning the payment made on the primary claim.

If you want to include line level information on the claim, select the Service Line tab, click the
More button, select the Claim Line Adjudication tab, and then enter additional information
relating to a specific line. (If the section you want to edit is grayed out, select the check box in the
section header to enable the section for editing. See the Enable Sections section on page 167 for
more information.)

On the Errors tab, review the information and correct as many errors as possible. (See the Correct
a Claim section on page 164 for more information.)

Click Submit.

If there are one or more uncorrected errors, a confirmation window appears. Click Cancel to return
to the claim and correct the remaining error(s), or click OK to submit the claim with errors.

Message from webpage

\_?() Please ensure that all the required changes have been made and clairm is ready For subriission. Do you wank to continue?

I ol H Cancel ]

If there are no errors, the claim is submitted to the Emdeon clearinghouse. A confirmation window
appears with the message, “"The claim has been successfully submitted.”

If the claim is not rejected by the Emdeon clearinghouse, it is sent to the payer. The next business
day, you should receive a claim confirmation report indicating whether the claim was rejected at the
Emdeon clearinghouse or sent to the payer. (You will see this report in either Reporting & Analytics
or your Office email depending on how your account is set up.)
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The table below lists the minimum required data you will need to enter to submit a secondary claim.
Other required data will automatically appear on the secondary claim because it will have been pre-
populated from the primary claim.

Tab

Section

Field

Note

Payer/Billing
Provider

Payer Information

Payer ID (which populates Name)

If the Other Payer ID and Other Payer
Name fields from the Other Insurance tab
on the primary claim were populated, those
values will pre-populate the Payer ID and
Name fields on the secondary claim. If the
values did not pre-populate, complete these
fields.

Sequence

Select “Secondary”

Subscriber/Patient

Subscriber
Information

Entity Type

Patient Relationship to Insured

Subscriber ID

Last Name

First Name

If the Entity Type, Individual Relationship,
Other Insured ID, Last Name, and First
Name fields from the Other Insurance tab
on the primary claim were populated, those
values will pre-populate these fields on the
secondary claim. If the values did not pre-
populate, complete these fields.

Authorization

Release Information

Release of Information

Patient Signature Source

Assignment of Benefits

These fields are claim-specific and cannot
be assumed or pre-populated from the
primary claim. Complete these fields.

Other Insurance

Other Payer

Claim Filing Indicator

Insurance Type

These fields do not appear on the primary
claim, so they will not be pre-populated.
Complete these fields.

Claim Adjudication

Claim Adjudication

Adjudication/Payment Date

Payer Paid Amount

If the payer amount paid differs from the
claim total charges, adjustments will be
required to offset the difference. These
adjustments can be entered at the claim
level, line level, or both. See the Claim
Amount Level Validation section on page
170 for calculation specifications.

Claim Adjustment

Claim Adjustment Group

Claim Adjustment Reason

Adjustment Amount

These fields are required if you select the
“Include Claim Adjustments on Claim” check
box.

Claim Line
Adjudication

(Select Service
Line tab, click
More button, and
select Claim Line
Adjudication tab)

Claim Line
Adjudication

Service Line Paid Amount

This field is required if you select the
“Include Claim Line Adjudication on Claim”
check box. The other relevant fields in the
Claim Line Adjudication section are pre-
populated from the primary claim line detail
but can be changed if they are reported
back differently on the ERA.

Claim Line
Adjustment

Claim Adjustment Group Code

Claim Adjustment Reason Code

Adjustment Amount

These fields are required if you select the
“Include Claim Line Adjudication on Claim”
check box. See the Service Line Amount
Level Validation section for calculation
specifications.

Note: All of the other amount fields on the Claim Adjustment and Claim Line Adjustment sections are only required when they
are reported on the primary claim payer’s ERA.
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